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Introduction

This document describes Spycer, the innovative data and content con-
trol software developed by the Rohde & Schwarz DVS GmbH (in short
'DVS’). With the software you can easily maintain transparency and
control over video and audio data and their corresponding metadata.
Accompanied by a conclusive rights management, browsing, search-
ing and viewing of video and audio material can be done without any
difficulty. Several management tools supplement the usage of Spycer
comprising, for example, a renaming function, an integrated high-
speed copying process, a sophisticated defragmentation of image se-
quences as well as the new P2 and XDCAM workflows.

All the above said can be achieved on the respective computer system
locally with one Spycer alone, but the real benefit comes when several
Spycer applications operate combined in a network. Then they form the
SpycerNet, a scalable distributed content management network for
data search and retrieval. For example, the instant a Spycer application
detects new clips on its local storage (the watched folders) they and
their metadata are made available to all other Spycer applications pres-
ent in the network immediately. Furthermore, to perform management
tasks such as a defragmentation or a copying, your Spycer may be con-
trolled by other Spycer applications or you may control others available
in the SpycerNet. Of course, all these behaviors can be fully configured
via a rights management.

Spycer can be run on a standard computer system and does not require
any special DVS hardware. On several DVS video systems, such as
CLIPSTER or the Pronto family, it is already integrated in the respective
DVS software and accessible the same way as the other software mod-
ules.

There are several different variants of Spycer available, from Spycer Ba-
sic providing a limited feature set to Spycer for DVS-SAN able to access
storages in the StorNext file system (SNFS). For further information
about the different variants please refer to section “Program Variants of
Spycer” on page 1-6.

1-1
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1.1 Overview

This user guide informs you about the installation and general handling
of Spycer as well as about its complete controllable interface. The chap-
ters in this user guide contain the following information:

Chapter 1 Begins with a short introduction to Spycer, fol-
lowed by a note regarding the audience this
manual is written for and an explanation of the
conventions used in this manual. Furthermore,
it details the available software variants and
their respective capabilities, the system re-
quirements necessary to run Spycer when it is
not already installed as well as the latest high-
lights of the software.

Chapter 2 This chapter provides basic information about
Spycer. First the key features of Spycer are de-
scribed, followed by some background infor-
mation regarding the software structure of
Spycer and licensing.

Chapter 3 Describes the first steps to get started with
Spycer. In this chapter you find details about
how to install the program, how to perform its
first setup as well as about how to startand end
it. This is complemented by some information
about the program variant integrated in the
DVS software on a DVS video system, such as
CLIPSTER or the Pronto family.

Chapter 4 This chapter gives you a complete overview of
the software, detailing all features and options.
Furthermore, you find explanations about how
to change the layout of the software and de-
scriptions about the menu bar on a Mac OS.

Chapter b Explains the browse and search tools of
Spycer.
Chapter 6 Provides a description where and how to pre-

view data in the software.

Chapter 7 Describes the tools and instruments that help
you to manage vast amounts of data with
Spycer, such as the file format converter, the
built-in defragmenter and high-speed copying.
Furthermore, you find information about job
lists, the task scheduler as well as P2 and
XDCAM ingest.




Introduction

Chapter 8

This chapter provides information about how to
work with metadata, i.e. how to view and how
to edit them. Furthermore, it describes how to
create metaclips in the Spycer software.

Chapter 9

Details all configuration settings available in the
main menu of Spycer. In addition, you find in-
formation about the context menus and the
properties window.

Appendix

Gives additional information about the soft-
ware. Among others you find a list of the sup-
ported file formats, maintenance and
troubleshooting issues or shortcuts and com-
mand line operations.

Index

This chapter facilitates the search for specific
terms.

1-3
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1.2 Target Group

To use this user guide and Spycer correctly, you should have experience
in handling PCs and working with the respective operating system
where Spycer is installed. For the full use of the software it would be
best to have some knowledge in the field of digital video and its accom-
panying metadata.

1.3 Conventions Used in this User Guide

The following typographical conventions will be used in this documen-
tation:

¢ Texts preceded by this symbol describe activities that you must per-
form in the order indicated.
— Texts preceded by this symbol are parts of a list.

° Texts preceded by this symbol are general notes intended to fa-
1 cilitate work and help avoid errors.

You must pay particular attention to text that follows this sym-
bol to avoid errors.

7]

Texts enclosed by quotation marks are references to other man-
uals, guides, chapters, or sections.

"Window’ Text in bold with single quotation marks indi-
cates a window name

BUTTON Text in small caps and bold indicates push but-
tons

Group/Menu Text in italic and bold indicates either a group
name, menu name or options in a menu list

Item Text in bold only stands for other labeled items
of the user interface

Menu » Option In the specified group or menu, select the stated
item

DirectorylFile Directory structure or file

Entry Parameters, selections or entries made in the
program, or commands entered at a prompt

[Key] An individual key or a key combination on a key-
board
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Keyboard Shortcuts

To perform options or procedures with the keyboard, often requires a
simultaneous pressing of two keys.

Example:

[Ctrl + F1] If this is given, hold down the [Ctrl] key and
press simultaneously the [F1] key.

Screenshots

The screenshots shown in this documentation have been taken for the
most part from the Windows-based version of Spycer in its standard
stand-alone application variant providing a full feature set (SAN access
included). Depending on the software variant available to you and the
installed operating system, your Spycer application may look different
and/or may not provide all the features described here. However, due
to the fact that the descriptions given here and their screenshots are
complete, they will contain the interface items that concern your vari-
ant and/or operating system as well.

Command Descriptions
Command descriptions may additionally use the following notation:

#... Has to be numerical

<. ..> Variable; this term has to be replaced by an ap-
propriate value

7-5
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1.4 Program Variants of Spycer

Spycer is available in several different program variants, from Spycer
Basic providing a limited feature set to Spycer for DVS-SAN able to ac-
cess storages in the StorNext file system (SNFS). This section details
the available variants, their differences and their capabilities.

o The stand-alone variants Spycer Basic and Spycer are the same
1 application differing only in their licensed features. To run a
Spycer Basic as Spycer, you need an appropriate license pro-

vided by a license file or when installing several applications,
by a dongle. See section “Licensing” on page 2-9 for further
details about the dongle and licenses.

The following lists the available variants:

Spycer Basic

'Spycer Basic' is available for free. Compared to
the other program variants it provides a limited
feature set (see table 1-1 on page 1-7). It is the
stand-alone application that can be run on a stan-
dard computer system (see section “System Re-
quirements” on page 1-8).

Spycer

'Spycer’ is the standard version of the Spycer ap-
plication. It is the stand-alone application that can
be run on a standard computer system (see sec-
tion “System Requirements” on page 1-8). It pro-
vides the complete feature set with the exception
that it cannot perform a file management or scan-
ning of data on storages in the StorNext file sys-
tem (SNFS).

integrated Spycer

This variant of Spycer is integrated in the DVS
software running on a video system by DVS (such
as CLIPSTER or the Pronto family). As the stan-
dard variant of Spycer ('Spycer’) it provides the
complete feature set and furthermore, works
seamlessly together with the available DVS prod-
ucts (see section “The Integrated Spycer” on
page 3-15).

Spycer for
DVS-SAN

This Spycer application variant can be found on
SAN systems. Compared to the standard variant
of Spycer ('Spycer’) it is also capable of managing
and scanning data on storages in the StorNext file
system (SNFS).

SpycerBox (for
DVS-SAN)

This Spycer application variant is a special version
for the SpycerBox system by DVS. It provides pre-
view proxies of a connected SAN system for
downloads to other Spycers in the SpycerNet. It
uses the same license as Spycer for DVS-SAN and
offers most widely the same features.

7-6
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The following table details the features of the different Spycer applica-

tion variants:

Table 1-1: Features of the program variants

Spycer
Basic

Spycer

integrated
Spycer

Spycer for
DVS-SAN

Requirements

free

license file

DVS hardware

license file and
DVS-SAN

Local and SpycerNet
browsing/searching

X

Watch folders on SAN
volumes

SNFS watch folders

Remote control this
Spycer via SpycerNet

Remote control other
Spycer applications via
SpycerNet

Renaming of image
sequences

X
(not on SAN)

X
(not on SAN)

Editing of metadata

X
(not on SAN)

X
(not on SAN)

Built-in defragmenter

X
(not on SAN)

X
(not on SAN)

High-speed copying

X

X

File format
converter

X

X

Task scheduler

Generation of preview
proxy clips

i @

This user guide describes as good as all possible features that
a Spycer application may provide, thus covering all above men-
tioned variants. The feature set of Spycer Basic is limited as de-

tailed above. However, because the descriptions given here are
complete, its functions are explained as well. In case one fea-
ture is available for a particular variant only, it will be explicitly
mentioned in the text.

1-7




Spycer User Guide w

1.5 System Requirements

7-8

The stand-alone application of Spycer ('Spycer Basic’ and 'Spycer’, see
section “Program Variants of Spycer” on page 1-6) is able to run on a
standard computer system that fulfills the following system require-
ments:

Supported Hardware

These are the minimum hardware requirements that the computer sys-
tem has to meet if you want to use the program:

— 2 GHz dual-core processor

— 1 GB of RAM

— 200 MB free space on system disk

— CD-ROM drive (if Spycer is delivered on CD)

— OpenGL-capable graphics card (minimum resolution 1024 x 768)

— Ethernet network card to communicate between Spycer applica-
tions (SpycerNet)

— FC card to connect to a SAN (if required)

o To run a Spycer Basic as Spycer, if installing it on several cli-
] | ents, you will also need one free USB port for the dongle to en-
able the licensed feature set. See section “Licensing” on
page 2-9 for further details about the dongle and licenses.

Supported Operating Systems

The program can be executed on the following operating systems:
— Linux (Red Hat Enterprise Linux 5 or Red Hat Enterprise Linux 6)

° DVS tested Spycer with the above mentioned Linux distri-
1 butions. Others may work as well, but not necessarily.

— Mac OS X
— Windows 2003/2008 Server, Windows XP, Windows 7 (recom-
mended), or Windows Vista

. Be sure that you have installed the newest service packs
1 and/or patches for your system, otherwise you may encoun-
ter soft- and/or hardware problems.

The following requirements may be necessary to run Spycer depending
on the operating system:

— Mac OS only:
— QuickTime Version 7.6.6 or higher to display *.mov files
— QuickTime plug-in 1.4 for DNxHD content in *.mov files, if
required
— XSAN software Version 2.1.1 for SAN (with current SNFS ver-
sions)
— Mac OS X 10.5 or higher
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— Windows only:
— QuickTime Version 7.6.8 or higher to display *.mov files
— QuickTime plug-in 1.4 for DNxHD content in *.mov files, if
required
— License to run the program with a licensed feature set (*. txt file
or floating license on a dongle, see section “Licensing” on
page 2-9)

1.6 Important Notes

Please observe the following when using the Spycer application:

o The following network ports have to be free and available to
1 connect successfully to the SpycerNet:

— Port 9960 UDP
— Port 9961 TCP
— Port 9970 UDP
— Port 9971 TCP
— Port 9980 TCP
— Port 9981 TCP
— Port 9982 SDP
— Port 9983 TCP

See to it that these ports are free in your network (e.g. as ex-
ceptions in the firewall settings) otherwise Spycer will be con-
fined to its localhost only (IP address 127.0.0.1 has to be used).
During the installation of a Spycer for Windows these ports are
automatically freed. On other operating systems you may have
to configure them manually. In case of problems or questions,
please contact your local network administrator.

The SpycerAgent registers all data (even unknown files) as well
as all events that take place in the watched folders. To minimize
the size of its database and the overall traffic for the
SpycerAgent, it is recommended to include directories/drives
that contain files of formats supported by Spycer only (see sec-
tion “Supported File Formats” on page A-6). Otherwise search,
scanning and defragment processes may get lengthy due to
unnecessary overhead.

An editing of header metadata such as image related data
(e.g. bit depth or number of pixels/lines) may lead to impaired
material that cannot be used correctly in another application

or Spycer anymore. This could happen when editing the me-
tadata of e.g. *. dpx files. When editing metadata, be sure
about what you are doing.

i @
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To run Spycer successfully under the Windows Vista operating
system, please see section “Troubleshooting under Windows
Vista” on page A-b.

i @

To use floating licenses, the CodeMeter application has to be
installed on all participating systems, i.e. on the system that
distributes the licenses and the system that should receive
one.

Hence the multicast mode is used by Spycer by default, your
network environment must be multicast capable.

i @

1.7 Latest Highlights in Spycer

Newer versions of Spycer usually provide features that older applica-
tions may be missing. The following lists the most important features
and functions that were new in the latest Spycer versions:

- ) Please note that file related tasks or further information due to
l new features may not be available on systems with older
Spycer versions, even if triggered from a newer application ver-
sion in the SpycerNet (see section “Software Structure” on
page 2-4).

— Windows Active Directory access management for Windows, Linux
and MAC OS

— The new P2 and XDCAM workflows: Spycer virtualizes external
drives as folders in its browse and search area. This enables you to
move and copy content in the Spycer network and to edit its meta-
data easily

— The Avid Workflow option in Spycer: With it you can work directly
on Avid's ISIS or use the production asset management Interplay

— The record scheduler (The complete description of the record
scheduler with all its options and features can be found in the
“VENICE Client Software” user guide.)

— The metaclip feature allowing you to easily create, manage and
store metaclips of several file formats

— A new licensing model with simple file uploads for licensing

— FTP server connectivity as well as Grass Valley Profile and Grass
Valley K2 support

— Administrator’s rights management: With Spycer network adminis-
trators can define and manage computer groups for a secured
SpycerNet by using the existing infrastructure

— Support of REDCODE RAW (*. r3d) format on all platforms (see
section “Supported File Formats” on page A-6)

— A "read while write”-feature allowing you to browse and preview
files while they are being recorded
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This chapter provides basic information about Spycer. First descrip-
tions of the key features of Spycer are given. This is followed by some
background information about the software structure providing details
about the user interface, the SpycerNet and the SpycerAgent in partic-
ular. The chapter will be concluded with details and explanations of
how to license Spycer.

2-1
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2.1 Key Features of Spycer
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Spycer is a software program for content management, especially de-
signed for handling large amounts of video and audio data as well as
their corresponding metadata, either locally stored or distributed on
several systems connected to a network. The following lists and ex-
plains shortly the key features of Spycer:

o There are several variants of Spycer available and not all may
l provide the complete feature set. Further information about
them can be found in section “Program Variants of Spycer” on
page 1-6.

— Browse and Search

— With Spycer you can browse local or network storages (the lat-
ter either via the SpycerNet or with the help of mounted net-
work drives as for the Avid Workflow option). With its search
tool you can find the wanted material swiftly by combining var-
ious parameters, such as file names or metadata information.
All material and data displayed in the browse and search area
can be shown either in text information or thumbnail view.

— Viewing of Material
— Video clips and images can be viewed either with their thumb-

nails in the browse and search area or, when double-clicked, in
the enlarged preview area. Both, the thumbnails as well as the
preview area, provide a scrub bar (timeline) where you can
move to different positions within a video clip’s sequence.
Once video material is available in the preview area, you may
also use the built-in media player for a real-time viewing
(requires a proxy) or gather further information about it in the
metadata area.

— Managing Metadata
— After data is selected and shown in the preview area, its meta-
data, such as the header data or descriptive data, is displayed
as well. Then they can be added or changed easily or searched
for with Spycer’s search tool. Furthermore, you can create
metaclips (*. vamc) from several file formats which can be
used as a container for video and audio clips.

— Management Tools
— Spycer is equipped with several management tools such as

high-speed copying and a sophisticated defragmenter. Spycer
also offers a renaming tool for image sequences, or a file for-
mat converter allowing you to convert video and image data
from one file format to another. Among other useful manage-
ment tools you find also a job list detailing current and past
jobs performed on or by your system, a task scheduler allowing
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you to run management and maintenance tasks automatically
at intervals or certain times as well as the P2 or XDCAM
options that allow you to perform ingest operations with the
help of virtual folders in Spycer.

— SpycerNet
— One Spycer can perform all the above said on the computer

system where it is installed locally. By communicating with
other systems, sharing their databases and enabling a remote
control of the applications for, e.g. management tasks, several
systems can form the so called SpycerNet, a scalable distrib-
uted content management network for data search and
retrieval.

— Rights Management
— Each Spycer contains a rights management to allow other
Spycer applications in the network (SpycerNet) access to its
data or a remote control of it. Browse and search permissions
or read and write permissions enable different possibilities for
the respective system.

— Virtualization
— Spycer virtualizes external drives as folders in its browse and
search area. This enables you to move and copy content in the
Spycer network and to edit its metadata easily.
— Virtualized folders in Spycer can be:
s FTP and Grass Valley K2 servers
s Avid Interplay databases (only combined with ISIS storage)
o P2 card readers (when licensed)
o XDCAM card readers (when licensed)

2-3
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2.2 Software Structure
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The following provides basic information about the software structure
of the Spycer application to help you understand how the software op-
erates. In its parts, the Spycer application consists of three elements
that together provide the software’s capabilities:

— the user interface,
— the SpycerAgent and
— the SpycerNet.

While the first two are software components actually installed on the
computer, the latter is the means of communication between different
Spycer installations in a network enabling the scalable and distributed
content management. The following diagram shows the software
structure and communication processes between the individual ele-
ments of Spycer applications in a SpycerNet in detail:

~| Client I ———| Client: File Server |

Spycer
Spycer for DVS-SAN
user interface .
user interface

8‘_’ SpycerAgent SpycerAgent Rams 8

Database Database

N/ L

SpycerNet

/ \ DVS-SAN

8 s dl SpycerAgent Spycer
Database user interface

integrated

Spycer [ local content
user interface management disabled ]

{ Client: CLIPSTER ———— [ Client -

Figure 2-1: Overview of the software structure

The ovals in the drawing above represent the user interfaces of the
Spycer applications, while the lines indicate the communication ways
on the individual clients as well as between them in the SpycerNet. It is
of no consequence to the SpycerNet whether the software applications
are all of the same variant of Spycer or not (see section “Program Vari-
ants of Spycer” on page 1-6).

The following sections will explain the drawing above in more detail.
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The User Interface

With the user interface of Spycer you can view, edit and administer the
data shown in its areas and/or tools, for example, browsing and search-
ing for data or editing their metadata. It can be used to display the con-
tents that is locally available and furthermore, when operating in a
SpycerNet, it may also show the material that is stored on other sys-
tems.

In case it is running without the background process enabled (as the
bottom right Spycer in figure 2-1 on page 2-4 indicates), the user inter-
face can still be used as a network browser in the SpycerNet to display
data available on other systems.

o Because the user interface runs independently from the

1 SpycerAgent, it will separately check whether a valid license is
provided. When found, it will run with the respective feature
set enabled (see section “Licensing” on page 2-9).

SpycerAgent

To scan and display any data locally stored on your system, the Spycer
application installs a background process (Mac/Windows. service,
Linux. daemon) called SpycerAgent. It will be launched at the first start
of the software and in the future automatically during the loading of the
operating system.

The SpycerAgent administers a database that contains all important in-
formation about the contents of the watched folders (the scanned and
indexed local storages). This database is used in the user interface of
Spycer to display video and audio material and is revised so that it is
always up-to-date with the actual content stored.

o The very first writing of the database may take some time de-
1 pending on the amount of data stored in the watched folders.

Further information about the watched folders can be found in
section “Watch Folder Settings” on page 3-11.

The SpycerAgent is an important part of the SpycerNet. On the one
hand it makes the data in the database available to the user interface
installed locally and on the other to all other Spycer applications in the
network (if browse and search permissions are given, see section “Re-
mote Access Permissions” on page 3-12). Without it only the data pro-
vided by other SpycerAgents in the network can be seen and accessed.
Thus, it is the database that will be visible to other Spycer user interfac-
es in the SpycerNet.

Furthermore, the SpycerAgent controls the Spycer application tasks on
your system such as copy or defragmentation processes. Usually, these
are initiated by the user interfaces in the SpycerNet. Locally you can
perform read and write as well as browse, search and edit processes as
wanted: The user interface triggers the event and the SpycerAgent car-
ries them out.

2-5
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The SpycerAgent runs totally independent of Spycer’s user interface.
This makes it possible to maintain the SpycerNet almost at all times.
Even with no user logged in to the system and no Spycer user interface
running, other Spycer user interfaces will be able to search and browse
in your data or perform copy or write procedures (if permitted on your
system).

o Because the SpycerAgent runs independently from the user in-
1 terface it will separately check whether a valid license is pro-
vided. When found, it will run with the respective feature set
enabled (see section “Licensing” on page 2-9).

With the local content management (i.e. the SpycerAgent) enabled,
Spycer not only displays the data scanned and indexed in its database.
The viewing or reading of the contents of other drives or directories on
your system (local reading) as well as of mounted network drives is
possible even without their contents added to the database.

To administer the background process, DVS offers you a tool especially
designed for this purpose. Please refer to section “The SpycerAgent
Tool” on page A-18 for more details about this. Nevertheless, the stan-
dard operating system tools to administer background processes can
be used as well.

SpycerNet

The SpycerNet is one of the main features of Spycer. It is the part of the
software that constitutes the scalable and distributed content manage-
ment.

With a single Spycer application you can access data locally stored or
available via mounted network drives only. But if there are more than
one Spycer installed on different computer systems connected via a
network, they will form the SpycerNet. Then they communicate with
each other and share their databases providing information about the
data stored locally on each system. The more Spycer applications are
installed, the more data you can gather from different systems. This is
meant by the terms 'scalable” and 'distributed’: ‘scalable’ because
there is no limit to the number of Spycer applications working together
and ‘distributed’ because they work independently on separate work-
stations as well as provide separate databases.

This way no central server is required and you still can easily maintain
transparency and control over all video and audio data in your work-
flow. The individual Spycer installations communicate with each other
and share their databases as soon as they are present in the network
and browse and search permissions are given. To configure a Spycer
application to take part in the SpycerNet, see section “General Set-
tings” on page 3-8.



Basics

Notes about Networking with Spycer

The SpycerNet is best set up in a way that the overall workload is dis-
tributed over the client stations. If working with a central storage (e.g.
a SAN), only one Spycer should provide the database for this storage.
This is one of the major features of Spycer: Not every system has to
scan the central storage but only one which will share its database in
the SpycerNet. This will reduce the overall traffic greatly because only
one Spycer monitors the central storage.

Furthermore, each Spycer contains a basic rights management to allow
other Spycers in the SpycerNet access to your data or a remote control
of the SpycerAgent installed. The permissions what other Spycers are
allowed to do on your system (as well as all other settings mentioned

in this section) have to be stated during the initial setup of the software
(see section “Initial Setup of Spycer” on page 3-8). Of course, they can
be altered at any time later without difficulty (see section “The Config-
uration Menu” on page 9-2).

Listed in the following are some basics regarding the role of your
Spycer application in a SpycerNet:

5 ) Some network ports have to be free and available to connect
1 successfully to the SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address 127.0.0.1 has to be used).
For further information about this please see section “Impor-
tant Notes” on page 1-9.

When the local content management is disabled, i.e. the SpycerAgent
is not installed on your system:

— Your Spycer application will not appear in the SpycerNet regardless
of any other setting.

— Your Spycer user interface will not show any files locally stored nor
can mounted network drives be accessed.

When the local content management is enabled:

— If set to localhost, your Spycer will not appear in the SpycerNet
regardless of the permissions given.

— With no permissions given and when an |P address is stated other
than the localhost address, your Spycer application will be regis-
tered in the SpycerNet but provide no data.

— With permissions given and when an |IP address is stated other than
the localhost address, your Spycer application will be registered in
the SpycerNet. Other Spycer applications can perform at least
browse and search operations in your database.

Set the respective content management and permissions regarding the

information given in section “The Group ‘General’” on page 9-11 and
section “The Group 'Permissions’” on page 9-21.

2-7
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SpycerNet Groups

In Spycer it is possible to define and manage groups within the
SpycerNet. Every peer can have an administrator account which must
be configured once during or after the installation. The network admin-
istrator defines the password and assigns a peer to a certain SpycerNet
group. This increases the security of a peer-to-peer network significant-
ly because the secured Spycer peers are only visible when they belong
to the same group. Only if the peer(s) are set to public they are visible
to everyone in the SpycerNet. For further information about the settings
and configurations of SpycerNet groups see section “The Group 'Ad-
ministrator’” on page 9-4.



2.3 Licensing

If you want to run the software with more than the basic features, you
have to license it. The licenses will then be valid for the options you
have ordered. The Spycer application is licensed in three ways:

1. Via hardware: On DVS video devices ex factory equipped with
Spycer, such as the DVS-SAN, CLIPSTER or the Pronto family, the
Spycer application is already properly installed and licensed. Then
the program can be started immediately.

2. For the stand-alone application of Spycer, via a special license
provided in a license file.

3. For the stand-alone application of Spycer that has to be installed
on several clients via a dongle with several floating licenses on it.

In case the license is not available or invalid, the stand-alone application
runs as Spycer Basic (see section “Program Variants of Spycer” on
page 1-6).

o) You can leave out the CodeMeter installation when you intend
J | torun Spycer as Spycer Basic only. However, when using float-
ing licenses on a dongle (see section “Floating License” on
page 2-11), all involved systems must have the CodeMeter ap-
plication installed.

Details about the license currently assigned to your Spycer ap-
plication can be found in the ’About Spycer’ window (e.g. for
troubleshooting purposes, see ‘About’ in the table on

page 4-17).

In the following you find all information needed when licensing Spycer.

2.3.1 Hardware License

On several DVS video systems, such as CLIPSTER or the Pronto family,
Spycer is integrated in the DVS software which makes it unnecessary
to install Spycer as a stand-alone application. Therefore, it is licensed
properly depending on your requirements and you can start working
with the software immediately. For further information about the inte-
grated Spycer version see section “The Integrated Spycer” on

page 3-15.

2.3.2 The License File

Licensing Spycer via a license request and a license file is the easiest
way. In this case you will receive a dedicated license in *. txt file for-
mat. If you have installed a Spycer application as described in section
“Installing the Software” on page 3-2, perform the following to be able
to run Spycer with more than just its basic features:



Spycer User Guide ﬁ

2-10

e Start the Spycer application as described in section “Starting the
Software” on page 3-6.

* Open the menu Tools and navigate to License Management » File
request... as indicated in the following:

Tools

Calculator..

Scan Event Yiewer...

Lix lanagement File request...

izather Lags... File updata...

Figure 2-2: License file request menu

This will prompt Spycer to generate a license file request and to open a
new e-mail in your standard e-mail program. The lower part of the file
request e-mail may not be edited or deleted. It carries the information
valid for your specific system. You have to send this e-mail to the DVS
e-mail address as already entered in your address field.

Spycer will also save a *. txt file to your desktop with the information
valid for your system to document the license request for you. After
having received your e-mail license file request, DVS will generate a li-
cense for your specific system and send itin a *. txt file via e-mail to
you. Perform the following to load the license into your Spycer applica-
tion:

* Save the license *. txt file to your desktop.

» Start the Spycer application as described in section “Starting the
Software” on page 3-6.

* Open the menu Tools and navigate to License Management » File
update....

This will open a directory window named ’Please select the license
file’. Usually the path to the desktop on your system is selected auto-
matically.

* Select the license *. txt file by double-clicking it in the directory
window.

This will load the license file into Spycer. You will be informed about a
successful license update by a system message saying that the file was
added and you should now restart the software.

* Confirm the system message by clicking the button OK and restart
the Spycer application.

When starting the software again, Spycer should now run with all li-
censed features. When the licenses are not available, for example, be-
cause updating the license file did not work properly, Spycer (the user



interface as well as the background process) will run as Spycer Basic
only.

° For further information about license issues refer to section
1 “Troubleshooting” on page A-2.

2.3.3 The Dongle

The floating licenses for Spycer to run the Spycer application with a li-
censed feature set are provided via a dongle (USB flash drive). This USB
has to be connected to a free USB port on the computer system where
Spycer is to be installed (see section “Installing the Software” on
page 3-2). Depending on your order, the wanted number of floating li-
censes is available on that dongle and can be used on that number of
clients.

When running a local content management, it is generally recommend-
ed to plug in the dongle prior to starting the computer, which will en-
sure that the SpycerAgent operates with the licensed feature set
enabled. Additionally, it should be left connected to the system even
when the user interface of Spycer is not running, because otherwise
you may disrupt SpycerNet processes running on your system (e.g. a
defragmentation). It can be disconnected safely only when the comput-
er system is turned off. Further information about the SpycerAgent and
the SpycerNet can be found in section “Software Structure” on

page 2-4.

o The user interface of Spycer and the SpycerAgent run indepen-
l dently from each other. Both will check separately whether a
valid license is provided to enable the respective feature set
(see section “Software Structure” on page 2-4).

You find enclosed in the delivery of the licensed version of
Spycer a special key chain. Please fasten it to the dongle to rec-
ognize it later without difficulty as belonging to Spycer.

Mac only: Please note that in some cases your system may not
shut down or boot normally with the dongle plugged in. To
solve this problem, unplug the dongle during shutdown or
(re-)boot.

Floating License

The dongle provides a certain number of floating licenses for the shar-
ing only and the Spycer applications (user interface as well as
SpycerAgent) can grab the licenses from the dongle when they are
connecting to the SpycerNet (only one license per system will be as-
signed). As long as there are licenses available, each Spycer Basic reg-
istering in the SpycerNet will then run with the licensed feature set.
Once the maximum number of licenses is assigned, every other Spycer
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Basic connecting to the network will run with the limited feature set on-
ly.
To share the license of a dongle in the SpycerNet, the dongle has to be

configured as a license server. It will then monitor the shared licenses
and assign them anew when available again.

s ) Dedicated licenses, i.e. single workstation licenses, and float-
1 ing licenses can be used together in a SpycerNet.

To use floating licenses, the CodeMeter application has to be
installed on all participating systems, i.e. on the system that
distributes the licenses as well as the ones that receive them
(see section “Installing the Software” on page 3-2). You can
download the CodeMeter software from the CodeMeter inter-
net pages.

Configuring a Dongle to Run as a License Server

To enable a floating license and share the license of a dongle in the
SpycerNet, the dongle has to be configured as a license server. For this
perform the following:

* |f appropriate, start Spycer and select from its menu bar (see sec-
tion “The Integrated Spycer” on page 3-15) Tools » License
Management » License Server....

This will open the following dialog window:

¢ License Server 4

Far floating nenabled wEr
le awailable to
o Miarks also

Q| Disable |

Cancel

Figure 2-3: License server setup

¢ Activate the Enable license server radio button to enable the
license server for the connected dongle.

e Confirm your selection with the OK button.

After this another message window appears asking you again whether
you are really sure about your selection:

* Confirm the setting once more with the button YES.
* Next close the Spycer application and restart your system.

2-12
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Once the system is rebooted, the dongle connected locally to your sys-
tem will run as a license server offering other Spycer applications li-
censes to run with the licensed feature set enabled.

o To deactivate the license server for the dongle, you have to per-
1 form the same procedure as mentioned above with the follow-
ing exception: Instead of selecting the radio button to enable
the server you have to activate the radio button Disable li-
cense server.

How to Upgrade Spycer Basic to a Licensed Spycer

To upgrade the free version of Spycer (Spycer Basic) to a licensed ver-
sion of Spycer, you will need either a license file (see section “The Li-
cense File” on page 2-9) or a dongle that provides a valid floating
license for the application. You can order it from the DVS service de-
partment or via the Spycer websites (www.spycer.net or www.spyc-
er.de).

Once you have received the dongle perform the following:

. If your computer where Spycer is installed is already running,
1 instead of the following, perform the procedure described in
section “How to Connect the Dongle to a Running Computer”
on page 2-13.

* Connect the dongle to a free USB port on the computer system
where Spycer is installed.

* Next start the system and afterwards the Spycer user interface (see
section “Starting the Software” on page 3-6).

When Spycer is started, it will run with the licensed feature set.

How to Connect the Dongle to a Running Computer

To connect the dongle to a running computer system and run Spycer

with the licensed feature set enabled, you have to perform the follow-

ing:

* If running, close the Spycer user interface (see section “Exiting the
Software” on page 3-14).

* Connect the dongle to a free USB port on the computer system.

» Afterwards, restart the Spycer user interface (see section “Starting
the Software” on page 3-6).

The above steps are enough if a local content management is disabled
on your system (SpycerAgent not running). However, if your Spycer ap-
plication runs with the local content management enabled, during the
start-up of Spycer a message will appear informing you about the new
detected license. Then you have to do the following in addition:

* Follow the instructions given on the screen necessary to restart the
SpycerAgent.

2-13
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Once the SpycerAgent has started, the background process as well as
the user interface of Spycer will run with the licensed feature set en-
abled.

How to Grab a License

Licenses are not given only to the user interface of Spycer but the
SpycerAgent as well as soon as it is started (local content management
enabled, see section “SpycerAgent” on page 2-5). To get one of the li-
censes provided by a dongle in the SpycerNet, do as follows:

* |f the computer system where your Spycer application is installed is
turned off, simply start it.

» Afterwards, start the Spycer user interface (see section “Starting
the Software” on page 3-6).

During the loading of the operating system it will ask locally as well as
in the network if there is a dongle available and whether it provides a
license. If a license is available, it will be handed to the SpycerAgent (if
enabled) as well as the user interface of your Spycer application.

Nevertheless, to grab a license with an operating system already run-
ning and a Spycer application registering as Spycer Basic, you have to
do the following:

* If running, close the Spycer user interface (see section “Exiting the
Software” on page 3-14).

* Next restart the Spycer user interface (see section “Starting the
Software” on page 3-6).

During the start-up the Spycer user interface will ask locally as well as
in the network if there is a dongle available and whether it provides a
license. If a license is available, it will be given to your user interface.

The above steps will be enough to grab a license if a local content man-
agement is disabled on the system. However, if your Spycer application
runs with the local content management enabled, a message will ap-

pear informing you about the new detected license. Then you have to

do the following in addition:

* Follow the instructions given on the screen necessary to restart the
SpycerAgent.

Once the SpycerAgent has started, the background process as well as
the user interface of Spycer will run with the licensed feature set and
the procedure to grab a license is finished.

How to Get further Floating Licenses

The wanted number of floating licenses will be delivered on the dongle
by DVS. If all licenses are used and you need further Spycer applica-
tions, you can order one or more licenses.

Usually, you can order further floating licenses from the DVS service
department or via the Spycer websites (www.spycer.net or


http://www.spycer.net

Basics

www.spycer.de). However, if a dongle is already available, you can con-
vert a dedicated license to a floating license with the procedure de-
scribed in section “How to Update the License on the Dongle” on
page 2-1b.

How to Make a License Available again to the Dongle

Licenses are not given only to the user interface of Spycer but to the
SpycerAgent as well as soon as it is started (local content management
enabled, see section “SpycerAgent” on page 2-b). To make a license
available again to a dongle in the network, perform the following:

* If running, close the user interface of Spycer (see section “Exiting
the Software” on page 3-14).

The above step will be enough to give back the license to the dongle if
a local content management is disabled on the system. However, if
your Spycer application runs with the local content management en-
abled, you have to do the following in addition:

* With a local content management enabled on your system you
have to stop the background process SpycerAgent as well which
can be done either manually, for example, with its tool (see section
“The SpycerAgent Tool” on page A-18) or by shutting down the
computer system.

Once the user interface and the SpycerAgent are closed, the license of
your Spycer application is given back to the dongle and can then be as-
signed to another Spycer connecting to the network.

How to Update the License on the Dongle

The license on the dongle can be updated, for instance, to enable new
features or change an evaluation license to a non-expiring one. For this
you have to send a request with internal license information to DVS. In
return, you will receive an update file which has to be used to program
the dongle with a new license. After this the dongle is updated.

To update the license(s) on the dongle, do the following in detail:

* |f not already the case, connect the dongle to a free USB port on
the computer system and click the button OK in the message win-
dow.

» Start Spycer (see section “Starting the Software” on page 3-6).

* From its menu bar (see section “The Integrated Spycer” on
page 3-1b) select Tools » License Management » Request....

This will open a message window instructing you to connect the dongle
to the computer if not already done. Regard the system message and
proceed by answering it. The license information of the dongle will be
saved to a file with the name SpycerLicense.WibuCmRacC (exact lo-
cation will be detailed in a message window). Simultaneously your
standard e-mail program will be opened. The saved information will
also be added to an e-mail automatically.

2-15
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* Send the encrypted dongle information to DVS by doing one of the
following:

— If you are connected to the internet, send the dongle informa-
tion already added to the opened e-mail to
dongleupdate@dvs.de, or

— copy the file SpycerLicense.WibuCmRaC to a common stor-
age medium (e.g. CD-ROM) which you can then send to the
DVS service department per mail.

Once received, the e-mail/file will be evaluated by DVS and a license
update file with the extension *.wibuCmRaU will be created. DVS will
send this to you as soon as possible.

After receiving the license update file, do as follows:
» Store the file on the computer where the dongle is connected.

* |f appropriate, start Spycer and select from its menu bar Tools »
License Management » Update....

This will open a message window instructing you to connect your don-
gle to the computer and afterwards select the update file:

* |f not already the case, connect the dongle to the computer system
and click the button OK in the message window.

* In the opening window, browse for the update file *.WibuCmRaU
on your storage and confirm your choice with the button OPEN.

This will program the dongle with the new license which may take
some time. Once the programming of the dongle is complete, a mes-
sage will report this.

* Close the Spycer user interface and restart it to take the changes
into effect.

When Spycer is started once again, it will run with the new license.

s ) [ncasethenew license is still not available, you have to reboot
l your computer with the dongle connected.

When using the floating licenses on a dongle, you have to con-
figure the dongle as a license server to enable a sharing of the
license (see section “Configuring a Dongle to Run as a License
Server” on page 2-12).
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This chapter describes how to get started with Spycer. First the instal-
lation of the software is described, followed by details how to start the
application. When Spycer is started for the first time, it will guide you
through some initial configuration settings which will be described next
in this chapter. The chapter will be concluded with some more details
about the program, such as an explanation about how to exit the soft-
ware as well as a short description of the program variant of Spycer in-
tegrated in the DVS software on a video system by DVS (such as
CLIPSTER or the Pronto family).
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3.1

Installing the Software

The stand-alone application variant of Spycer able to run on a standard
computer system (see section “Program Variants of Spycer” on

page 1-6) has to be installed first. It is available for several operating
systems. This section describes for each available operating system
separately how to install Spycer.

o On some DVS video devices Spycer is already installed (e.g. on
1 the DVS-SAN, CLIPSTER or the Pronto family). Then you may
skip this section and continue with section “Starting the Soft-
ware” on page 3-6.

Linux only: When installing Spycer on this system, the Code-
Meter installation is mandatory.

The CodeMeter software can be downloaded from the Code-
Meter internet pages if necessary. The newest version of the
Spycer application can be found on the Spycer internet site
(www.spycer.net or www.spycer.de).

After the installation of the software, you have to update the license(s)
on your system performing the steps as described in section “The Li-
cense File” on page 2-9 or in section “The Dongle” on page 2-11, de-
pending on the number of Spycer clients.

3.1.1 Installation under Linux

The installation of a stand-alone Spycer for Linux operating systems
normally requires two files:

— The CodeMeter installation file and
— the Spycer installation file.

If you are in possession of a licensed Spycer, they usually can be found
on the enclosed CD-ROM. With a licensed Spycer it is recommended

to install the CodeMeter application first. In case you require Spycer Ba-
sic only, you can leave out the CodeMeter installation.

CodeMeter Installation

With a licensed version of Spycer it is recommended to install the
CodeMeter application first:

* Open a command line (shell) and log on to the system as root.
* Then install the CodeMeter application, for example, by entering:

rpm -Uhv <paths>/CodeMeter-<version no.>.
<0S architectures>.rpm


http://www.spycer.net
http://www.spycer.de
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This installs the CodeMeter application on your computer. The installa-
tion is finished as soon as a message reports this. After this continue
the installation with the installation of the Spycer application.

Spycer Installation

To install Spycer, perform the following:

* If applicable, open a command line (shell) and log on to the system
as root.

* Then install the Spycer application by entering, for example:

rpm -Uhv <path>/Spycer-<version no.s>.
<0S architectures>.rpm

This installs all necessary files and libraries of the update option of
Spycer on the computer system. The update option should be preferred
to the installation option -ihv. It will update an already installed Spycer
version or install the Spycer application from new. As next step you
have to license the software as described in section “Licensing” on
page 2-9.

Having finished all steps, the installation of the software is complete
and you can perform its initial setup to run the program. It has to be
made when the Spycer application is started for the first time and can
be called up with a normal user account (see section “Starting the Soft-
ware” on page 3-6 and section “Initial Setup of Spycer” on page 3-8).

o Under Linux the Spycer application can usually be found in the
1 system menu under the entry Audio & Video » Spycer. |t can
be deinstalled by entering rpm -e Spycer inacommand line.

The CodeMeter application can usually be found in the system
menu under the entry System » CodeMeter Control Center.
It can be deinstalled by entering rpm -e CodeMeter4 in a
command line.

3.1.2 Installation under Mac OS

The installation of a stand-alone Spycer for the Mac operating system
usually comes as a single archive file that contains two sets of installa-
tions:

— The CodeMeter installation and
— the Spycer installation.

If you are in possession of a licensed Spycer, it usually can be found on
the enclosed CD-ROM. When using floating licenses on a dongle, in-
stalling the CodeMeter application is mandatory. In this case, it is rec-
ommended to install the CodeMeter application first. In case you

require Spycer Basic only or license the software via the license file (see
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3-4

section “The License File” on page 2-9), you can leave out the Code-
Meter installation.

CodeMeter Installation

When licensing Spycer via floating licenses on a dongle, it is recom-
mended to install the CodeMeter application first:

* Open the installation file of Spycer
(Spycer-<version no.>.dmg, e.g. with a double-click of the
mouse).

This will mount the Spycer application as a volume and display its con-
tent on the screen.

* From this volume open the installation file of the CodeMeter appli-
cation (CmRuntimeUser <version no.>.dmg, e.g. with a dou-
ble-click of the mouse).

This as well will mount the CodeMeter application as a volume and dis-
play its content on the screen.

* From the last volume install the CodeMeter application by execut-
ing its * . mpkg file.

The installation routine of the CodeMeter application is started which
will guide you through the installation.

* Follow the instructions given on the screen.

The CodeMeter application is then installed on your computer. The in-
stallation is finished as soon as a message reports this. After this con-
tinue the installation with the installation of the Spycer application.

Spycer Installation

To install Spycer, perform the following:

* If not already the case, open the installation file of Spycer which will
mount it as a volume (Spycer-<version no.>.dmg, €.g. with a
double-click of the mouse).

* From this volume install the Spycer application by executing its
*  mpkg file.

The installation routine of the Spycer application is started which will
guide you through the installation.

* Follow the instructions given on the screen.

This installs all necessary files and libraries of Spycer on the computer
system. As next step you have to license the software as described in
section “Licensing” on page 2-9.

Having finished all steps, the installation of the software is complete
and you can perform its initial setup to run the program. It has to be
made when the Spycer application is started for the first time and can
be called up with a normal user account (see section “Starting the Soft-
ware” on page 3-6 and section “Initial Setup of Spycer” on page 3-8).
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3.1.3 Installation under Windows

The installation routine of a stand-alone Spycer for the Windows oper-
ating system is a single executable file. Usually, it can be found on the
enclosed CD-ROM. To begin the installation, perform the following:

* Open a file manager (e.g. Windows Explorer) on the computer sys-
tem and browse the CD-ROM.

* Execute the installation file of Spycer, for example, with a double-
click of the mouse.

This starts the installation routine which will guide you through the in-
stallation.

» Follow the instructions given on the screen.

o When using floating licenses (see section “The Dongle” on

1 page 2-11), all involved systems must have the CodeMeter ap-
plication installed. For this the CodeMeter check box has to be
activated when appearing on the screen during the installation
routine.

During the installation procedure all necessary files and libraries will be
installed on the computer system. The installation is finished as soon as
a message reports this. As next step you have to license the software
as described in section “Licensing” on page 2-9.

Having finished all steps, the installation of the software is complete
and you can perform its initial setup to run the program. It has to be
made when the Spycer application is started for the first time (see sec-
tion “Starting the Software” on page 3-6 and section “Initial Setup of
Spycer” on page 3-8).

. To run Spycer successfully under the Windows Vista operating
1 system, please see section “Troubleshooting under Windows
Vista” on page A-b.
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3.2 Starting the Software

This section provides you with a description how to get Spycer started.
Because the software can be run under several operating systems, it is
divided into the different starting procedures for each supported oper-
ating system.

o On several DVS video systems (e.g. CLIPSTER or the Pronto
l family) Spycer is by default integrated in the DVS software and
thus not needed as a stand-alone application. To start the soft-
ware there, you have to start the respective DVS software (see
section “Starting the Integrated Spycer” on page 3-15).

The very first starting of the software will launch its initial setup
necessary to run the software (see section “Initial Setup of
Spycer” on page 3-8).

When Spycer is started, a log file is written to a directory that
logs the actions performed with the Spycer user interface (see
section “Gathering Diagnostic Information” on page A-22 and
section “Interesting Files and Folders” on page A-14 for further
information).

3.2.1 Starting the Software under Linux

To get the software started under the Linux operating system, perform
the following:

* Select from the system menu of Linux the entry Audio & Video »
Spycer.
Alternatively, you may also start the program from a command line
(shell) by entering Spycer.

This will load the Spycer application by DVS (see section “The Integrat-
ed Spycer” on page 3-15).

3.2.2 Starting the Software under Mac OS

3-6

To get the software started under a Mac operating system, perform the
following:

* Select from the Applications folder of Mac OS the entry
Spycer. app.

This will load the Spycer application by DVS (see section “The Integrat-
ed Spycer” on page 3-15).
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3.2.3 Starting the Software under Windows

To get the software started under the Windows operating system, per-
form the following:

* Select from the START button menu of Windows on the submenu
DVS the entry for Spycer (for example, All Programs » DVS » DVS
Spycer).

Alternatively, you may also start the program via the Spycer icon on
the desktop of Windows.

This will load the Spycer application by DVS (see section “The Integrat-
ed Spycer” on page 3-15).

o In case the option Mount network drives was selected the last
1 time the program was exited, you will be asked by a message
window to type in your password to legitimize your access to
mounted network drives (see section “The Group 'Network
Drives’ (Windows Only)” on page 9-19).
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3.3

Initial Setup of Spycer

When Spycer is started for the first time (see section “Starting the Soft-
ware” on page 3-6), it will automatically initiate a setup procedure and
guide you through some configuration settings. These have to be spec-
ified in order to run Spycer.

In detail the setup procedure consists of the following configuration
steps:

General settings

Administrative settings

Scan filter settings

Watch folder settings

Remote access permissions

Finishing the setup

2 e o

Once the respective settings for the displayed configuration step are
concluded, you can proceed to the following configuration step with
the NEXT button until the setup is finished and the software is started.
The button BACK takes you to the previous configuration step while the
button CANCEL aborts the setup procedure without starting the pro-
gram. The required settings possibilities will be explained in this sec-
tion.

o The settings of the initial setup procedure are identical to some
1 of the general configuration settings of Spycer. Therefore, they
can be changed afterwards as well. For a detailed description
of the configuration settings please refer to section “The Con-
figuration Menu” on page 9-2.

For further information about the SpycerNet and the back-
ground process SpycerAgent see section “Software Structure”
on page 2-4.

3.3.1 General Settings

The first configuration settings to make are some general settings. With
them you determine the network connection of Spycer and whether a
local content management SpycerAgent should be enabled or dis-
abled:
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should use for the Spy

should use forthe Spyp

ymmunication restricted to the subnet)

Fart {00001

Unicast range: From port 00001 To port Q0002

Apply

uninstalled

|

Figure 3-1: General settings

The settings of the group General in the setup menu do not differ from
the settings in the group General of the menu option Config.... The op-
tions and settings that are to be found are described in section “The

Group 'General
have to:

rn

on page 9-11. In this setup window you generally

— Set the IP address that Spycer should use to communicate with
other Spycer applications in a network, thereby forming the
SpycerNet.

i @

For downwards compatibility to Spycer versions prior 1.4 you
can activate the respective check box. In this case some net-
work ports have to be free and available to connect successful-
ly to the SpycerNet. Otherwise Spycer will be confined to its
localhost only (IP address 127.0.0.1 has to be used). For further
information about this please see section “Important Notes”
on page 1-9.

— Assign a name at will to your home system (host).
— Enable the local content management (SpycerAgent) if wanted.

i @

You have to select one of the radio buttons for the local con-
tent management option. As long as no selection is made, the
button NEXT will be unavailable.

If the IP address is set to ‘localhost’ and the local content
management is disabled, Spycer will display no data at all.

If the SpycerAgent is not running, disable the local content
management and then enable it again by using the radio but-
tons.
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3.3.2 Administrative Settings

In the following step you can define and manage computer groups for
a secured SpycerNet by using the existing infrastructure. Every peer
can have a password protected administrator account and peers can be
(remotely) assigned to a secure SpycerNet group. Secured Spycer
peers are only visible when they belong to the same group.

& Setup

Login:
Mo administrator passmard

Set administratar pasaword

Figure 3-2: Administrative settings

The settings of the group Administrator in the setup menu do not differ
from the settings in the group Administrator of the menu option Con-
fig.... The options and settings that are to be found are described in sec-
tion “The Group "Administrator’” on page 9-4. In this setup window you
generally have to:

— If wanted, log in and/or set a new password.
— If wanted, assign peers from the SpycerNet list to a particular group
or add a new group.

3.3.3 Scan Filter Settings

3-10

With a local content management enabled, you also have to determine
the file types that Spycer should not display as sequence file types. This
step will be skipped in case the local content management has been
disabled (see section “General Settings” on page 3-8 and section “The
Group 'General’” on page 9-11).
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& Setup

& matup language file

F/'guré 3-3: Scan filter settings

The settings of the group Scan Filter in the setup menu do not differ
from the settings in the group Scan Filter of the menu option Config....
The options and settings that are to be found are described in section

“The Group 'Scan Filter'” on page 9-22. In this setup window you gen-
erally have to:

— Add additional file formats to the list with the help of the button
ADD, or revise the list by either altering entries (double-click with
the mouse) or selecting an entry and deleting it from the list with
the button REMOVE.

3.3.4 Watch Folder Settings

If a local content management has been enabled, you have to set the
watch folders next. This step will be skipped in case the local content
management has been disabled (SpycerAgent disabled, see section
“General Settings” on page 3-8).
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& Setup

include panding

Include Folder.. Exclude Folder..

Figure 3:4.' Watch folders settings

The settings of the group Watch Folders in the setup menu do not dif-
fer from the settings in the group Watch Folders of the menu option
Config.... The options and settings that are to be found are described
in section “The Group "Watch Folders’” on page 9-24. In this setup win-
dow you generally have to:

— Determine that a folder (either a drive or directory) should be
watched by the background process by adding it to the list box with
the button INCLUDE FOLDER....

3.3.5 Remote Access Permissions

If a local content management has been enabled, you have to set the
remote access permissions next. This step will be skipped in case the
local content management has been disabled (see section “General
Settings” on page 3-8).

e e

Select all Dezelact all

Figure 3-5: Permissions settings
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The settings of the group Permissions in the setup menu do not differ
from the settings in the group Permissions of the menu option Con-

fig.... The options and settings that are to be found are described in sec-
tion “The Group "'Permissions’” on page 9-21. In this setup window you
generally have to:

— Determine what other Spycer applications in the network
(SpycerNet) are allowed to do on your system with the remote
access permissions.

3.3.6 Finishing the Setup

When the last configuration is made, the following screen will be dis-
played:

) Setup . | i “-“’.l

4. Setup completed

Figure 3-6: Setup completed

Then you can finish the setup procedure by pressing the button OK
which will start the Spycer application (see section “The Integrated
Spycer” on page 3-15).

o If Spycer is started for the first time with no database available,
] | theinitial scanning of the watched folders may take some time
depending on the amount of data stored in these locations. As
long as the scanning process is active, your system will have
the status 'busy’ (see section “The Status Bar” on page 5-9).
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3.4 Exiting the Software

3-14

To end the current Spycer session, perform the following:

i

The Spycer application integrated in the DVS software on a vid-
eo system by DVS (such as CLIPSTER or the Pronto family) will
be ended when the complete DVS software is exited. Further
information about how to do this can be found in the docu-
mentation of the video system software, while for more infor-
mation about the integrated Spycer consult section “The
Integrated Spycer” on page 3-15.

Exiting Spycer will not terminate the background process
when a local content management is enabled. The process is
started during the loading of the operating system (fully oper-
ational even with no user logged in) and terminated only when
the system is shut down (see section “SpycerAgent” on
page 2-5 for more details).

* Select the option Quit on the Spycer menu (Mac: Spycer » Quit

Spycer) or press the key combination [Alt + F4] (Mac: [ + Q))
alternatively.

i

Linux/Windows only: In full-screen mode the menu Spycer
will be replaced by the Spycer icon. However, it provides the

same menu options as the menu Spycer (see section “The
'Spycer'/Spycer lcon Menu on Windows/Linux” on
page 4-12).

The user interface of Spycer will be closed and then you can, for in-
stance, shut down the computer system.

i

When exiting Spycer, the log file opened during the starting of
the application is finished and saved (see section “Starting the
Software” on page 3-6).
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3.5 The Integrated Spycer

On several DVS video systems, such as CLIPSTER or the Pronto family,
Spycer is integrated in the DVS software which makes it unnecessary
to install Spycer as a stand-alone application. With the integrated
Spycer you can seamlessly work together with the other software mod-
ules of the DVS software.

3.5.1 Starting the Integrated Spycer

To start Spycer integrated in the DVS software, you have to start the
DVS software. Then it can be loaded the same way as most other mod-
ules of the DVS software:

» Start the DVS software of the DVS video device. For details about
how to do this please refer to the documentation of the video sys-
tem software.

* Next press the button SPYCER in the task bar of the DVS software
(see figure 3-7 on page 3-16).

o When the software module of Spycer is started for the first

1 time, the initial setup of the application may be launched. Then
you have to detail the necessary configurations as described in
section “Initial Setup of Spycer” on page 3-8. If not, itis recom-
mended to check whether the configurations match your
needs (see section “The Configuration Menu” on page 9-2).

In case the check box Mount network drives was activated
the last time the program was exited, you will be asked by a
message window to type in your password to legitimize your
access to mounted network drives (see section “The Group
"Network Drives’ (Windows Only)” on page 9-19).

This will load Spycer as a software module of the DVS software:
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task bar —e

Figure 3-7: The integrated Spycer

3.5.2 Using the Integrated Spycer

The integrated Spycer can be used the same way as described in this
user guide. In addition, it provides the following functionality:

With the integrated Spycer you will notice right below the menu bar of
the DVS software the bin as it is available in the Edit or I/0O Tool. Once
audio and video clips are displayed in the browse and search area that
are locally available or stored on a SAN, they can be dragged and
dropped to the contents area of the bin:

GENERIC ¥

Figure 3-8: drag ‘n’ drop of clip to bin
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This will add the selected clip to the contents area of the bin.

Below the user interface of the Spycer software module the task bar of
the DVS software will be available as usual. With it you can switch to
the other modules of the software, such as the Edit or the I/O Tool. After
a switching to the Edit or I/0 Tool of the DVS software, the clip(s) added
to the bin will still be available and can be used as usual.

s ) Furtherinformation about the bin and the task bar can be
1 found in the documentation of the Edit Tool of the respective
DVS video system.

3.5.3 Configuring the Integrated Spycer

The general configuration settings available for the stand-alone applica-
tion of Spycer (see section “The Configuration Menu” on page 9-2) can
be set for the integrated Spycer as well. For this you have to start the
configuration tool of the DVS software.

« Configuration >

Log in as administrator

Figure 3-9: The Configuration Tool with Spycer settings

Under the default settings for the DVS software (tab Default) you find
several entries regarding Spycer in the group list. They provide the
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same settings as described in section “The Configuration Menu” on
page 9-2 and some additional settings depending on the system.

s ) Further information about the configuration tool of the DVS
1 software can be found in the documentation of your DVS video
system.

3.5.4 Exiting the Integrated Spycer

The Spycer application integrated in the video system’s software will be
ended when the whole DVS software is exited. Further information
about how to do this can be found in the documentation of the video
system software.

o Exiting the DVS software and thus the integrated Spycer will
1 not terminate the background process when a local content
management is enabled. The process is started during the
loading of the operating system (fully operational even with no
user logged in) and terminated only when the system is shut
down (see section “SpycerAgent” on page 2-5 for more de-
tails).




Software Reference

This chapter provides you with a detailed reference and overview of the
user interface with all its tabs and menus. The items of the different
tabs will be outlined, when necessary, separately for every mode and
state. Furthermore, you find a description about how to change the lay-
out of the user interface and explanations about the menu bar to the
top left of the program.
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4.1 Overview of the User Interface

This section gives you a first overview of the Spycer user interface. Af-
ter having started the software (see section “Starting the Software” on
page 3-6), you can, e.g. select content in the preview area (see chapter
“Previewing Data” on page 6-1) or use the search feature in Spycer
(see chapter “Browsing and Searching” on page b-1).

menu bar mode buttons

& Spycer for DVS-SAN J |
; 2 g .
i

GENERIC ¥

Figure 4-1: Spycer user interface

The display of the main window can be switched to the modes meta-
data, job list, task scheduler and record scheduler when pressing the
respective mode buttons right under the menu bar.

menu bar mode buttons

&y Spycer for [WVS-SAN

Tools  Wiew Help

Job List Tazk Scheduler tecord Scheduler

Figure 4-2: Menu bar and mode buttons

By default the program opens in the metadata mode. In the following
subsections you find further information about the different views of
the Spycer user interface.
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4.1.1 User Interface in the Metadata Mode

With the button METADATA directly below the menu bar you can switch
to the metadata area of Spycer. The following figure shows the user in-
terface of Spycer when the METADATA button is pressed:

menu bar metadata area preview area

& Spy(ngGrD\'l\N || B |

GENERIC hd

browse and search area
Figure 4-3: User interface in metadata mode

The user interface provides the following items:

menu bar The menu bar provides access to functions and
tasks of an administrative nature to Spycer. Here
you find, for example, its configuration settings as
well as several tools. A short reference to the menu
bar can be found in section “The Menu Bar” on
page 4-12.

s ) On Mac systems the menu bar is not avail-
l able as it is under other operating sys-
tems. Instead its options can be found in
the standard program menu bar of the op-
erating system (see section “The Menu
Bar on Mac OS” on page 4-18).

4-3




Spycer User Guide

metadata area

Directly below the menu bar you find the metadata
area which will show you the properties and meta-
data of the file currently singled out in the browse
and search area. You can switch through as well as
add and edit the metadata easily with the buttons
provided to the left of the user interface. For more
details about the metadata area and its various
functions see chapter “Working with Metadata” on
page 8-1.

preview area

To the right of the metadata area you find the pre-
view area. In Spycer this area is used to view or lis-
ten to the currently singled out data. At the top you
find a video overlay where you see the content of
the material (e.g. of video clips). Below the video
overlay a scrub bar of the material’s timeline is avail-
able as well as the preview controls. The preview
area is described in chapter “Browsing and Search-
ing” on page b-1.

browse and
search area

With the browse and search area you can browse
local or network storages in up to two browsing
panes. This area also provides the marker and the
search tools of Spycer. This area and its functional-
ity are explained in section “The Browse and Search
Area” on page 4-8 and in chapter “Software Refer-
ence” on page 4-1.

4.1.2 User Interface in the Job List Mode

4-4

With the button JoB LIST directly below the menu bar you can switch
to the job list of Spycer. The following figure shows the user interface
of Spycer when the JoB LIST button is pressed:
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menu bar job list area

& Spycer for

browse and search area
Figure 4-4: User interface in job list mode

menu bar Same as in section “User Interface in the Metadata
Mode"” on page 4-3.

job list area The job list area provides information about jobs
that are performed on your system or that you have
initiated on other systems in the SpycerNet. Addi-
tionally, these jobs can be controlled from here, for
example, by canceling them.

browse and Same as in section “User Interface in the Metadata
search area Mode"” on page 4-3.

4.1.3 User Interface in the Task Scheduler Mode

With the button TASK SCHEDULER directly below the menu bar you can
switch to the task scheduler of Spycer. The following figure shows the
user interface of Spycer when the TASK SCHEDULER button is pressed:

4-5



Spycer User Guide

ﬁ

menu bar

& Spycer for ]JS-‘l

task scheduler area

| = | E |z

browse and search area
Figure 4-5: User interface in task scheduler mode

menu bar

Same as in section “User Interface in the Metadata
Mode"” on page 4-3.

task scheduler

The task scheduler area provides information about

search area

area scheduled tasks on your system or on other sys-
tems in the SpycerNet. Additionally, the tasks on
your local peer can be controlled from here, for ex-
ample, by canceling them.

browse and Same as in section “User Interface in the Metadata

Mode"” on page 4-3.

4.1.4 User Interface in the Record Scheduler Mode

With the button RECORD SCHEDULER directly below the menu bar you
can switch to the record scheduler of Spycer. The following figure
shows the user interface of Spycer when the RECORD SCHEDULER but-

ton is pressed:

4-6



E

Software Reference

menu bar

machine list

Fnergaens)y

PEIEREIREREEERE

scheduler display job list

browse and search area
Figure 4-6. User interface in record scheduler mode

menu bar

Same as in section “User Interface in the Metada-
ta Mode"” on page 4-3.

scheduler display

Showing the timeline and the record bars (queued
in, running and completed) in an overview.

job list Job list in the record scheduler showing all fin-
ished, interrupted, paused, etc. jobs.
browse and Same as in section “User Interface in the Metada-

search area

ta Mode” on page 4-3.

machine list

Lists all VENICE devices configured for FIMS in
form of their identifiers like IP addresses and
channel numbers, or host names and channel
numbers.

i @

plete descr

When switching to the record scheduler in Spycer, the system
will prompt you to configure the FIMS settings. You can disre-
gard this system message if not using this feature. The com-

iption of the record scheduler with all its options

and features can be found in the “VENICE Client Software”

user guide.
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4.1.5 The Browse and Search Area

In the lower part of the Spycer user interface, you find the browse and
search area. With it you can browse local or network storages in up to
two browsing panes. This area also provides Spycer's marker and
search tools which are detailed below.

directory tree

4-8

For switching between the different modes of the browse and search
area use the buttons FILE SYSTEM, MARKER and SEARCH at the top left
of the browse and search area.

Figure 4-7: Mode buttons in the browse and search area

When switching the modes, the user interface of the browse and
search area alters and you find the respective buttons and options.

File System Mode

In the file system mode, you find two browsing panes, each containing
a directory tree and a contents area for browsing the Spycer network

or your local peer, e.g. for dragging files into the preview area. You can
select a particular system or the whole network from the drop-down list
at the top left of the directory tree. The following figure shows the user
interface in file system mode:

contents area directory tree contents area

Figure 4-8: Browse and search area in file system mode

directory tree

Shows the contents of the system/network in a
folder structure.

contents area

Shows you the contents of the currently selected
drive/directory in the 'directory tree’.
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directory tree Shows the contents of the system/network in a
folder structure.

contents area Shows you the contents of the currently selected

drive/directory in the ‘directory tree’.

Marker Mode

In the marker mode, you can browse, view or set sync markers for au-
dio and video content. Markers are certain markings to sync the audio
and video track of the material that was shot on a day. After this and
further configurations in Spycer, it is then possible to create dailies e.g.
in the DVS CLIPSTER software.

Further information about markers and their usage can be found in the
supplement user guides of the respective devices. The following figure
shows the user interface in marker mode:

shoot dates marker list

Figure 4-9: Browse and search area in marker mode

shoot dates Lists all available contents by its shoot date.

Above this list you find the network drop-down list
that can be used to select a particular system or
the whole network from it.

marker list Provides you with a quick overview of all the
markers of a certain selected shoot date.

When double-clicking a file in the marker list, you can view it and its set
markers in the preview area (see section “User Interface in the Metada-
ta Mode"” on page 4-3). Furthermore you can set or configure the de-
scriptive data and save the files to a certain destination.

Search Mode

In the search mode, you can search for data as easily as you can
browse for it. You will be able to find any searched for material by com-
bining various search parameters, such as file names or metadata infor-
mation. You can select a particular system or the whole network from
the drop-down list at the top left of the search parameters and then en-
ter the search parameters in the respective fields. The following figure
shows the user interface in search mode:

4-9
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search parameters area

4-10

Find it

results area

Figure 4-10: Browse and search area in search mode

search parameters
area

Provides you with buttons, drop-down lists and
entry fields to configure the search parameters.
You can select/deselect and add/remove search
parameters to search the contents of the Spycer
network or of a particular system. When clicking
the button FIND IT!, you activate the search.

results area

Lists all search results you have configured with
the search parameters. \When double-clicking an
entry, the content will be shown in the preview
area.
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4.2 Changing the Layout of the User Interface

The layout of the Spycer user interface can be changed to your personal
requirements. You can maximize the view of the user interface or of the
preview area as well as change the size of areas. All alterations will be
saved when the software is closed.

This section describes how to change the size of areas of Spycer.

s ) [nformation about how to maximize certain areas or the user
l interface itself can be found in section “The Video Overlay” on
page 6-4 and section “The 'Spycer’/Spycer Icon Menu on Win-
dows/Linux” on page 4-12.

Generally, the software user interface shows a separation line vertically
or horizontally wherever the layout of areas can be changed.

Figure 4-11: Separation line between areas

This line can be taken with the mouse and moved to another position.
For example, to alter the size of the two browsing panes perform the
following:

* Move the separation line between the two browsing panes to the
left or to the right:

H [n] | |'!||1_|'|_I oc

204
1.31619

Q0025

A 00 %%

Figure 4-12: Example how to adjust the layout of the software

The horizontal size of the two browsing panes will adjust accordingly.

Furthermore, if you pull a separation line completely to the left/right or
up/down, the respective area will no longer be visible and thus can be
turned off (hidden). This way you can, for instance, make information

visible that you may otherwise have to scroll to.

o The layout of the user interface can be set back to a default lay-
l out by using the menu option Reset Layout on the menu View
(see section “The 'View’ Menu” on page 4-1b).
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4.3 The Menu Bar

At the top of a stand-alone Spycer application you find a menu bar. It
provides access to functions and tasks of an administrative nature to
the Spycer application. Here you find, for example, its configuration
settings as well as several tools. This section explains the menu bar as
it is available on a Windows/Linux and on a Mac OS system separately.
For a reference where to find the individual menu options on Mac sys-
tems see section “The Menu Bar on Mac OS” on page 4-18.

4.3.1 The 'Spycer’/Spycer lcon Menu on Windows/Linux

4-12

The menu Spycer contains the following menu options:

bini

Quit

Alt+Return =1 Y Alt+Return

Quit

Figure 4-13: The ‘Spycer’ and the Spycer icon menu

In full-screen mode (see 'Full screen’ in the table on page 4-12), the
menu Spycer will be replaced by the Spycer icon (Linux and Windows
only). However, then it still provides the same menu options as the
menu Spycer shown in the figure above and detailed in the following:

Menu Option

Explanation

Full screen

Select the menu option Full screen to activate the
full-screen mode of Spycer. In full-screen mode,

the menu Spycer will be replaced by the Spycer
icon (Linux and Windows only) but still provides

access to the same menu options.

Alternatively, you can press [Alt + Return] on your
keyboard.

Minimize

To access other programs that are installed on
your system when Spycer runs in the full-screen
mode, click the Minimize menu option on the
menu Spycer. |t reduces the Spycer user inter-
face to a button on the taskbar of the operating
system.

Quit

The menu option Quit exits the Spycer user inter-
face. Further details about this can be found in
section “Exiting the Software” on page 3-14.
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4.3.2 The 'Options’ Menu

The Options menu provides a menu option to set up and configure the
Spycer application. It contains the menu option as shown below:

Figure 4-14. The ‘Options” menu

Config... With the menu option Config... you can access the gen-
eral configuration settings of the Spycer application. To
open up the configuration settings, you can press [F4]
on your keyboard as well. You find further information
about them in section “The Configuration Menu” on
page 9-2.

4.3.3 The 'Tools’ Menu

On the Tools menu you find several tools to facilitate the usage of the
Spycer application. It provides the following menu options:

Taals

Calculator..

zather

Figure 4-15: The “Tools” menu

4-13
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Menu Option Explanation

Calculator... With the calculator of Spycer you can cal-
culate from an adjustable setting of video
formats its maximum recording time (by a
given amount of storage space) or the re-
quired storage (by a given duration of the
video data). It is described in more detail in
section “Calculator” on page 7-13. To
open this menu option, you can press
[F11] on your keyboard as well.

Scan Event Viewer... This menu option gives you the possibility
to observe all commands carried out by
the SpycerAgent. You can select the net-
work view or a particular peer and the
commands are sorted by priority.

To open this menu option, you can press
[F8] on your keyboard as well.

License Management | The License Management menu option
allows you to configure the licenses. It
opens a submenu with the options

File request, File update and

License Server (for floating licenses, see
section “Floating License” on page 2-11)
which are detailed below this table.

Gather Logs... Gathers log files from the server which de-
tail the actions performed by and with the
VENICE server. You may get asked by the
DVS service department to send in these
files as well as others in case of problems
with e.g. CLIPSTER or VENICE. They will
be saved at a location of your choice in an
archive file.

Licenzse Management Request...
Update...

License Senver ...

Figure 4-16: Submenu of the menu option ‘License Management’
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Menu Option Explanation

File request... When selecting this menu option, an auto-
matic e-mail will be created with a license
request for your local Spycer version. This
e-mail has to be sent to DVS.

File update... This menu option opens a directory win-
dow for you to browse the text file with the
license code sent by DVS. See section “Li-
censing” on page 2-9 for further reading.

License Server... With the menu option License Server...
you make a set of floating licenses avail-
able to other Spycers in a network. Further
information about this and how to do it can
be found in section “Configuring a Dongle
to Run as a License Server” on page 2-12.

For details about the license update on a
dongle refer to section “How to Update
the License on the Dongle” on page 2-15b.

4.3.4 The 'View' Menu

With the menu View you can change the layout of the user interface in
certain ways. It contains the following menu options:

LEIT=101)

e Previewm Sre 3

Figure 4-17: The View” menu
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Menu Option

Explanation

Reset Layout

In case you have changed the layout of
the user interface, for example, by hiding
areas (see section “Exiting the Software”
on page 3-14), it can be reset with this
menu option. Then the layout of the user
interface will be set to a default layout and
all areas will be visible again.

Maximize Preview Area

This menu option performs the same op-
eration as the Maximize menu option of
the video overlay’s context menu in the
preview area (see section “The Video
Overlay” on page 6-4), i.e. it maximizes
the view on the preview area. To restore
the layout, you can use the menu option
Reset Layout (see above) or the menu
option Minimize on the context menu of
the preview area (see section “The Video
Overlay” on page 6-4).

4.3.5 The 'Help’ Menu

You can get additional information about the Spycer application via the
menu option of the menu Help. It contains the following menu options:

About

fanual (html)

lanual (pdf)

4-16

Figure 4-18: The "Help” menu
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Menu Option

Explanation

About

With this menu option you can receive fur-
ther information about the Spycer soft-
ware. In the opening window you find, for
example, the precise version number of
the software or additional license informa-
tion (e.g. the serial number of the dongle
or the expiration date and time). The latter
may be useful to troubleshoot license is-
sues.

To open this menu option, you can press
[F12] on your keyboard as well.

Manual (html)

The documentation of the Spycer applica-
tion can be accessed via this menu option.
It opens the documentation in HTML for-
mat. Alternatively you can press [F1] on
your keyboard to open it.

Manual (pdf)

The documentation is also available in PDF
format which is most suited if you want to
print out the document. It can be accessed
easily via the menu option Manual (pdf).

s ) On Mac systems the menu bar is
l not available as it is under other
operating systems. Instead its op-
tions can be found in the standard
program menu bar of the operat-
Ing system (see section “The
Menu Bar on Mac OS” on

page 4-18).
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4.3.6 The Menu Bar on Mac OS

The menu baras itis explained in the preceding sections is not available
on Mac systems. Instead the individual menu options can be found in-
tegrated in the standard program menu bar.

4-18

Tools View Help

About Spycer
Preferences... 3£,

Services

Hide Spycer
Hide Others
Show All

Quit Spycer

Image

F/'gure-4— 19: The program menu bar of Mac OS

This section details where to find the menu options compared to the
Linux/Windows versions of the software:

Location on Linux/Windows

Location on Mac OS

Spycer » | Full screen

View » Full screen

Minimize

View » Minimize

Quit

Spycer » Quit Spycer

Options » | Config...

Spycer » Preferences

Tools » Calculator...

Tools » Calculator

License Request... | Tools » License
Manage- Management » Request...
ment » Update... | Tools » License
Management » Update...
License Tools » License
Server... Management » License
Server...
View » Reset Layout View » Reset Layout

Maximize Preview Area

View » Maximize Preview
Area

Help » About Spycer » About Spycer
Manual (html) Help » Manual (html)
Manual (pdf) Help » Manual (pdf)
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In the lower part of the Spycer user interface, you find the browse and
search area. With it you can browse local or network storages in up to
two browsing panes.

This area provides the directory trees and the contents areas of the soft-
ware. It also contains Spycer’s marker feature and the search tool en-

abling you to find any searched for material easily by combining various
search parameters, such as file names or metadata information.

This chapter first explains the browse tool, followed by a description
how to initiate and perform a search with Spycer.
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5.1 Browsing for Data

With the button FILE SYSTEM at the top left side of the
browse and search area you can activate the browse
tool of Spycer if not already visible in the user interface.

Beauty_f

amaterial

File Mame
File Farmat

hann

1 m

All Files = Texd All Files
Figure 5-1: The browse tool

It offers two browsing panes for overview purposes and drag-and-drop
procedures. The following figure gives an overview of one of the brows-

ing panes:
directory directory contents status
tree controls area bar

e Hetuork [ & Path: | v:ise i
! File Nam File Fath
[HUG

audino

berlin

Image  |All Files ) Online

Figure 5-2: Overview of a browsing pane
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5.1.1 The Directory Tree

The directory tree enables you to see the contents of your system/net-
work in a folder structure.

e— network/system
drop-down list

folder structure

Figure 5-3: Overview of the directory tree

With the network/system drop-down list at the top of the directory tree
you can select whether you want to view the contents of a particular
system or the whole network:

| &
Fila Ham
aldarion

aludra

ancalagon

anoat

digil

linus

Figure 5-4: Network/system drop-down list

Once a selection is made in the drop-down list, you can browse the net-
work or system in the folder structure. Either by double-clicking an en-
try with the mouse or by clicking on the plus (+) or minus (-) sign in
front of an icon you can expand or collapse the contents sorted under
this item.

The different icons provided by the directory tree indicate the following:

The whole network. The whole network, i.e. all systems
-t in the SpycerNet as well as the home system, is dis-
played and can be used for the respective task.

5-3
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A foreign system. This icon indicates a foreign system in
the SpycerNet. When selected, only this particular sys-
tem (i.e. its watched folders) will be visible and used for
the respective task.

Same as 'a foreign system’ but with an older Spycer ver-
sion running in the compatibility mode (see section “The
Group 'General’” on page 9-11). Some features that you
can perform on your system cannot be triggered on the
foreign system. See section “Notes about Networking
with Spycer” on page 2-7 for further information.

The home system. This icon stands for the host system.
When selected, all its local storages will be visible and
used for the respective task (for a search only the
watched folders).

When an icon is displayed together with a clock (), its Sys-
tem is busy (see section “The Status Bar” on page 5-9).

Furthermore, there are several drive and directory icons available:

H OHE

i @

A drive of an SNFS volume (SAN).
A normal system drive (e.g. an NTFS volume).

A directory/subdirectory of a drive that does not contain
data directly. However, it may contain subfolders that
carry data.

A directory/subdirectory of a drive containing data that
will be displayed in the contents area of the browsing
pane as soon as the folder is selected.

When right-clicking a file in the contents area and selecting the
menu option Open in new window, a further window wiill
open up showing the directory tree and the respective con-
tents area belonging to it (see section “The Context Menus” on
page 9-28).

Other drives, such as USB storages, external hard drives, net-
work drives, Avid drives as well as FTP folders will also be indi-
cated by different icons. On Windows operating systems they
will be shown in addition to the drive letters on these systems.

For further information about them see e.g. section “File In-
gest” on page 7-23 and section “The Group 'FTP Connectivi-

1

ty’" on page 9-9.
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The states of the drives and folders are shown in the folder structure of
the directory tree via colors:

Directory Color Explanation

light blue This drive/directory is locally available but neither
explicitly included nor excluded in the watch fold-
er settings. However, it may contain a subdirecto-
ry that is a watched folder. File-based processes in
these drives/directories are possible (e.g. copy,
move or delete procedures).

5 ) [hecontents of these locations are not in-
1 cluded in the database of Spycer and they
are read when accessed only. Thus it may
take some time to open them, especially
when they contain a lot of data.

With the menu option View on the con-
text menu of the directory tree, it is also
possible to hide these locations. Then
only the watched folders will be visible in
the directory tree (see section “The Con-
text Menus” on page 9-28).

dark blue This drive/directory is monitored by the back-
ground process, i.e. it is a watched folder.

dark grey This drive/directory cannot be accessed. Please
refer to your system administrator.

° For further information about watched folders see section
1 “Watch Folder Settings” on page 3-11.

As soon as a drive/directory that contains data is selected, its contents
will be displayed in the contents area of the browsing pane.

5.1.2 The Directory Controls

With the directory controls at the top of each browsing pane you can
control the directory tree. It offers the following possibilities:

Bl This button moves you one item up in the folder struc-
ture.

| This button adds a new subdirectory to the currently se-
lected drive/directory. It opens a dialog window where
you have to enter the name of the new directory. After
confirming the name with the button OK, the directory
will be created.

5-5
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The field Path details the path to the currently selected
directory: First the drive letter is given, followed by the
directory path.

5.1.3 The Contents Area

The contents area of a browsing pane shows you the contents of the
currently selected drive/directory in the directory tree. All files at the se-
lected storage location will be displayed, either in text information or
thumbnail view depending on the viewing settings for the respective
browsing pane (see section “The Status Bar” on page 5-9).

o A contents area providing the same features as explained here
1 as well as in section “The Status Bar” on page 5-9 and section
“The Context Menus” on page 9-28 is also available in the
search tool after performing a search (see section “The Results
Area” on page 5-13).

With the menu option View on the context menu of the con-
tents area, you can also display directories that are available at
the selected location (see section “The Context Menus” on
page 9-28).

In the text information view, you will receive a detailed list of the folder’s
content. In this view you can easily sort the files/clips in ascending or
descending order by clicking on the column heading that the data
should be sorted by.

File HMame File Path File Format| o
[HU ] ... TIFF
. RF&4

dirack_hdaster.

Figure 5-5: Contents area in text view

When in the thumbnail view, still images and video clips are shown in
the contents area of a browsing pane with a thumbnail preview. In this

5-6
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view you will get additional information about the displayed material via
text that appears to the right of the thumbnail.

i

The column headings of the contents area can be customized,
I.e. the names can be changed or columns can be added and
deleted. Please contact the DVS service department if you
want the contents area to be customized.

File Name

[=
000
16

Cruration

Figure 5-6: Contents area in thumbnail view

The following table shows the material and data types that can be
viewed in the contents area of a browsing area and explains the way
they are displayed:

video clips:

In the thumbnail view, video clips are
shown in the contents area of a brows-
ing pane with a thumbnail preview.
When a clip is selected, a scrub bar be-
low the thumbnail will be available that
can be used to preview the clip in still
images (see section “Previewing Data
via Thumbnails” on page 6-2).

In the text information view, video clips
are indicated by this icon. In case it is
visible in the thumbnail view, it indi-
cates either a video clip whose data is
currently not available or an invalid clip.
Then wait a few seconds and give
Spycer time to gather the data. If nec-
essary, refresh the view of the directo-
ry/contents area. If after that the icon is
still visible, see to it that the right video
material is provided on the respective
video storage.

5-7
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audio clips:

project files:

still images:

unknown:

directories/
drives/
systems:

Audio clips are shown with this icon in
ﬂl the browsing pane (in the text informa-

tion as well as thumbnail view). Audio
files that contain more than one mono
or stereo channel (multiple channels)
are also supported by Spycer.

Project files of a video system software
by DVS (e.g. the CLIPSTER software)
will be shown with this icon in the
browsing pane (text information as well
as thumbnail view).

Still images, i.e. single image files of a
file format that Spycer supports, are
also displayed in Spycer. In the thumb-
nail view, still images are shown with a
thumbnail preview. However, because
they are not video clips they do not pro-
vide a scrub bar when selected.

In the text information view, still images
are indicated by this icon. In case it is
visible in the thumbnail view, it indi-
cates either a still image whose data is
currently not available or an invalid im-
age. Then wait a few seconds and give
Spycer time to gather the data. If nec-
essary, refresh the view of the directo-
ry/contents area. If after that the icon is
still visible, see to it that the right data
is provided on the respective storage.

Spycer shows all files available on the
'). storage, even files of unknown formats.

Files that are not recognized by Spycer
are displayed with this icon (text infor-
mation as well as thumbnail view).
However, because each will be worth
one entry in the database of the
SpycerAgent, your storage should con-
tain as few of these files as possible.
Otherwise search procedures may get
lengthy due to unnecessary overhead.

Other items may be displayed in the contents area with
appropriate thumbnails/icons as well, such as directo-

ries (if enabled, see menu option View in section “The

Context Menus” on page 9-28), drives or systems. For
further information about them see section “The Direc-
tory Tree” on page 5-3.
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5.1.4 The Status Bar

The status bar at the bottom of a browsing pane offers you several con-
figuration settings for its contents area as well as a status indication of
the currently selected system. In detail it provides the following:

i @

Image

Further information about the text information and thumbnail
view can be found in section “The Contents Area” on page 5-6.

Use the button TEXT to view the files/clips in the con-
tents area with their text information only.

With the button IMAGE you can activate the view of the
thumbnails.

This drop-down list enables you to a selective viewing of
the material displayed in the contents area. Select from
it the type of data that should be visible in the contents
area only. You can choose between the options All Files,
All Supported Files, Project Files, Video Files, Audio
Files.

This field indicates the status of the system currently se-
lected in the directory tree (see section “The Directory
Tree” on page 5-3). When it shows Online, it is ready
for further processing tasks. When it shows Busy writ-
ten inred, the system is occupied by a task and will react
to your command as soon as it is ready again. The status
Busy may be displayed, for example, when the system
is performing a real-time operation or in case the data-
base of its Spycer application is updated. In the brows-
ing panes, the icons of systems that are busy will be
displayed together with a clock (see section “The Direc-
tory Tree” on page b-3).

5-9
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5.2 Searching for Data

With Spycer you can as easily search for data as you can browse for it.
You will be able to find any searched for material by combining various
search parameters, such as file names or metadata information.

With a click on the button SEARCH at the top left side
of the browse and search area you can activate the
search tool of Spycer if not already available in the user interface.

° Alternatively you can use the keyboard combination [Ctrl + F]
1 (Mac: [3 + F]) to switch to the search tool of Spycer.

search parameter area results area

Figure 5-7: The search tool

It provides the following areas:

search parameter In the search parameter area, you can deter-

area mine the location where the search should be
conducted as well as define the search parame-
ters. Here you can also save a search query to a
file (*. sq) as well as load previously saved
ones.

results area The results area of the search tool will display
the results once a search has been conducted.
[t offers almost the same features as the con-
tents area of a browsing pane.

This section explains the search tool of Spycer in detail. First the search
parameter area will be described, followed by a description of the re-
sults area. The section will be concluded with a step-by-step descrip-
tion how to use the search tool of Spycer.

5.2.1 The Search Parameter Area

In the search parameter area, you can determine the location where the
search should be conducted as well as define the search parameters.

5-10
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Here you can also save defined search parameters to a file as well as
load previously saved ones.

search location search parameters controls

M aeer

W Metwok

lawing metadata:

¥ | |File Hame

Find it!

Figure 5-8: The search parameter area

All items of the search parameter area will be explained in the follow-
ing:

Search Location

With the drop-down lists Content on and in you can determine the lo-
cation where the search should be conducted. Select from it whether
you want to search the contents of a particular system or the whole net-
work. It offers the same possibilities as the system/network drop-down
list in a browsing pane (see section “The Directory Tree” on page b-3
for more details).

o Only the database of the local storage and/or the databases of
1 the Spycer applications in the SpycerNet will be used for a
search. Drives and directories not indexed in the database(s),
i.e. not included in the watched folders settings, will be disre-
garded (see section “SpycerAgent” on page 2-5).

Search Parameters

Below the drop-down list for the search location the search parameters
have to be detailed. With the drop-down list to the left determine the
search criteria that should be used for the search. You can choose from
a variety of different criteria ranging from file name or extension over
video/audio properties to metadata information such as the production
date or company.

Depending on the selected criteria the number of the available fields for
a search parameter may vary. If three are available, use the one in the
middle to set an operator for the search (e.g. for a file name
contains ...,is ...,begins with ... andends with ...).
With the last field to the right you have to specify the criteria. It may pro-
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vide an entry field where you have to type in your search term or a drop-
down list providing you with a list to choose the search item from.

The button + (Ell) below the search parameters adds another search pa-
rameter that the search will also observe. With it an AND search is pro-
vided (e.g. when searching for a file name that begins with start AND
the file extension * .wav, you will receive all file names with the prefix
‘start’ and the Wave file extension such as start 01+02.wav). You

can add as many AND searches as you like and they can be deleted just
by clicking the - button () right in front of the additional parameter.

For names of video clips you have to observe the C notation

i usually with the syntax <string>%0Yd. <ext>:

<string> Preceding string of file name

% Marker that the following is a format string

0 If the output of the format string does not pro-
vide the stated length, fill it with zeros (0)

Y Number of digits, for example, 5

d Marker that the format string is a decimal num-
ber

<ext> File extension

With the search Hollywood%05d.dpx entered Spycer will
yield as a result the clip Hol1lywood in the DPX file format that
provides a five digit frame number.

Controls

With the controls at the bottom of the search parameter area you can,
for example, initiate a search, clear the already defined search parame-
ters or build up a library of often used search queries. In detail it pro-
vides the following items:

The button RESET clears the already defined search pa-
rameters and resets the search parameter area.

The LOAD button allows you to load previously saved
search parameters from a file. It opens a dialog window
where you have to select the respective file containing
the search query (*. sq). After its confirmation, the
saved search parameters will be loaded into the search
parameter area of Spycer.
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[Save | With the button SAVE you can save the currently set
search parameters to a file. Thus you can build up a li-
brary of search queries to use them in the future again.
A click on this button opens a dialog window where you
have to specify the storage path and file name of the
search query file to be saved. After the confirmation of
your settings, the file will be saved to the specified loca-
tion (*. sqg) (see section “Interesting Files and Folders”
on page A-14).

With the button FIND IT! you start a search. It will be per-
formed at the selected location and will yield the results
according to the set search parameters in the results
area to the right. As long as the search is processed, the
system(s) where the search is performed will be busy,
i.e. their icons will appear with a clock superimposed
(see section “The Directory Tree” on page 5-3).

s ) With the focus on the search parameter area a
1 search can also be initiated by pressing the [En-
ter] key.

5.2.2 The Results Area

The results area of the search tool displays the results soon after a
search was initiated.

File Name Cabrio_ %05 d. tif

Frame Rate
Cruratian
[refrag

¢ File Hame

Frame Fate
Cruratian
Cefrag

1

Text All Files

Figure 5-9: The results area

Once a search is finished, the number of hits will be displayed at the top
left of the results area. Right below it the found files can be seen.

Most of the results area resembles the contents area of a browsing
pane and provides its possibilities as well. For example, you can adjust
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the viewing with the controls at the bottom of the results area or you
can invoke the same context menu on the found files. Therefore, for
more information about this please refer to section “Browsing for Data”
on page b-2.

i

With the menu option Show in browser on the context menu
of a clip in the results area, you can immediately display the se-
lected file in a browsing pane of Spycer. This way you can de-
termine its location easily.

5.2.3 Using the Search Tool

The usage of the search tool of Spycer is quite straight forward. To start
a search and display its results, do as follows:

5-14

* Select from the drop-down list Content on the location where the
search should be made. Choose from it, for example, a particular
system in the network.

* Afterwards, select the search criteria that you want to search for
from the first drop-down list of the available search parameter. In
our example here, we will select the criteria File Format.

This will slightly change the appearance of the search parameter entry
fields and instead of three now only two fields are displayed.

* Select from the second drop-down list of the search parameter the
entry, for example, for the *. t1if file format.

i

You may use the + button below the specified search parame-
ter to add another parameter that the found *. tif files also
must provide to be displayed as a result (AND search).

With the criteria File Format you can only select formats
that are supported by Spycer directly (see section “Supported
File Formats” on page A-6). However, you can search for any
file format, even ones unknown to Spycer, by entering its ex-
tension in the criteria File Name (e.g. enter .txt).

¢ Next start the search with the button FIND IT!.

The search will be conducted at the specified location(s). As long as the
search is processed, the system(s) where the search is performed will
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be busy, i.e. their icons will be shown together with a clock. When fin-
ished, the result will be shown in the results area to the right.

i

To limit the displayed findings in the results area further, you
may also use the selective view drop-down list (see section
“The Status Bar” on page 5-9).

By selecting entries in the results area and using the menu op-
tion Save as TXT... on their context menu you can save the
search result to a text file, for example, for later evaluation.

With the menu option Show in browser on the context menu
of a clip in the results area, you can immediately display the se-
lected file in a browsing pane of Spycer. This way you can de-
termine its location easily.
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This chapter provides descriptions about how to preview data in the
software.

The preview area in Spycer is used to view or play the currently singled
out material (3D LUT and image files as well as audio (audio waves) and
video clips). By creating and using proxy clips, video material can also
be viewed in real time. The contents of the material then can be seen
in the video overlay. Below the video overlay a scrub bar of the materi-
al’'s timeline is available as well as the preview controls.

Additionally, you can preview image and video data via the thumbnails
provided in the contents areas when browsing or searching.
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6.1 Previewing Data via Thumbnails

When in the thumbnail view, video and image data can be seen with
thumbnails in the contents areas of the browse and search tools. Each
thumbnail is created on-the-fly and displayed as soon as a directory is
selected that holds video or image data.

Further details about the contents areas of the browse and
search tools not explained in the following can be found in sec-
tion “Browsing for Data” on page 5-2.

i @

Riesenrad_%054.tif

TIFF

Cruration
[refrag
1]

Figure 6-1: A contents area

Still images (i.e. single image files) in the browse and search area just
provide their thumbnails. For video clips, however, the complete time-
line can be previewed via the little scrub bar below its thumbnail. To do
this, perform the following:

* |f not already selected, select the clip that you want to preview with
a click of the mouse.

This will make the scrub bar of the thumbnail available.

* Move the cursor of the scrub bar to the left or right to view the con-
tents of the clip:

o For this you may also use the keys [Left Arrow]/[Right Ar-
1 row] when the scrub bar has the focus (e.g. after selecting
it with the mouse).

thumbnail

scrub bar

with cursor ———
4+—>

Figure 6-2: Preview of a clip in a contents area
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The thumbnail above the scrub bar will show you the contents of the

clip in still images. This can also be used to select a preliminary position
for the metadata and preview area: When singling out the clip (see e.g.
section “Previewing Data with the Preview Area” on page 6-3), the po-
sition of the scrub bar cursor will be retained and available there as well.

6.2 Previewing Data with the Preview Area

At the right-hand side of the user interface you find the preview area.
In Spycer this area is used to preview the currently singled out material.

s ) [ncase the preview area is not visible, it is either hidden (see
] | section “Exiting the Software” on page 3-14) or the view is
switched from the metadata and preview area to the view of
the job list or the task scheduler. To switch back to the meta-
data and preview areas, use the button METADATA at the top
left side of the user interface (see also chapter “Previewing Da-
ta” on page 6-1).

e —— video overlay

WRE:EREl ——— status bar
Figure 6-3: The preview area

With the preview area you can view the color dispersion of 3D LUT files
in a color cube or the image data of still images and video clips. By cre-
ating and using proxy clips video material can also be played. Further-
more, audio clips can be played in the preview area as well.

. For a preview of audio and 3D LUT files you can use locally
1 stored data only. A direct preview of this material from other
systems in the SpycerNet is not possible.
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At the top of the preview area you find a video overlay showing you the
contents of the singled out material. Additionally, for video and audio
clips a scrub bar is provided below the video overlay as well as the pre-
view controls, both allowing you to move within the clip’s content. At
the very bottom a status bar is available that details further information
about video and their proxy clips.

6.2.1 The Video Overlay

The video overlay at the top of the preview area allows you to preview
data. Once a still image, 3D LUT or video clip is singled out in the
browse and search area (e.g. with a double-click of the mouse), its con-
tents is displayed there.

With the context menu of the video overlay you can, for example, con-
figure the appearance of the video overlay or the behavior of plays fur-
ther. It provides the following menu options:

View Displays timecode, keycode and frames informa-
tion superimposed on the video overlay. Select
from the opening submenu the respective informa-
tion that should be displayed in the overlay. The en-
abled view shows a cross in front. While the
frames information simply shows the current posi-
tion of the scrub bar cursor, the timecode and key-
code information are taken from the headers of the
files. This means that, if a file without timecode
and/or keycode information in its file header is dis-
played, no timecode/keycode will be displayed in
the overlay.

Fit to screen Scales the video overlay to the maximum available
width or height of the preview area. If enabled, it
shows a cross in front.

Maximize / Either maximizes the preview area, i.e. hides all

Minimize other areas of the Spycer user interface (see sec-
tion “Exiting the Software” on page 3-14), or re-
stores the previous layout of the user interface.

s ) [hiscan also be performed with a double-
l click of the mouse somewhere in the pre-
view area or the menu option Maximize
Preview Area on the View menu (see
section “The 'View' Menu” on page 4-15).

When the video overlay is maximized, the
clip'sinformation are displayed in a tooltip
when leaving the mouse cursor on it.

Play original With a proxy available this menu option forces the
play of the original video material instead. If en-
abled, it shows a cross in front.
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Reload proxy Reloads the proxy of the clip displayed in the pre-
view area.

Force realtime  This option holds the frame rate of the video clip to
be played out, meaning the clip will be played in
real time but, for example, when no proxy is avail-
able, frames in between may be dropped to
achieve this. If enabled, it shows a cross in front.
When disabled, the clip will be played out frame by
frame as fast as possible. With a container format
such as *.mov or *.mpeg selected for a viewing
that contains audio as well, you will hear the audio
stream when the Force realtime option is enabled.

When previewing data with set markers (see section “Marker
Mode"” on page 4-9) further menu options of the context menu
will be enabled. Then you can select the options Add marker,
Delete marker and Delete all markers as well.

i @

6.2.2 The Scrub Bar

If the singled-out file is a video or audio clip, you find a scrub bar be-
neath the video overlay, representing a timeline of the clip’s contents.
With its cursor you can move within and view the content of the clip.
Simply select the cursor with the mouse and move it along the scrub
bar to the wanted position, or click somewhere on the scrub bar to
move the scrub bar cursor there instantly. \While working with video
clips and the scrub bar or the preview controls below, the video overlay
always adjusts to your moves and displays the image of the selected
position.

6.2.3 The Preview Controls

In addition to moving the scrub bar cursor manually, you can control it
via the preview controls below the scrub bar, e.g. the play button. In de-
tail the controls beneath the scrub bar perform the following functions:

o A preview can also be controlled with various keyboard short-
1 cuts. Further information about the available shortcuts can be
found in section “Keyboard Shortcuts” on page A-12.

BN S With these buttons you can step one frame for-
or backward in the contents of the clip. The
scrub bar cursor will move accordingly.

6-5




Spycer User Guide
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With this button you can play the clip that is cur-
rently singled out (audio or video). The real-time
play of a video clip and/or the playing of a clip in
the SpycerNet requires a proxy. After activation,
the button changes its appearance to its active

state (NG ) and you have to press it

again to stop the play.

s ) [his button will not be available when a
1 playing cannot be performed (e.g. with
audio material stored on a foreign sys-
tem).

Locally stored video clips can be
played even without proxies available.
They will be played according to the
settings of the overlay (menu option
Force realtime, see section “The Video
Overlay” on page 6-4).

With this button activated a play of the clip’s
timeline will be performed endlessly in a loop:
Once the scrub bar cursor reaches the end of
the clip, the play will start from the beginning
again. To switch off the loop mode, simply click
this button again.

These buttons jump to the beginning or end of
the clip displayed in the preview area. The first
button jumps to the beginning of the scrub bar
while the second button jumps to its end.

This button sets a marker at the position of the
cursor on the scrub bar. Alternatively you can
set a fixed value in the position entry field to the
right of the video overlay.

s ) Furtherinformation about markers and
l their usage can be found in the supple-
ment user guides of the respective
DVS devices.

This button deletes the marker when the cursor
is set at its position in the dailies workflow.
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These controls are items providing functions for
the dailies workflow in e.g. CLIPSTER (see the

supplement user guides of the respective DVS

devices).

The entry field allows you to enter a frame-accu-
rate value the cursor will jump to on the scrub
bar when pressing [Enter]. From the drop-down
list you can select the frames to be recalculated
when e.g. audio and video material have differ-
ent frame counts. When pressing the button
LocK FR, you can lock the drop-down list at its
set frame number.

6.2.4 The Status Bar

At the bottom of the preview area a status bar can be found showing
you information about the clip and its proxy. It details, for example,

whether a proxy clip is available for a preview, the current position of
the scrub bar cursor in frames, and the clip’s total amount of frames.

Furthermore, when viewing clips over the SpycerNet, the status bar
also indicates the download progress of the proxy from the foreign sys-
tem as well as the data rate of the download:

59,5 MBits

Figure 6-4: Progress bar of a proxy download via the SpycerNet

6.2.5 How to Single out Data

To single out data and view its content in the preview area, you have to
do the following:

* |n the browse and search area (see chapter “Software Reference”
on page 4-1), make the wanted material available in a contents area
by browsing or searching for it.

* |n case a specific image of a video clip should be displayed in the
preview area, select it with the help of the thumbnail’s scrub bar
(see section “Previewing Data via Thumbnails” on page 6-2).

* Next you have several possibilities at hand. Use either one of the
following:

— Select the respective file with the mouse and drag 'n’ drop it
somewhere in the metadata or preview area.
— Double-click the respective file with the mouse.
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— Use the menu option Show all metadata on its context menu
(see section “The Context Menus” on page 9-28).

This will single out the selected data and further information about it
will be displayed in the metadata area (see chapter “Previewing Data”
on page 6-1). If the singled out data is either a 3D LUT, video clip or a

still image, its content will be displayed in the video overlay of the pre-
view area.

6.2.6 Previewing Video Clips

As soon as video data is displayed in the preview area (see section

“How to Single out Data” on page 6-7) you can preview it. For this you
may use the scrub bar or the preview controls:

* Move the cursor of the scrub bar to the left or right to move to a
certain position within the clip.

o Alternatively you can use the keys [Left Arrow]/[Right Ar-
1 row] when the preview area has the focus (e.g. after select-
ing it with the mouse).

gcrub bar =
with cursor —

+—>

Figure 6-5: Preview of a clip in the preview area

e Additionally you can use the preview controls (e.q. NN BEN)

to view the contents of the clip (see section “The Preview Controls”
on page 6-5).

The video overlay will adjust to your moves accordingly and display the
contents of the clip.

s ) he position of the scrub bar cursor also determines the file
1 specific metadata that will be displayed in the header data view
(see section “Header Data” on page 8-6).
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If a proxy clip is already available for the singled out video clip (detailed
in the status bar of the preview area), you can also preview the video
clip in real time:

o A proxy clip can be created with the menu option Create

1 | proxy of the context menu of the clip in the contents area of
the browse and search tools (see section “The Context Menus”
on page 9-28). Further information about proxy clips can be
found in section “General Information about Proxies” on
page 6-11.

e Press the play button () of the preview controls.

Then the contents of the clip is shown in real time in the video overlay
of the preview area.

o Locally stored video clips can be played in non-real time even
1 without proxies available. They will be played according to the
settings of the overlay (menu option Force realtime, see sec-
tion “The Video Overlay” on page 6-4).

With a container format such as *.mov or * . mpeg selected for
a viewing that contains audio as well, you can also listen to its
audio. For this the option Force realtime has to be enabled
(see section “The Video Overlay” on page 6-4).

Spycer is able to read several MXF formats while they are still
being recorded. The “read while write”-feature allows brows-
ing and previewing while writing the file is still in process (if the
codec is “read-while-write”-capable).

6.2.7 Previewing Audio

Audio clips can be as easily previewed as video clips: As soon as an au-
dio file is singled out (see section “How to Single out Data” on

page 6-7) you can listen to it and see its audio waves in the audio wave-
form monitor.

o For a preview of audio you can use locally stored data or data
l that is stored on a SAN only. A direct preview of this material
from another system in the SpycerNet is not possible.

 Press the play button (| CE) of the preview controls to
play the audio file.

This will play the contents of the audio file and the audio waves will be
visualized in the preview area. If your computer system is equipped
with a sound device and speakers, you will now hear the audio data.
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Figure 6-6: Audio wave visualization

When double-clicking the video overlay, you can enlarge it. By using
the scroll wheel on your mouse you can zoom in and out.

. Audio from container file formats such as *.mov or *. mpeg
l can be played as well. For this the option Force realtime has
to be enabled (see section “The Video Overlay” on page 6-4).

6.2.8 Previewing 3D LUTs

When a three dimensional look-up table (3D LUT, formats*. 3d1,
* . e3dand *. 1ut)is singled out (see section “How to Single out Data”
on page 6-7), it will be displayed in the preview area with its color cube.

o For a preview of 3D LUTs you can use locally stored data only.
l A direct preview of this material from another system in the
SpycerNet is not possible.
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Figure 6-7: The color cube of a 3D LUT in the preview area

To view it and its color conversion results in more detail, Spycer offers
you several possibilities:

» Perform one of the following in the video overlay:

— By pressing the left mouse button and moving the mouse you
can rotate the color cube freely.

— By clicking with the scroll wheel or the right mouse button you
can switch the output colors to the input colors and vice versa.
The colors that are currently displayed is indicated at the top of
the video overlay.

— By turning the scroll wheel of the mouse you can morph the
colors in the cube from output to input and vice versa. The
degree of the morphing is indicated at the top of the video
overlay.

With this you can evaluate a 3D LUT easily in Spycer and see the results
of a color conversion.

6.2.9 General Information about Proxies

Proxy clips are downscaled versions of high-resolution video material,
especially created by Spycer to enable previews of video clips in real
time on systems, even when they are not equipped with real-time hard-
ware. Usually they are generated in a container file format that allows
for a compression of images as well as an embedding of audio data (if
available).

The proxy generation, such as its storage location, file format or reso-
lution, can be configured freely with the general configuration settings
of Spycer (see section “The Group 'Jobs’” on page 9-16). There you can
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also determine that they should be created automatically as soon as
clips are added to the storage. In case the automatic generation is de-
activated, proxies can be easily created via the context menu of clips in
the contents areas of the browse and search tools (menu option Create
proxy, see section “The Context Menus” on page 9-28).

o To create proxies on your system, the proxy generation has to
1 be enabled and configured first (see section “The Group
'Jobs’” on page 9-16).

Just as with the database of the local storage, each Spycer application

cares for and administers the proxies of the video material that is locally
available only. During the creation of a proxy an entry with a progress

bar will appear in the job list (see section “The Job List” on page 7-15)
and the proxy clip is saved at the configured location. There, the direc-
tory structure of the watch folder where the clip is stored is reproduced
to provide for an easy identification of the proxy clips.

For a real-time preview of clips locally stored, the proxies will be avail-
able immediately. The proxy's status is detailed in the status bar of the
preview area (see section “The Status Bar” on page 6-7) when a clip is
singled out.

o Locally stored video clips can be played in non-real time even
1 without proxies available. They will be played according to the
settings of the overlay (see section “The Video Overlay” on
page 6-4).

In the SpycerNet proxies are shared among the Spycer applications.
When a proxy clip is available on a foreign system and the clip is singled
out for a preview, its proxy will be downloaded from the other system
and temporarily stored on your system. It will be removed from your
system again as soon as another file is singled out or the Spycer user
interface is closed.

o To create proxies on another system in the SpycerNet, you

1 must have read and write permissions on this system and the
native Spycer application must be properly configured for the
creation of proxies.

To preview an already available proxy in the SpycerNet, only
the browse and search permission are required.
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This chapter describes tools and instruments available in Spycer that
will help you to manage vast amounts of data. First several smaller
management tools are described, such as the renaming of image se-
quences, the built-in defragmenter or the storage space calculator.
Then follow descriptions of the job list and the task scheduler. After
that, you will find information about the latest management features in
Spycer such as the P2 and XDCAM ingest as well as creating metaclips.
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7.1 The Management Tools

Several management tools supplement the usage of Spycer compris-
ing, for example, a renaming function for image sequences, an inte-
grated high-speed copying process and a sophisticated
defragmentation of image sequences. They will be described in this
section.

7.1.1 Renaming

Spycer provides a renaming tool for image sequences where you can
easily change, for instance, the name prefixes, frame numbers or file
extensions. When viewing the file related metadata of the currently sin-
gled out file, you find the button RENAME (see chapter “Managing Da-
ta” on page 7-1) right beside the Filename(s) entry. With it you can
rename the currently singled out material.

In case the singled out material is available as a single file on the stor-
age (e.g. an audio file), the button RENAME opens a dialog window
where you simply have to enter the new name. Once the file name
changes are confirmed with the button OK, the file will be named ac-
cordingly. You can invoke this option when pressing [F2] on your key-
board as well.

However, when the button RENAME is called for an image sequence
consisting of still images, it opens the renaming tool of Spycer:

o A renaming either for a single file or a file sequence (multi-se-
1 lecting the clips by clicking the files and simultaneously press-
ing [Ctrl]) can also be called with the menu option Rename...
on the context menu of a directory/file in the browse and
search area (see section “User Interface in the Metadata
Mode"” on page 4-3). A renaming of single folders or multiple
folders can be performed as well.
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» Rename

x| Mame Pattern

_ganan

Start Humber

| Extenzion | dpx

| case Mame & Ext : Lowercase

Figure 7-1: The renaming tool

The renaming tool of Spycer provides the following items:

Name Pattern
Start Number

Extension

Case

With the check box Name Pattern you enable a
change of the pattern of the files. Usually, this is
used to alter the frame numbering.

Change the name pattern in the entry field below
the check box. The hash symbols (#) indicate the
pattern of the frame numbering. If the number of
hash symbols exceed the number of digits of the
frame numbering, they will be filled with zeros.
This entry field can also be used to change the file
names’ prefixes (same effect as 'Replace/With').

The Start Number entry field changes the frame
number of the first frame file (start frame). All other
files will be numbered in ascending order.

If activated, it will change the file extension of the
image sequence with the term entered in the entry
field to the right.

When enabled, it will change the upper and/or low-
er cases of the file names’ letters. Select the appli-
cable alteration from the drop-down list to the
right.
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Replace An enabled check box of these items allows you to
With replace any string in your file names with the spec-
. ified one. It works also over several occurrences. In

Case Sensitive ¢ Replace field, type in the string that should be
replaced. In case the string to be replaced occurs
several times, i.e. it is available more than once,
you can enter it case sensitive. Then by activating
the Case Sensitive check box you may rule out
any other lower or upper case occurrence. In the
field With, you have to type in the replacement
string to be inserted in the file names.

table With the table at the bottom of the renaming tool
you can verify the result of the renaming by com-
paring the old file names with the new ones.

OK The OK button closes the renaming tool and ap-
plies the specified changes to the whole sequence
of the video clip: All file names will be changed.

CANCEL Cancels the renaming and closes the tool without
changing the file names.

7.1.2 Defragmenter

7-4

Spycer provides a built-in defragmenter especially designed to optimize
the physical alignment of image sequences (video clips) on storages so
that they are more suited for real-time operations.

The alignment of clips on a storage is of special importance when per-
forming real-time operations with clips in HD or larger: The perfor-
mance of the hard disk(s) is limited and may soon be reached,
especially when the storage contains large amounts of data. Then, a
real-time operation (playout or record) may get interrupted due to the
facts that files are stored in segments or even fragments on the hard
disks and disk drives tend to get slower the fuller they are. With the
built-in defragmenter you can defragment any file that is fragmented
and, furthermore, align image files of video clips contiguously in larger
blocks on the storage which will minimize access times during read
procedures.

The built-in defragmenter uses proprietary routines to defrag-
ment the data on the storage. The results will not be the same
when using a third-party defragmentation tool, because it will

not heed image file sequences. Therefore, do not use any oth-
er defragmentation tool than the ones from DVS for a defrag-
mentation of a video storage.
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Itis recommended to defragment storages at regular intervals,
even with lesser amounts of data stored on them. Then, newly
copied or captured material can be better positioned on the

storage and later defragmentation runs have less to deal with.

i @

To run the defragmenter on an SNFS storage, you must log on
to the computer system with administrative rights for the stor-
age.

With Spycer you can defragment either single files/clips or several ones
in one step. To defragment more than one file/clip, you can either select
several ones in a contents area of the browse and search tools or de-
fragment the directory or drive that contains them.

o With a Spycer that supports SNFS (see section “Program Vari-
] | ants of Spycer” on page 1-6) you can also optimize the free
space of a storage. For this initiate a defragmentation of the
complete drive/volume. Works only on SNFS storages.

The following details how to assess the defragmentation degree and
how to initiate a defragmentation.

Assessing the Defragmentation Status

The defragmentation status of a file/clip can be seen in the browse and
search area as well as in the file metadata view of the metadata area.

In the browse and search area, you find this information in a contents
area once a file is displayed (see section “The Contents Area” on

page 5-6). The text information provided by the file will detail this infor-
mation (either to the right of a thumbnail or when in its text information
view) under the entry 'Defrag’:
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Figure 7-2: Contents area showing the defragmentation status
Additionally, it can be seen in the metadata area (see chapter “Manag-
ing Data” on page 7-1) when an entry in Spycer is singled out and the

file metadata is visible. You find the defragmentation degree under the
entry ‘Defragmented’ among the general file data.
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Figure 7-3: File metadata showing the defragmentation status

In Spycer the defragmentation status of a file or clip is indicated with
the help of colors and percentage values:

file sizes.

Color | Percent Explanation

blue 100% | The file/clip is optimally aligned on the storage
and none of its data is fragmented.

- 1% - 99% | The clip exists in segments but none of its files
are fragmented.

red 0% The file or at least one image of a clip is stored in

fragments on the storage. If this is the case with
a video clip, it may cause problems during play-
out operations, depending on its resolution and

i @

Segmentation: A clip is segmented when its image files are not
aligned contiguously in larger blocks on the hard disk array but
scattered over the storage.

Fragmentation: Either a file is fragmented or a video clip con-
tains fragmented files. In contrast to segmentation here, it is
the data of a single file that is scattered over the storage.

Initiating a Defragmentation

A defragmentation can be started in the metadata area with the file me-
tadata view selected or via the browse and search area. Even files of un-
known formats are defragmented by the defragmenter of Spycer. To
initiate a defragmentation, perform either one of the following:

/-6
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— To initiate a defragmentation from the metadata area:
With the metadata of the file or clip displayed in the file metadata
view of the metadata area select the button DEFRAG.

— To initiate a defragmentation from the browse and search area:
Browse or search for the respective file/clip. When it is displayed in
a contents area, select from its context menu the menu option
Defragment (see section “The Context Menus” on page 9-28).

This will start a defragmentation of the selected data and an entry in the
job list is created (see section “The Job List” on page 7-15b). The job en-
try also shows a progress bar for the defragmentation process. As long
as the defragmentation is under way the system will have the status
'‘busy’ (see section “The Status Bar” on page 5-9).

Furthermore when in the browse and search area, you can defragment
more than one file/clip with a single step:

— You can select several individual ones when displayed in a contents

area, for example, by holding down the [Ctrl] key (Mac: [#8]) while
selecting them with the mouse.

o With the search tool you can search for a defragmentation
l degree. Once displayed in the contents area of the search
results, the entries can be selected and then defragmented.

— You can select a directory or volume that contains these clips in the
directory tree of the browse area, which will defragment all files
stored at this location (files in subdirectories as well).

Then initiate the defragmentation with the menu option Defragment
from the context menu (see section “The Context Menus” on
page 9-28).

o With a Spycer that supports SNFS (see section “Program Vari-
1 ants of Spycer” on page 1-6) you can also optimize the free
space of a storage. For this initiate a defragmentation of the
complete drive/volume. Works only on an SNFS storage.

As long as the defragmentation is in progress, the system will have the
status 'busy’. Depending on the amount of data to be defragmented
this process may take a while. The defragmentation operation ends au-
tomatically as soon as all selected data is processed. Then the files/clips
will be perfectly aligned on the storage and show a defragmentation
status of 100% (blue).

7.1.3 High-Speed Copying

To copy vast amounts of video material from one storage location to an-
other, is often a time consuming procedure when performed with the
standard tools of an operating system, such as a file manager. To do
this faster, DVS integrated in Spycer a high-speed copying routine

7-7



Spycer User Guide w

which deals with such tasks in about four times the speed of a standard
operating system copy.

The high-speed copying tool is truly integrated in Spycer: It will be start-
ed and used as soon as a copying or moving is performed.

o The copying/moving can also be combined with an automatic
1 defragmentation of the copied or moved material. For further
information about how to set this please refer to section “The
Group 'Jobs’” on page 9-16.

Copying (Moving) Directories/Files

Copying directories/files with the browse tool (see section “Browsing
for Data” on page 5-2) of Spycer can be performed without effort. It of-
fers two browsing panes where you can do this easily via drag-and-
drop. When operating between storage locations at your home system,
directories and files can also be moved:

* If not already visible in the user interface, activate |FIEEEN
the browse tool with the button FILE SYSTEM at the
top left side of the browse and search area.

The user interface then displays the two browsing panes of Spycer as
indicated in figure b-1 on page b-2 in the section “Browsing for Data”.

* Inthe directory tree of the left pane, browse to your target directory,
i.e. the directory where the data should be copied to.

* |n the right browsing pane, browse to the directory containing the
material that should be copied, i.e. the source directory.

* After that select in the right browsing pane the material (either a
drive/directory from the directory tree or files from the contents
area) that should be copied or moved.

5 ) Filesinthe contents area can be selected as easily as in a file
1 manager. For example, you can select a range of adjoining
files with the mouse when the [Shift] key is pressed, while
disjointedly you can select them when the [Ctrl] key

(Mac: [38]) is pressed. Further information about this can be
found in section “Keyboard Shortcuts” on page A-12.

You can also select whole volumes for the copy process and
copy them in a single step.

* Now drag 'n’ drop the selected material to the left browsing pane
by using the left mouse button. It can be dropped either in its con-
tents area as shown in the following figure or on the target directory
in the directory tree.
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Figure 7-4: The browse tool

This will copy the material to the target location.

Between different systems in the network, data can be copied
only to prevent an unintentional removing of material from the
native system.

i @

Within the home system the material can also be moved. To
change from a copying to a moving, press the [Alt] key during
the drag-and-drop procedure.

If the drag-and-drop procedure is performed with the right
mouse button instead of the left one, you will receive a context
menu at the target location allowing you to select whether the
data should be copied or moved.

A copying or moving can also be performed via the menu op-
tions available on the context menu of files and directories
(Copy, Paste or Move to folder..., see section “The Context
Menus” on page 9-28) or when using the shortcuts [Ctrl + C]
and [Ctrl + V].

A copy process does not stop on read errors. If errors occur on
single files, the copy process will proceed with the following
files. Content that could not be copied will be listed in a copy
report (see section “The Job List” on page 7-15, context menu
Show Report).

The system will ask you if you are sure you want to copy the
selected content to prevent unintentional movements of con-
tent. You can deactivate this option in the group Jobs in sec-
tion “The Group ‘Jobs’” on page 9-16.

Deleting Files/Directories

Files or directories can be deleted just as easily as they can be copied:
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* Select a file or directory in one of the browsing panes.
» After this press the key [Del] on your keyboard.

A warning message will appear where you have to confirm that you re-
ally want to delete the file/directory.

The file/directory will be directly deleted from the storage.
There is no undo functionality or recycle bin available to re-
store the data.

* |n the warning message, press the button YES to confirm the dele-
tion.

This will delete the selected file or directory. If a directory is deleted, the
subdirectories and all material sorted under this directory will be delet-
ed as well.

o To delete files or directories, you may also use the menu option
1 Delete on the context menu of the respective item (see section
“The Context Menus” on page 9-28).

7.1.4 File Format Converter

7-10

Spycer provides an integrated file format converter able to convert still
images as well as complete video clips to another file format. Whether
you want to convert, for example, a video clip in a container format to
an image file sequence or vice versa, this tool deals with such tasks ef-
fortlessly. It can be accessed from the context menu of image or video
data displayed in the browse or search area:

* |n the browse and search area (see section “Browsing for Data” on
page b-2), browse or search for the still image or video clip that
should be converted.

* Then select from its context menu the menu option Convert... (see
section “The Context Menus” on page 9-28).

This will open the window of the file format converter of Spycer:
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Figure 7-5: The file format converter of Spycer

The source settings, i.e. details about the material that should be con-
verted, are displayed in the upper part of the window. The lower part
determines its destination, i.e. such things as name, file format or res-
olution. You can use the arrow buttons on the lists or click into them to
enter your setting. The following items are provided:

Source

Inpoint

Duration

Destination Path

Destination Name

Indicates the directory and path to the source
material. It is already set to the video/image data
where the file format converter was called.

Allows you to select a different inpoint for the
conversion. The conversion will start with the im-
age of this frame number.

Determines the length of the converted clip, i.e.
how many frames to convert from the inpoint on-
wards. Its maximum value can be:

<last frame no.>-<inpoint>+1.

The path to the directory where the converted
file(s) will be stored. To set a path, you may either
type in a path in the entry field or use the button
to the right () to select one via the opening di-
alog window.

The name of the converted file(s). To create file
names with frame numbers, you have to observe
the C notation, usually with the syntax
<string>%0Yd.<ext> (see section “The
Search Parameter Area” on page b-10).
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Start Index

File Format

Codec

Resolution

Width

Height

Pixel Ratio

Aspect

Frame Rate

Scaling Quality

OK

CANCEL

Available for clip formats that consist of still imag-
es: Allows you to select the start index of the clip,
i.e. determines the frame number in the file name
of the first converted frame.

Determines the file format of the final material.
The respective extension will also be indicated in
the field Destination Name.

If the selected file format requires a codec, it can
be selected with this drop-down list. Whether this
setting will be available depends on the selected
file format.

With this field you can determine the video for-
mat of the material to be created. Either select
from its drop-down list one of the predefined vid-
eo formats or set it to custom to define the reso-
lution yourself.

Details the width of the material to be created in
pixels. If Resolution is set to custom, it can be
adjusted freely.

Details the height of the material to be created in
pixels. If Resolution is set to custom, it can be
adjusted freely.

Determines the pixel aspect ratio that should be
applied during the conversion. Whether this set-
ting will be available depends on the selected file
format.

Available for informatory reasons. It details the
aspect ratio of the set video format, i.e. the ratio
of Width to Height.

Sets the frame rate of the converted material.
Whether this setting will be available depends on
the selected file format.

For the conversion you can select between three
scaling qualities. It also effects the speed of the
conversion. For example, the setting high will
yield the best quality but will also take longest to
process.

The OK button closes the file format converter
and converts the material according to the set-
tings.

Cancels the conversion and closes the file format
converter without having saved any settings.

After having configured the file conversion, you can start it by pressing
the button OK. This will write the converted material to the destination
directory and an entry in the job list is created (see section “The Job
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List” on page 7-1b). The entry in the job list also shows a progress bar
of the conversion process. As long as it is under way the system will
have the status ‘busy’ (see section “The Status Bar” on page 5-9). If the
original video/image format of the material differs from the destination
format, the image(s) will be skewed accordingly so that they fit optimal-
ly in the new format. After the conversion, the source file(s) are not de-
leted but remain at their location for further use.

7.1.5 Calculator

With the calculator of Spycer you can calculate from a set video format
its maximum recording time (by a given amount of storage capacity) or
the required storage (by a given duration of video data). It can be ac-
cessed from the menu bar of Spycer:

* From the menu bar of Spycer (see section “The Integrated Spycer”
on page 3-1b) select Tools » Calculator... or press [F11].

This will open the calculator of Spycer:

¢ Calculator >4

Quantization |10 bit

Frame Rate |20

Size o000 | (mie F =]

Cruration 000000 g

Figure 7-6: The calculator of Spycer

With the upper settings you determine the video format. Once the vid-
eo format is set, the calculation will be straight forward:

* Select the video format from the settings items by choosing the
appropriate values.

* Next you have two possibilities at hand:

— To determine the maximum length of the video data by a given
storage capacity, enter in the field Size the storage space, or

— enter in the field Duration the duration of the video data if you
want to know the required storage space. It has to be entered
in timecode format without frames (hh: mm: ss)

The calculation will be made as soon as an entry is changed: The re-
maining value will adjust itself automatically. Once you are finished
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with the calculation(s), the window of the calculator can be closed with
the button CLOSE.

o With the radio buttons to the right of the fields Size and Dura-
l tion you can also determine the way a calculation is per-
formed: To calculate from a given storage to a duration, the
Duration radio button has to be selected, and vice versa.

A similar calculation regarding disk spaces of a selected stor-
age can be done in the properties window of a drive or direc-
tory (see section “The Properties Window"” on page 9-34).
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7.2 The Job List

The job list of Spycer provides information about jobs
that are performed on your system or that you have

initiated on other systems in the SpycerNet. Additionally, these jobs can
be controlled from here, for example, by canceling them. You can

switch to the job list of Spycer with the button JoB LIST directly below
the menu bar.

o When the job list is not activated and visible, arriving jobs are
1 indicated by a (three times) flashing JoB LIST button.

When a new job is initiated, the user interface is switched to
the job list mode automatically.

& Spycer for DVS-SAN

Refresh list

) v

| Text | Fimage™ (Al Files ¥ Online
Figure 7-7: The job list of Spycer

The job list shows tasks that are concerned with your system: either
they were triggered from or are carried out on your system. Additional-
ly, it details only those tasks that may render a system 'busy’ (see sec-
tion “The Status Bar” on page 5-9). Whenever such a task is triggered,
an entry can be found here. For example, if you start a defragmentation
on another system in the SpycerNet (see section “Defragmenter” on
page 7-4) or re-scan your watched folders (see section “The Context
Menus” on page 9-28), or someone else in the SpycerNet starts a task
on your system, it will be noted here. Furthermore, as long as the task
is not finished, each entry informs you about its progress in the last col-
umn of the list, for example, with the help of a progress bar. Then, it
may detail the time remaining, its progress in percent and the data rate:
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Figure 7-8: Job in progress

In detail the table of the job list provides the following information:

Column Explanation
Created by Details the system that triggered the task.
Job Type The type of job that has been triggered is stated in

this column, e.g. copy, dvscopy, move, delete,
scan, etc. If the job type appears with auto

in front, it was initiated by the task scheduler of
Spycer (see section “The Task Scheduler” on
page 7-18).

Src. Peer The source peer. Details the source of the data in
the SpycerNet, i.e. the name of the system where
the source data is stored.

Source States the location of the source files on the
source peer.

Dest. Peer The destination peer. Details the destination of the
data in the SpycerNet, i.e. the name of the system
where the data is to be transferred to.

Destination Details the target directory on the destination
peer.
Status Indicates the state of the respective job, such as

paused, running, canceled, finished, failed, etc.

Progress Informs you about the progress of the job. Pro-
cesses that take longer are displayed with the help
of a progress bar (see above).

Time Displays the point of time when the job was car-
ried out.

The jobs in the job list are listed in the order they were initiated from top
to bottom, i.e. the latest jobs are listed at the bottom of the job list.
When several jobs are started on a system, they will be processed one
at a time in the sequence stated in the job list. Jobs that wait for a task
to finish have the state ‘pending’. The software offers several possibili-
ties to filter jobs in the job list. Above the job list, right below the menu
bar you can switch the view to the whole network or to a specific peer,
and to controllable jobs only. To the top right in the area History: you
can select the number of listed jobs in the job list when clicking the
drop-down list.
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With the buttons below the job list you can control the list as well as
running and pending jobs. To select a job, simply click on its entry in
the job list (see also section “Keyboard Shortcuts” on page A-12):

PAUSE SELECTED Pauses the selected job(s).

RESUME SELECTED Either continues a paused job or starts a pend-
ing one.

CANCEL SELECTED Cancels and aborts the selected job(s).

REFRESH LIST Clears the table, running and pending jobs will

be detailed again.

Furthermore, the job list offers a context menu when right-clicking an
item in the list. You can choose between the following options:

Cancel
Fauze

Resume

Showe Errar Meszage

Show Re po t

Figure 7-9: Context menu in job list

Cancel This option cancels a job that has been queued in
or that is already running.

Pause This option pauses a job that has been queued in or
that is already running.

Resume Either continues a paused job or starts a pending
one.

Show Error This option allows you to display an error descrip-

Message tion in a further window if a job fails. Simply right-

click the respective failed job and select this option.

Show Report | \\When selecting this option, a log file in *. txt for-
mat opens up showing the report to this specific
job. This file contains information about the time
and date, path, protocol, datarate, etc. These files
are stored in the folder 1og (section “Interesting
Files and Folders” on page A-14) when navigating
to C: \ProgrambData\DVS\Spycer.

Cancelling, resuming or pausing a job, can only be performed
from the source, destination or local peer.

i @
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7.3 The Task Scheduler

The task scheduler enables you to initiate tasks at cer-  [EFEEE NN,
tain times or intervals automatically, for example, for

management and maintenance operations in your SpycerNet. You can
switch to the task scheduler of Spycer with the button TASK SCHEDULER
directly below the menu bar.

& Spycer for DVS-54N
Options

Metadata

Figure 7-10: The task scheduler of Spycer

The task scheduler allows you to perform, for example, copy, defrag-
ment or delete tasks regularly (e.g. defragmenting larger storages at
nighttimes or weekends) or at defined times just once.

Scheduled jobs are administered by the SpycerAgents in the
SpycerNet, i.e. by the background processes where the respective task
is targeted at (the destination system). Thus, to run scheduled jobs, the
user interface of Spycer can be closed, because it will be the back-
ground processes that carry out the tasks.

Once a scheduled job is started, it will be performed according to the
settings made in the task scheduler. It will be detailed in the job list of
each Spycer application involved in the task (i.e. the creation, target
and destination systems) with the respective job type and an added
auto ... infront. In case you do not have the appropriate rights on
the target and/or destination system(s), you will be either informed
about this when creating the job in the task scheduler, or an access to
the system will be denied at the time when the job is started which will
call up a notification then.

The following subsections explain the task scheduler of Spycer in more
detall.

7.3.1 Managing Scheduled Jobs

At the top of the task scheduler you find some items that allow you to
manage scheduled jobs. With them you can determine easily either for
the whole SpycerNet or a specific system the jobs that are scheduled

to be performed, enabling you, for instance, to identify and (with appro-
priate permissions) edit redundant or contradicting jobs.
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Figure 7-11: ltems to manage scheduled jobs

The drop-down list Select allows you to select destination peers. By se-
lecting a specific system in the SpycerNet from its list you can find out
which jobs are scheduled on this system. They will be detailed in the
list of the task scheduler. When the entry Network is selected, all jobs
that are currently scheduled in the SpycerNet will be listed.

With the check box show editable only you can hide from the list the
entries that you do not have the appropriate rights to edit. Afterwards,
only the entries that can be changed are displayed.

Once you have found a job that you want to change use the list and the
items below it to edit the task scheduler (see section “The Task Sched-
uler’s List” on page 7-19 and section “Creating and Editing Scheduled
Jobs” on page 7-20).

7.3.2 The Task Scheduler’s List

The list of the task scheduler details the scheduled jobs according to
the setting of the Select drop-down list (see section “Managing Sched-
uled Jobs” on page 7-18). It provides the following information:

Column Explanation

Job Type Specifies the type of job that is scheduled to be
performed, e.g. copy, delete, defrag, etc.

Created by Details the system that created the entry in the
task scheduler.

Src. Peer The source peer. Details the source of the data in
the SpycerNet, i.e. the name of the system where
the source data is stored.

Source States the location of the source files on the
source peer.

Dest. Peer The destination peer. Details the destination of the
data in the SpycerNet, i.e. the name of the system
where the data is to be transferred to. If empty, a
job is selected that does not require a destination.

Destination Details the target directory on the destination
peer. If empty, a job is selected that does not re-
quire a destination.

Start Indicates the interval, date and time of the event.
In case of intervals, a date refers to the day when
the task is carried out for the first time.

Duration Details how long to perform the job.
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The entries in the task scheduler are listed in the order they were en-
tered from top to bottom, i.e. the latest entries are listed at the bottom
of the list. A scheduled job can be selected with a single click of the
mouse and a double-click automatically opens the window to edit an
entry (if you have the appropriate rights, see section “Creating and Ed-
iting Scheduled Jobs” on page 7-20.

7.3.3 Creating and Editing Scheduled Jobs

7-20

With the buttons below the list you can create new or edit already ex-
isting scheduled jobs.

New Jobs

The button NEW at the bottom left of the task scheduler area, allows you
to create a new scheduled job. It opens the following window:

¢ Create new task 4

Destination:

2007-11-04 - | 8:00:00

Duratian:

Figure 7-12: Window to create a new scheduled job

Then use the items detailed below to define the job:

Job Type Select from the drop-down list the type of job that
should be performed. The following are available:
Copy, Delete, Defragment, Scan, Refresh,
Sync, Scan proxy watch folder.

Source Once a source is defined, i.e. the path to the di-
rectory where the data to be processed is stored,
itis detailed here. You can set the source with the
button to the right of the entry field (). It opens
a window where you can select drives and/or di-
rectories on systems in the SpycerNet. However,
only those systems will be listed where a Spycer
of at least version 1.3 is running.
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Destination This field will be available when a job is selected
that requires a destination (e.g. copy). It details
the target directory in the SpycerNet where to
store the processed data. You can set it with the
button to the right of the entry field (). It will
open a window where you can select drives and/
or directories on systems in the SpycerNet. How-
ever, only those systems will be listed where a
Spycer of at least version 1.3 is running.

Start These items determine the interval, date and time
when to start the job:

The first drop-down list is available for a future ad-
aptation of Spycer and can be disregarded cur-
rently.

With the second drop-down list you can set the
interval when to perform the job (e.g. Single
Event, Daily, Weekly, etc.). You can also define
an interval of your own according to your needs
(Custom Interval).

Use the available date (yyyy-mm-dd) and time
(hh:mm: ss) fields to set the day when the task
should be performed (in case of intervals when it
should be carried out for the first time) and the
time when to start the job.

Duration Determines how long to perform the job: You can
setitto auto (process until the task is finished) or
a defined time (process for hh:mm: ss, then
stop).

SAVE Saves and closes the window to configure a
scheduled job and creates a new entry detailing
the job in the list of the task scheduler.

CANCEL Cancels the creation of a new job and closes the
window.

Editing Jobs

Via the buttons DELETE and EDIT you can edit the tasks displayed in the
task scheduler.

By selecting an entry in the list of the task scheduler and pressing the
button DELETE the respective task will be deleted. However, you can
only delete scheduled jobs that were created by your Spycer applica-
tion.

With the button EDIT you can change an existing job. For this select the
scheduled job in the list and press the button edit (alternatively double-
click the job in the list) which will open the window to change a job:
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Figure 7-13: Window to edit a scheduled job

Then you can edit the respective job. The window provides the same
items as the window to create a new scheduled job (see section “New
Jobs” on page 7-20).

° The type of job cannot be changed when editing a job. For this
l you have to delete the scheduled job and create a new one.

An editing can be performed when one of the following conditions is
the case:

— The source is stored on your system.

— Your system is the destination.

— Your Spycer application created the job entry in the task sched-
uler.
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7.4 File Ingest

The group Ingest Folders in the menu Config... allows you to easily
handle several clips, edit their metadata simultaneously as well as store
and make them available for several tasks in the VENICE client soft-
ware. The original content is secured due to a virtualization of folders
that still offer you every possibility in Spycer. This is named the P2 In-
gest Workflow or the XDCAM Ingest Workflow, depending on the type
of the external drive. The File Ingest can also be used for the Avid
Workflow option in VENICE (see section “The Avid Workflow Option”
on page 7-26 and the “VENICE Client Software” user guide). In this
case the feature is named the Avid Workflow.

7.4.1 P2 Ingest Workflow

The P2 Ingest Workflow in Spycer facilitates the playout of e.g. 3D con-
tent in the VENICE client software (see “VENICE Client Software” user
guide). Stereo content is read from the connected P2 cards by its XML
data and *.vamc metaclip files are created automatically in Spycer.
You can then use these clips in VENICE to drag them into 3D groups
and play them out without having to worry, e.g. for the correct assort-
ment of the left and right eye of the stereo content. To enable P2 Ingest
in Spycer, perform the following:

* Connect the P2 card reader with the P2 cards in it to your system
(see the original manufacturer’'s documentation).

* Activate the check box P2 Ingest in the group Ingest Folders of
the menu Config... see section “The Group ‘Ingest Folders’” on
page 9-1b.

* Then select your local peer from the network drop-down list in the
browse and search area.

* Refresh the view of the directory tree by switching the peers in the
network drop-down list and then back to your local system.

o If not done yet, disable the Hide unwatched folders option in
1 the context menu option View to show all folders in the direc-
tory tree of Spycer.

Spycer identifies the P2 card reader as removable media and creates a
virtual P2 folder in the directory tree of the browse and search area as
indicated in the following figure:
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Figure 7-14: P2 ingest folder icon and content

Furthermore it identifies the P2 card reader as regular external storage
device in the directory tree of Spycer (drive H: in the figure above) and
indicates its internal folder structure with all audio, video, proxy, etc.
files. All cards in the P2 card reader are represented in this folder struc-
ture. When clicking one of these folders, you will see the files as stored
on the P2 card in the contents area of Spycer.

When clicking the folder P2 Ingest below the P2 card reader folder
structure, Spycer reads out the content that is on all cards of the P2
card reader what could take a while. When finished, it lists all files of
the P2 card as *. vamc metaclips which were created automatically by
Spycer with the help of the file's XML data. Spycer identifies different
files within the P2 Ingest Workflow. For example, stereo clips meaning
clips providing content for either the left or the right eye and spanned
clips. Spanned clips are scattered on different P2 drives but belong to
each other. Spycer will identify these spanned clips across the drives by
their XML data and create metaclips automatically. You can then copy
and save the clips to another folder on your local peer, edit metadata
(i.e. descriptive data see section “Descriptive Data” on page 8-10), re-
name several files simultaneously or delete redundant files (see chapter
“Browsing and Searching” on page b-1 and chapter “Working with
Metadata” on page 8-1). If the files are moved to a watched folder with-
in the network, you can use the search feature to find the clips.

o Although Spycer lists the drives of the P2 card reader as origi-
l nal drives in the directory tree, it is recommended to perform

any operation (renaming, editing metadata etc.) within the P2
Ingest Workflow in the P2 Ingest folder and leave the origi-
nal material on the P2 cards.

When deactivating the check box P2 Ingest in the group Ingest Fold-
ers of the menu Config... again, the virtual P2 folder will disappear but
the P2 card reader will still be indicated as regular external storage de-
vice (drive H: in the figure above) in the directory tree of the browse
and search area in Spycer.
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7.4.2 The XDCAM Ingest Workflow

To start working with the XDCAM option in Spycer, you need an
XDCAM card reader with the respective content and the driver for the
device must be installed on your DVS system. To enable XDCAM ingest
in Spycer, perform the following:

* Connect the XDCAM card reader with the XDCAM cards in it to
your system (see the original manufacturer’'s documentation).

* Activate the check box Professional Disk Ingest in the group
Ingest Folders of the menu Config... see section “The Group
'Ingest Folders'” on page 9-15.

* Then select your local peer from the network drop-down list in the
browse and search area.

* Refresh the view of the directory tree by switching the peers in the
network drop-down list and then back to your local system.

. If not done yet, disable the Hide unwatched folders option in
1 the context menu option View to show all folders in the direc-
tory tree of Spycer.

Spycer identifies the XDCAM card reader as removable media and cre-
ates a virtual XDCAM folder in the directory tree of the browse and
search area as indicated in the following figure:

Fath:

File Fath

1

Figure - 16: XDCAM ingest folder icon and conenz‘

Furthermore it identifies the XDCAM card reader as regular external
storage device in the directory tree of Spycer (drive K: in the figure
above) and indicates its internal folder structure with all audio, video,
proxy, etc. files.

s ) T several XDCAM card readers are connected to the DVS sys-
1| tem Spycer will list all devices as regular external storage de-
vice in its directory tree represented by letters.

The contents on the XDCAM card reader are represented as its original
folder structure in the directory tree. When clicking one of these fold-
ers, you will see the files as stored on the XDCAM card in the contents
area of Spycer.

When clicking the folder XxDCAM Ingest below the XDCAM card read-
er folder structure, Spycer reads out the content that is on the card. This
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could take a while, depending on the size of the stored data. WWhen fin-
ished, it lists all files of the XDCAM card as *.vamc metaclips which
were created automatically by Spycer with the help of the file’'s XML da-
ta. Spycer identifies different files within the XDCAM Ingest Workflow
and creates metaclips from them, so you do not have to worry about
which e.g. audio and video clips belong to each other. You can then
copy and save the clips to another folder on your local peer, edit meta-
data (i.e. descriptive data see section “Descriptive Data” on page 8-10),
rename several files simultaneously or delete redundant files (see chap-
ter “Browsing and Searching” on page 5-1 and chapter “Working with
Metadata” on page 8-1). If the files are moved to a watched folder with-
in the network, you can use the search feature to find the clips.

o Although Spycer lists the XDCAM card reader(s) as original

1 drives in the directory tree, it is recommended to perform any
operation (renaming, editing metadata etc.) within the XDCAM
Ingest Workflow in the XDCAM Ingest folder in Spycer and
leave the original material on the XDCAM card reader(s).

When deactivating the check box XDCAM Ingest in the group Ingest
Folders of the menu Config... again, the virtual P2 folder will disappear
but the P2 card reader will still be indicated as regular external storage
device (drive K: in the figure above) in the directory tree of the browse
and search area in Spycer.

7.4.3 The Avid Workflow Option

VENICE

VENICE

HD-SDI

UsB 3.0
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VTR / Live Video

The Avid Workflow is optionally available. With it you can work directly
on Avid's ISIS or use the production asset management Interplay. The
setup of the workflow is shown in the following figure:

P2 / XDCAM® =
k|
=7
|
i @
. Wrapping AT IS E @
@ sis° client _
Switch g

. Interplay® Client

Internal Storage Spycer®

B 7 N Avid
— [ ﬁ Media Composer®
- Avid Interplay® (PAM)
| VENICE Appliance

s
10 Gbit/s Ethernet ﬁ

SpycerBox Flex

Figure 7-16: The Avid Workflow

The DVS solution offers a server appliance connected to the VENICE
base system and enables direct signal ingest via HD-SDI. Up to four
channels can be ingested in parallel together with simultaneous proxy
file generation. The Avid drives are represented by virtual folders (pur-
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ple drive and directory icons) in the directory tree in the Spycer soft-
ware as in the following:

=

Figure 7-17: Directory tree of the Avid Workflow

All comprehensive standard features of VENICE such as VTR control
and batch capturing are also available. Metadata can be added to me-
dia files easily. Interplay projects and workspaces located on the ISIS
storage can be used for ingest as well as playout tasks. Via Spycer you
can also drag 'n’ drop files to projects or workspaces directly. Then you
can select as the record destination either a workspace located on the
ISIS storage or an Interplay project.

° Please contact the DVS service department for licensing and
1 setting up the Avid Workflow on your systems.
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7.5 Metaclips

Spycer offers a metaclip feature that allows you to easily create, man-
age and store metaclips of several file formats. Metaclips can be de-
scribed as a container for video and audio clips. They are normal text
files that detail among others the location of the included clips. They
can contain data about several clips forming a playlists, with audio and
video clips and its correct order.

7.5.1 Basics

7-28

Metaclips can be created directly, e.g. in the VENICE client software
(see "VENICE Client Software” user guide) or via Spycer. Metaclips that
were created in the VENICE client software, can easily be imported in
the Spycer software. Metaclips that were created in the Spycer soft-
ware, can be saved to the wanted destination to later use them as
source data for playout and transforming tasks in VENICE just as any
other clip. Normally one video and one or more audio clips are de-
scribed in a metaclip. However, it is also possible to reference to several
video/audio clips in a metaclip (for example for a playout in the 3D
mode in VENICE) and they would be played out successively as listed
in the metaclip. Furthermore metaclips can be created within a P2 fold-
er structure without having to use the P2 Ingest Workflow option (see
section “P2 Ingest Workflow"” on page 7-23).

File extension: * . vamc Video/audio metaclip file

All *. vamc files carry the file format METACLIP and can be searched
as such. When browsing to the respective folder, you find all metaclips
listed with further descriptive data as in the following figure:

[
u
u
u
u
u
u
u

&  METACLIP

Figure 7-18: Metaclips as *.vamc files in folder

You cannot move single metaclips to other folders if no abso-
lute path has been set in the metadata. WWhen moving content
with a set relative path or when deleting the original file (e.g.

the *.mxf file), the *.vamc file will lose its reference data.

i @

When creating metaclips, the names of the source clips must
be equal, otherwise the software might not know which clips
are to be combined.
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7.5.2 Creating Metaclips

Creating metaclips is easy in Spycer as you just have to perform a right-
click mouse operation to start the process. Depending on the location
and folder structure you either have to right-click a folder or a clip/sev-
eral clips in a folder. When browsing e.g. a P2 folder structure, Spycer
will search compatible audio and video clips automatically by their
naming. Perform the following to create metaclips in a P2 folder struc-
ture without using the P2 Ingest Workflow option:

* Right-click, e.g. the folder VIDEO in the folder CONTENTS of the P2
volume.

» Select the option Create metaclip(s) from the context menu to
start the create metaclip job.

Spycer will search all folders in the superior folder CONTENTS and cre-
ate metaclips from all matching audio and video clips with the help of
the file's XML data. Then it will create a folder superior to the folder
CONTENTS containing all metaclips.

If you want to create a metaclip from an audio and a video file in a fold-
er, perform the following:

* Select both clips by clicking them and simultaneously pressing the
key [Ctrl].

* Right-click the selected clips and select the option Create meta-
clip(s) from the context menu to start the create metaclip job.

Spycer will now create a metaclip from the audio and video file and
save it to the same folder. You can create metaclips from single video
files the same way.

° Please note that you can only create metaclips from XDCAM,
1 | DNXHD and P2 content.

You can now edit the metadata as described in section “Working with
Metadata” on page 8-14 or rename several metaclips simultaneously
as detailed in section “Renaming” on page 7-2. Assign an absolute
path to the metaclips in the metadata to be able to move them to other
folders or perform a deep copy. Performing a deep copy means that you
can copy only the metaclip into another folder and Spycer will move the
referenced audio and video files automatically. By performing a simple
drag 'n’ drop operation of the metaclip as described in section “Copy-
ing (Moving) Directories/Files” on page 7-8, Spycer will ask you in a di-
alog window if you want to perform a deep copy. When clicking YES,
only the metaclip will be copied to the folder but referencing correctly
to the e.g. *.mxf files.

° Deep copy operations are only possible to your local peer or to
1 a SAN volume.
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Metadata is data about data. In the field of digital video, it stands for
further information that describe the content (footage) throughout the
various production stages. This may include everything from the plan-
ning and pre-production stage over the actual production and post pro-
duction to the final delivery of the content. With Spycer you can add
and edit metadata effortlessly.

This chapter contains all information you need about the management,
the work and the viewing of metadata in the Spycer software.
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8.1 The Metadata Tab

If not already visible in the user interface, you can ac-
tivate the view of the metadata and preview areas of
Spycer with the button METADATA directly below the menu bar.

metadata controls metadata fields

art
End
Duration

TC Frame Rate

Wi dth 2042 Height

Depth 10 Alpha Depth

Fixel Ratio

Sampling Rate

hdode RzE Sampling

Gamma SMFPTEZ:™ Range

Frame Rate 24 v Coding:

Figure 8-1: The metadata area

The metadata area will show you the properties and metadata of the file
currently singled out in the browse and search area. You can switch
through as well as add and edit the metadata with the buttons (con-
trols) provided to the left.

This chapter describes in detail the metadata area as well as how to
work with metadata.

8.1.1 Displaying Metadata

The procedure to display metadata is the same as if you want to pre-
view the material in the preview area to the right of the metadata area:
It has to be singled out in a contents area of the browse or search tools.

° For further information about the preview area please refer to
1 | section “Previewing Data with the Preview Area” on page 6-3.

* To single out data and view its metadata, perform the procedure
described in section “How to Single out Data” on page 6-7.
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As soon as the metadata of the selected material are displayed, you can
switch through as well as add or edit them with the metadata controls
(see section “The Metadata Controls” on page 8-3). When an entry is
changed and saved, it will be stored in the file header(s) and/or in the
data record of the respective file/sequence in the database adminis-
tered by the SpycerAgent.

8.1.2 The Metadata Controls

After the metadata is displayed in the metadata area (see section “Dis-
playing Metadata” on page 8-2), you can switch through the different
metadata views as well as add or edit the metadata with the controls
provided to the left. The following controls are available:

The button FILE (the first view activated when

WAMNC [rata

Header [rata

Spycer is started and the metadata area is displayed)
shows the file related metadata information in the
metadata fields to the right of the controls. For more
details about this metadata view see section “File
Metadata” on page 8-4.

s ) [his view of the metadata allows you to re-
1 view most information only. Because they

are properties of the singled out data they

cannot be changed.

When clicking this button, you can switch to the
VANC data view. VANC data is ancillary data, speci-
fied by the SMPTE and sent in the blanking interval
of the video data. \When selecting the respective file
carrying VANC data, you can view it in the metadata
fields. For further information see section “VANC
Data” on page 8-8.

This button switches the view of the metadata to a
display of the header data provided by the singled
out material. Most file formats feature a file header
where further information about its content are de-
tailed. In the header data view of Spycer, you can
get a look at the data as it is written in the file itself.
With video data it will display the header data of the
frame (image file) that is currently selected with the
scrub bar cursor of the preview area (see section
“Header Data” on page 8-6). Certain entries in the
header data can be edited if supported by the file
format, e.g. the timecode information (source time-
code). Once saved, they will be directly written to
the file(s).

o Currently, only the header data of *.dpx
1 | and *. r3dfiles can be edited with Spycer.
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Froduction [rata

Crezcriptive [ata

Cancel

With the PRODUCTION DATA button you switch the
metadata view to its production information. Here
you can add or edit additional information about the
production stages of the content.

With the DESCRIPTIVE DATA button you switch the
metadata view to its descriptive information. Here
you can add or edit information about, e.g. the cre-
ation or type of the content.

o The descriptive data can be changed to

] | Yyourpurposes. Please contact the DVS ser-
vice department for customized descriptive
data.

This button allows you to add or change the meta-
data as they are available in the production metada-
ta view (button PRODUCTION) or the header data
view (button HEADER DATA). Once clicked, the me-
tadata can be changed.

With the SAVE button you can save your alterations
to the metadata. The changes will be stored in the
file header(s) (when in the header data view and
supported by the file format) and/or in the data re-
cord of the respective file in the database adminis-
tered by the SpycerAgent.

The CANCEL button discards all alterations to the
currently active metadata view.

8.2 Metadata Views

Spycer provides five metadata views to the metadata of the singled out
file: file metadata, header data and production metadata. You can
switch through the different metadata views with the upper controls
provided to the left (buttons FILE, VANC DATA, HEADER DATA, PRODUC-
TION DATA and DESCRIPTIVE DATA). Once the button EDIT is clicked and
if the respective fields are not dimmed, you can change their metadata.
The changes will be stored either in the file header directly and/or in the
data record of the respective file with the button SAVE.

This section explains shortly the different metadata views provided by
the Spycer user interface.

8.2.1 File Metadata

If not already displayed in Spycer, activate the view of the file metadata
with the button FILE of the controls (see section “The Metadata Con-
trols” on page 8-3).
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Ganaral File Data
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Figure 8-2: The file metadata

When a file is singled out (see section “Displaying Metadata” on

page 8-2), the file metadata view shows its file related information. All
files displayed in Spycer will deliver metadata in this view, for example,
in the area 'General File Data’ standard information about storage loca-
tion and file name are detailed. Additionally, video, audio and project
files supported by Spycer (see section “Supported File Formats” on
page A-6) provide the following:

s ) [his view of the metadata allows you to review most informa-
1 tion only. Because they are properties of the singled out file
they cannot be changed.

Some areas of the file metadata view will alter their appearance
and show different metadata in dependence on the selected
file type.

video/still images Video and still image files present further details
about their format in the area 'Image’ as well as
timecode or keycode information in the area 'Time-
code’ when timecode and/or keycode are stored in
the file's headers (source timecode).

audio Audio files detail further information about their
audio properties in the area 'Sound’.

project files Project files of a video system software by DVS
(e.g. the CLIPSTER or the VENICE software) will
deliver information about their output settings (vid-
eo format settings) as well as give a list of all media
that are included in the project.
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With the button RENAME you can change the file name(s) of the
singled out material. Please refer to section “Renaming” on
page 7-2 for further details.

i @

A defragmentation of the singled out material can be initiated
with the button DEFRAG. See section “Defragmenter” on
page 7-4 for more information.

With the drop-down list Source of the area "Timecode’ you can
select different types of timecode to be displayed in the file me-
tadata view (GENERIC: the first and last source timecode read
from the files’ headers, KEYCODE: the first and last keycode in-
formation read from the files’ headers, and INDEX: the start
and stop index (first and last frame number) read from the file
names).

8.2.2 Header Data

8-6

You can switch to a view of the header data of the singled out material
with the button HEADER DATA (see section “The Metadata Controls” on
page 8-3).

Most file formats provide a file header where further information about
its content are detailed, for example, in an image file often its height,
width and color depth is detailed. Some file formats, e.g. *. dpx files,
are capable of storing even more information. These information are
usually written in a specified format into the file headers and can be
read and interpreted by different software applications that support
these kind of information. Among them you find, for example, the
name of the creator (usually the program that created the files), the cre-
ation date and time, the timecode (so called source or generic timeco-
de), and/or the keycode.

In the header data view of Spycer, you get a look at the data as it is writ-
ten in the file itself. With video clips it displays the header data of the
file that is currently selected with the scrub bar cursor of the preview
area. To view the header data of another video image file, simply move
the scrub bar cursor of the preview area (see section “Previewing Data
with the Preview Area” on page 6-3) to the wanted position.

. Scrubbing of files that are bundled as sequences but not rec-
1 ognized as video material can be performed in the preview area
as well. The header data will be displayed this way.
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Figure 8-3: The header data

Files of text-based formats like *. 1ut, *.3d1, *.xml, *. txt,
* . vamc and VENICE files like *.venicescenarioand

* . venice show their complete contents when viewed in the
header data view.

i @

At the top of the header data view, you find further information about
the material that is singled out. At the top left the file name of the ma-
terial is detailed. With video clips that consist of still image files it is the
one that is currently selected with the scrub bar cursor of the preview
area. Certain entries of the header data can be added or edited if sup-
ported by the file format. With the drop-down list Edit at the top right
you can specify where in a video image file sequence an editing of the
header data should be performed.

If header data can be altered, a click on the button EDIT will alter the
view of the header data and you receive an entry mask:
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Figure 8-4: Changing the header data

The header data values that are detailed in this mask can be altered by
adapting or entering a value in an entry field and activating it with its
preceding check box. For further information about this see section
“Altering the Header Metadata” on page 8-14.

o Currently, in the header data view only the data of *. dpx files
1 and certain metadata attributes like edge timecode, absolute
timecode (time of day) and start timecode of *. r3d files can
be edited in Spycer.

8.2.3 VANC Data
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ANC data is ancillary data, specified by the SMPTE and sent in the
blanking interval of the video data. It includes data with timecode (TC),
embedded audio, closed captions and data for error detection, espe-
cially that of error detection and handling (EDH). Furthermore, it pro-
vides data about the ATC, the ancillary timecode. The number of
blanked pixels varies widely between different digital TV standards.

Ancillary data that is stored in the vertical blanking region between SAV
(start of active video) and EAV (end of active video), is known as vertical
ancillary data or VANC. VANC is commonly used for low-bandwidth
data and carries e.g. the closed caption data or VPID (video payload
identifier). The horizontal ancillary data space is abbreviated as HANC.

When selecting the respective file in the preview area (see section “Pre-
viewing Video Clips” on page 6-8) carrying VANC data, you can view it
in the metadata fields as in the following figure:
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Figure 8-5: The VANC data

When switching the metadata view to VANC data (button VANC DATA),
you see the caption data, Dolby-E audio data and additional informa-
tion. In the table to the top right you find the closed captions. When
previewing a clip in the preview area, the embedded closed captions
will be displayed in the table.

. VANC data can be displayed when stored on your local system
1 only. The VANC data in metaclips (*. vanc) can be viewed in
the Spycer software as well.

8.2.4 Production Data

With the PRODUCTION button you switch the metadata view to the pro-
duction metadata (see section “The Metadata Controls” on page 8-3).
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Figure 8-6: The production data

In this metadata view, you can add or edit additional information about
the production stages of the content. All fields can be changed (see
section “Changing the Production Metadata” on page 8-15).

8.2.5 Descriptive Data
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Descriptive data can be added to clips when recording and then made
visible and editable in Spycer again. This workflow has especially been
designed for file ingest from P2 and XDCAM drives. The descriptive
data of these files can be edited or even multi-edited and then stored to
a storage location at your choice in the SpycerNet. When working with
content from a P2 or XDCAM drive as described in section “P2 Ingest
Workflow"” on page 7-23 and in section “File Ingest” on page 7-23, you
can use the descriptive data for a fast management of data. The edited
descriptive data will be temporarily saved to the virtual P2 or XDCAM
folder and then, when creating metaclips (see section “Metaclips” on
page 7-28), written to the XML-file and the metadata of the metaclip.
Then, if the files are moved to a watched folder within the network, you
can use the search feature (see section “Searching for Data” on

page 5-10) to find the clips by its descriptive data. Activate the descrip-
tive data view by clicking the button DESCRIPTIVE DATA to the top-left
of the Spycer user interface (see section “The Metadata Controls” on
page 8-3). If the selected file contains descriptive data, you will see all
data fields and entries that are enabled for the specific file and/or that
are typical for the file format. If the file carries no descriptive data, this
will be indicated in the metadata area (see section “User Interface in the
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Metadata Mode” on page 4-3). If the file carries descriptive data, the
metadata area in your Spycer software will look similar to the following
figure:

Figure 8-7: The descriptive data

Data groups containing the entry fields and the respective data are la-
beled in white font and non-editable are labeled in grey. The entry fields
that can be edited or that are read-only can be defined in the clip file.

Editing the Descriptive Data
To edit the descriptive data of a clip, perform the following:

* Select the respective clip file from the directory tree and click it in
the contents area.

¢ C(Click the button EDIT to the bottom left of the metadata area (see
section “User Interface in the Metadata Mode” on page 4-3) to
enable the editing view as in the following figure.
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Figure 8-8: Editing the descriptive data

* Enter the data into the respective entry fields.

* Click the button SAVE to the bottom left of the metadata area to
save the descriptive data to the clip file and to close the editing
view.

o The check boxes to the left of the entry fields will be activated
] | automatically when entering data into the fields.

If the check box is not activated, the data in the respective en-
try field will not be saved to the clip file.

Editing descriptive data can also be performed via the context menu of
a clip file. This can be used especially for simultaneously editing the de-
scriptive data of several clips. Perform the following:

* Select the respective clip file from the directory tree and click it in
the contents area.

<) You can select several files when clicking a clip and simultane-
l ously pressing the [Ctrl] key. When using the shortcut
[Ctrl + A], you can select all clips in a folder.

The first clip you select will be the preference clip for Spyceri.e.
only the descriptive data of this file type in a folder will be ed-
ited. The preference clip will then be indicated by an orange
line. Files in subfolders will not be regarded either.

* Right-click the selected clip(s) and select the option Edit descrip-
tive metadata....

8-12
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This will open a further window containing all enabled entry fields for
the clip file. The entry fields will be the same as when using the EDIT
button to the bottom left of the metadata area.

* Fill'in the respective fields with the descriptive data as wanted and
click the button OK.

The descriptive data of all selected clips will now be changed and saved
to the clip files. This will be indicated as meta edit job in the job list.

° The metadata which were assigned to a file in the VENICE cli-
1 ent software are visible in Spycer in the descriptive metadata.

Customized Descriptive Data

Customized descriptive data fields can be added to the software and la-
belings of already existing entry fields can be changed as well. If you
want to define more than the given entry fields for the descriptive data,
please contact the DVS service department. The new entry fields will
then be available and editable in the Spycer user interface.

o All metadata will be saved to the database in Spycer. If new en-
1| tv fields are added to the descriptive data, you will have to
scan the respective clip files anew.

Customized descriptive data fields that are not typical for a specific file
format can also be defined for the metadata file of a metaclip in Spycer.
The descriptive data will then only be saved to the metadata file of the
respective clip.
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8.3 Working with Metadata

Once material is singled out as described in section “How to Single out
Data” on page 6-7, its metadata is displayed in the metadata area. All
files displayed in Spycer provide metadata in the different metadata
views. This way you can gather information from the file metadata view
(button FILE), for instance, about the video or audio format of material
or check the timecodes provided by a video clip with the drop-down list
Source. Furthermore, you may compare these information with the ac-
tual header data stored in the file(s) with the help of the header data
view (button HEADER DATA). In the production metadata view (button
PRODUCTION), you can view its production metadata.

In the production and header data view, metadata can also be added
and edited. This section describes shortly how to add and/or edit meta-
data.

s ) For further information about the file's descriptive data and
1 VANC data see section “Descriptive Data” on page 8-10 and
section “VANC Data” on page 8-8.

8.3.1 Altering the Header Metadata

8-14

Certain file formats of video clips also support the storing of metadata
information in their files’ headers. Among these metadata you find, for
example, the name of the creator, the creation date and time, the
source timecode, and/or the keycode.

To change the header data of an image sequence, perform the follow-
ing:

. Currently, in the header data view only the data of *. dpx files
] | and certain metadata attributes like edge timecode, absolute
timecode (time of day) and start timecode of *. r3d files can
be edited in Spycer.

Files of text-based formats like *. Iut, *.3d1, *.xml, *. txt,
* . vamc and VENICE files like *.venicescenarioand

* . venice show their complete contents when viewed in the
header data view.

* Single out the video clip whose metadata you want to change as
described in section “How to Single out Data” on page 6-7.

* In case you want to alter the metadata of a specific image or image
range, move the scrub bar cursor of the preview area to the wanted
position (see section “Previewing Video Clips” on page 6-8).

* After this switch to the header data view by activating the button
HEADER DATA.

This displays the header data of the file currently selected with the
scrub bar cursor in the header data view. Now you can change its me-
tadata:
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* Via the drop-down list Edit at the top right of the header data view
select where in the file sequence an editing of the header data
should be performed.

e After this activate the button EDIT from the metadata controls.

This will alter the appearance of the header data view and an entry
mask is displayed.

o In case no entry mask is displayed when the button EDIT is ac-
1 tivated, an editing of the header data is not supported by the
selected file format.

* Type in or alter the respective metadata information in the available
fields.

. To create file names with a proper frame numbering as meta-
1 data for video clips, you have to observe the C notation, usually
with the syntax <string>%0Yd. <ext> (see section “The
Search Parameter Area” on page 5-10).

¢ (Check whether the check boxes of the values that should be
changed in the file header(s) are enabled.

e Afterwards, save the metadata with the button SAVE.

This will change the values stored in the file header(s). Depending on
the selected file range for the changes it may take some time. When fin-
ished, the original header data view is restored and you can see the al-
terations in the information displayed.

8.3.2 Changing the Production Metadata

Production metadata can also be changed. They will be stored virtually
in the database of the Spycer application:

* Single out the material whose metadata you want to change as
described in section “How to Single out Data” on page 6-7.

* |f not already displayed, switch to the production metadata with the
button PRODUCTION of the metadata controls (see section “The
Metadata Controls” on page 8-3).

* From the metadata controls activate the button EDIT.

This enables you to change the metadata displayed in the metadata ar-
ea.

* Type in or alter the respective metadata information in the available
fields.

¢ Afterwards, save the metadata with the button SAVE.

The metadata will be stored and written to the material’s data record in
the database administered by the SpycerAgent. With this you can eas-
ily find the material again by searching for the added metadata with the
search tool of Spycer (see section “Searching for Data” on page 5-10).
In addition Spycer automatically generates XML files (* . metadata) for
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each content entry of the database with the supplemental descriptive
information as set in the software.
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This chapter describes the general configuration settings of Spycer
which are to be found in the menu Options when selecting the option
Config... or when pressing the key [F4]. Among them you find, e.g. the
remote access permissions, options for the administration of
SpycerNet groups and the network configuration settings.

Additionally, the chapter details other items of the software, such as the
context menus available for Spycer or the properties window.

9-1



Spycer User Guide

ﬁ

9.1 The Configuration Menu

The menu Config... in the menu bar to the top left of the user interface
(see section “The Menu Bar” on page 4-12) provides, e.g. the settings
for the remote access permissions and the network configuration. To
set any of the general configuration settings of Spycer, you have to ac-
cess them first. For this perform the following:

¢ From the menu bar of Spycer (see section “Overview of the User
Interface” on page 4-2) select Options » Config... or press [F4] on
your keyboard.

This will open the general configuration settings of Spycer:

settings pane

o . -

Figure 9-1: Starting screen of the configuration settings

The window provides the following items in general:

group list

To the left side of the configuration window, you find
a group list that provides access to the different set-
tings. They will be valid for the Spycer software in gen-
eral. Once an entry is selected, the settings pane to the
right will alter its appearance and the configuration
items of the respective group are displayed. You can
then change the settings of this group.

settings pane

The settings pane shows the settings that are available
under the selected group (group list to the left). To
change the settings, alter the configurations in the set-
tings pane and confirm your alterations with the OK
button.

RESET

A click on this button resets all values back to the last
confirmed settings.
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OK This button confirms your alterations to the settings in
the configurations window and closes it. Then the
new settings will be in effect. They will be saved when
the Spycer user interface is closed (see section “Exit-
ing the Software” on page 3-14).

CANCEL The button CANCEL closes the window for the general
configuration settings without confirming your set-
tings. The Spycer application will use the latest con-
firmed settings.

Some of the settings have already been set during the initial
setup procedure. For any further information about this please
refer to section “Initial Setup of Spycer” on page 3-8.

i @

9.1.1 The Group 'Active Directory’

Spycer is able to heed user and group permissions controlled by a Win-
dows Active Directory environment. When starting the software, you
will be prompted to enter user name and password for the domain.
Spycer will ensure that file permissions and owner settings are kept
during all data movements across the SpycerNet. The following figure
shows the settings:

s -
Defaults

Figure 9-2: The group "Active Directory’

enable Select this check box to enable the Windows Active
Directory environment as well as the entry fields and
the button of the group.

User: Enter the user name for the domain in this entry field.
Password: Enter the password for the domain in this entry field.
VERIFY Press this button to verify your entries and to enable

the Active Directory feature.

When the Active Directory option is enabled, you will be prompted to
enter a valid username and password each time you start the Spycer
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application. Disable this option by deactivating the check box to start
Spycer without logging in an Active Directory environment.

i

Spycer may require certain settings to be activated within the
Windows Active Directory controller. Please contact the DVS
service department for installation support.

9.1.2 The Group 'Administrator’

9-4

With Spycer network administrators can define and manage computer
groups for a secured SpycerNet by using the existing infrastructure. Ev-
ery peer can have an administrator account which must be configured
once during or after the installation. By using a password protected ad-
ministrator account, peers can be (remotely) assigned to a secure
SpycerNet group. This increases the security of a peer-to-peer network
significantly because the secured Spycer peers are only visible when
they belong to the same group.

s

= administrator

Figure 9-3: The group ‘Administrator’

Login:

Enter your administrator password in the re-
spective entry field and press the button OK
to log in as administrator and see all
SpycerNet groups. After logging in, the ap-
pearance of the window alters and you find
two buttons. Use the button LOG OUT to log
out after your work is finished change your
administrator password with the button
CHANGE PASSWORD.
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The security group system is very flexible: As administrator you can use
the existing network infrastructure and easily choose which peer to add
to any group. After logging in, you see the SpycerNet groups as indi-

cated in the figure:

Figure 9-4: SpycerNet groups after logging in as administrator

Manage SpycerNet
Groups:

In this area you see all SpycerNet groups that
are available in the network. You can select/
deselect them by clicking the check box in
the column Peer. If you select one or more
particular peer(s) in the listing, you can as-
sign it/them to a SpycerNet group.

Change SpycerNet
Group of the selected
peer(s):

In this area you find a drop-down list provid-
ing none, new group and the group your
password is valid for. With these you can add
a new SpycerNet group (new group), set a
peer as none which is then labeled as public
and visible to everyone in the SpycerNet or
select the group your password is valid for
(e.g. Testgroup in the figure above). Perform
this by selecting the respective peer(s) from
the listing in the Manage SpycerNet
Groups: area, selecting an option from the
drop-down list and then pressing the button
SET.
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9.1.3 The Group 'AMT Exchange’

The group AMT exchange provides the options for the configuration of
Spycer in the Avid Workflow Option. Here, you can add a new drive to
Spycer that will serve as the database of Avid Interplay. This will be vis-
ible in form of a purple folder icon in the network/system drop-down list
of the browse and search area. The group offers the following:

9-6
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-

Media files pathlS15) | Interplay wotgroup | Metadata path (Local)

Figure 9-5: The group "AMT Exchange’

drop-down list 'net-
work and peers’

From this drop-down list you can select a par-
ticular system or the whole network in Spycer.

Local AAF
project folder

Use the directory button (...) to the right of the
field to browse to your local AAF project folder.

AMT drives listing

In this area all added virtual AMT drives are list-
ed. Furthermore, you find details about their
state, the media files paths on the Avid ISIS, the
Interplay work groups they belong to, and their
local metadata path.

buttons AbDD, DE-
LETE and MODIFY

Use these buttons to add a new AMT drive to
the listing, delete a selected drive or modify a
selected drive.

i @

The setup of the Avid Workflow Option will be performed by
the DVS service department. Please contact it for the installa-
tion and licensing.
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9.1.4 The Group 'Datarate Settings’

Spycer offers the possibility to limit the datarate for copy processes (de-
termined by the mount point of the exporting Spycer). The software
uses an implementation that guarantees smooth bandwidth distribu-
tion without any datarate peaks that could affect real-time playout or in-
gest. The throttle mechanisms are automatically adjusted regardless
whether you are using a local copy (SAN) or a network copy (NAS)
based transfer method. If datarate limitation is activated, Spycer will se-
rialize all jobs in the job queue.

5 coveon R —~

Limitation Activatad

I

CIEEIEL!

N

Figure 9-6: The group ‘Datarate Settings’

Path This column lists all local drives that can be found by
Spycer.

Limitation When activating the respective check box in the col-
umn Activated, the value in the Limitation column
will be alterable. Use the up- and down arrows to
change the value in steps of 5 Mb/s or select it with
the mouse pointer and enter a new value. All copy or
move jobs on this volume will be limited to the set da-
tarate.

Activated In this column you find check boxes to activate the dif-
ferent paths for the datarate limitation. When you click
into a check box, the respective value in the column
Limitation will be highlighted and the up- and down
arrows will be available.

The Spycer versions 2.2 and higher use approx. 20% head-
room of the set datarate.

i @

In very rare cases, more than one Spycer clients have a shared
network access. If these Spycer clients have different datarate
settings, the lower value of the two is used for datarate limita-
tions.
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9.1.5 The Group 'File Transfer Ports’

9-8

The group File Transfer Ports allows you to configure further network
ports that should be used exclusively for file transfers (e.g. copying pro-
cedures). By adding them to the list box on the right you can improve
the data transfer rate of your Spycer when copying or moving files to
or from other Spycer applications in the SpycerNet.

These network connections will be used for file transfers only and op-
erate in combination with the already existing network connection to
the SpycerNet.

5 corevsr . -

MT = - T ar high-speed file
D atarate
s -I:-r:!r our data tr 2

used in parallel v

Selected Ports:

Figure 9-7: The group ‘File Transfer Ports’

The group File Transfer Ports provides the following settings items:

o Only active network connections will be displayed. When a
1 network connection is inactive (e.g. no cable connected), its |IP
address will not be available.

Available Ports In this list box you find available additional net-
work connections. Select the ones that should
be used for file transfers and move them to the
list box to the right with the appropriate button.

o All available additional ports that are
1 currently active will be listed, regard-
less whether they can connect to an-
other Spycer application or not.
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Selected Ports This list box details the additional network con-

nections that will be used for file transfers. To
remove a port from the list, select one and
press the appropriate button to move it to the
left list.

- W These buttons move the selected ports from

the left list box to the right, or vice versa.

9.1.6 The Group 'FTP Connectivity’

The group FTP Connectivity provides options to establish a connec-
tion to another server via FTP. If you need to, e.g. download files from
a server without using the Spycer software on it, you can enter its IP

address and link to it:

s .

Ftp connection name Fort number | Senertype

Figure 9-8: The group ‘FTP Connectivity’

Use the button ADD to open a dialog window with all options and set-
tings needed. All established connections will then be listed in the set-
tings pane of the group FTP Connectivity and you can delete and
modify them by selecting an FTP connection and pressing the button
DELETE or MODIFY. After pressing the button ADD to establish a new
connection, you will see a dialog window with the following options:

Virtual name

Enter a name at will for the FTP server connection into
this entry field.

URL

Enter the IP address without port number of the FTP
server into this entry field.
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Port number | Enter the port number you want to establish the con-
nection to into this entry field. The number 21 is the
standard port number for FTP.

Server type | This drop-down list offers the options Standard,
Grass Valley K2 and Grass Valley profile.

Selecting a standard server, will connect you to a stan-
dard FTP server. Selecting a Grass Valley server from
the drop-down list, offers you the possibility to con-
nect to it and to be able to use its specific features.

Username Enter a username that is valid for the remote FTP serv-
er.

Password Enter a password that is valid for the remote FTP serv-
er.

When all settings are made and the FTP connection is established, you
can perform download and/or upload operations, depending on the
server's configuration.

o Since no Spycer software is installed on the opposing side, no
1 verify will be performed and no copy reports (see section “The
Job List” on page 7-15, context menu Show Report) will be
made after download/upload operations.

Very often you can select a folder in the directory of the FTP
server that functions as transfer folder for data exchange.

In the Spycer software the FTP directory will be visible as an FTP folder
icon in the browse and search area (see section “User Interface in the
Metadata Mode” on page 4-3) when you set it as visible folder.

Figure 9-9: The FTP folder icon in the directory tree

* To perform this, right-click the directory tree to the bottom left of
the user interface and select the option View.

To set unwatched folders to visible folders, the check mark in the option
Hide unwatched folders must be unchecked. This will set all un-
watched folders to visible in the directory tree of Spycer.
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With clicking the plus to the left of the FTP folder icon you can expand
the directory tree and see all subfolders. Depending on the server's
configuration you have access to different contents.

o Spycer does not read content in the FTP folders automatically.
1 When browsing to the folder, the FTP connection is estab-
lished from new each time. Therefore, the FTP folder icons will
not indicate if there's content in the folder or not and the
search feature in Spycer does not show all results.

File-based clips are shown by each frame as single file. Copying clips
from the FTP server into Spycer can be performed by multi-selecting

the files and copying them or copying the superior folder. The job list

will then indicate an ftpcopy job (see section “User Interface in the Job
List Mode” on page 4-4).

Usually FTP servers have a defined time-out moment that depends on
the remote server's settings. WWhen not working with the FTP connec-
tion, the server disconnects but the Spycer user interface might not up-
date automatically. Perform the following to refresh the user interface:

* Right-click the directory tree in the browse and search area in
Spycer and select the option Refresh or press [F5] before continu-
ing working with the FTP feature after a longer break.

o Please note that there is a properties window for the FTP peers
1 in the directory tree as well (see section “The Properties Win-
dow"” on page 9-34).

9.1.7 The Group 'General’

With the group General you configure the networking and local con-
tent management of Spycer. With the network settings you determine
the connection of your Spycer application to the SpycerNet as well as
its appearance in the network. The local content management will be
administered by the background process SpycerAgent. When it is en-
abled, the SpycerAgent will write information about the contents of the
watch folders (see section “The Group "Watch Folders’” on page 9-24)
into a database, making it available to your Spycer application as well
as to others in the SpycerNet (if applicable and permissions are given).
Afterwards, the watch folders will be monitored and the database will
be revised once file processes are detected. To configure a Spycer ap-
plication to take part in the SpycerNet, set an IP address other than the
local host address has to be stated in the network settings of Spycer.

o When a local content management is disabled, Spycer will not
1 display any local drives or storages. Then the user interface can
be used as a network browser showing the contents of other
Spycers in the SpycerNet only.
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Figure 9-10: The group ‘General’

In the group General you find the following settings items:

drop-down list Select from this drop-down list the network
'IP address’ connection (IP address), that Spycer should
use to connect to the SpycerNet. The localhost
address (127.0.0.1) disables the network con-
nection for Spycer. Afterwards, it can be used
locally only. The IP addresses that can be se-
lected are detected by Spycer automatically.
They are read from the currently active network
connections of your system. If there is more
than one network connection available, you
can select between them via their IP addresses.

5| Under Windows you can gather the IP
1 address of a network port via the net-
work connection icon in the system
tray of the Windows task bar.
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REFRESH

This button refreshes the |IP addresses available
in the drop-down list. IP addresses are gath-
ered from currently active network connec-
tions. When a network connection is inactive
(e.g. no cable connected), its IP address will
not be displayed in the drop-down list. Then es-
tablish a network connection at the respective
connector and click the REFRESH button. This
will make its IP address available in Spycer. Ad-
ditionally available is the localhost address
(127.0.0.1) to disable the network connection
for Spycer and run it locally only.

entry field
"hostname’

In this entry field type in the name that should
be used for your system when appearing in the
SpycerNet. You can assign any name you want
(special characters as well). To take the entry
into effect, you have to press the button SET
HOSTNAME.

o To apply the network configurations,
1| vou have to press the button APPLY

NETWORK SETTINGS before pressing

the button

Compatibility mode
in Spycer

For downwards compatibility to Spycer ver-
sions prior 1.4 you can activate this check box.
In this case some network ports have to be free
and available to connect successfully to the
SpycerNet. Otherwise Spycer will be confined
to its localhost only (IP address 127.0.0.1 has to
be used). The respective network ports are in-
dicated on the screen.

Multicast/unicast
range:

Use the entry fields in this area to configure the
network ports. If you want to establish a multi-
cast connection, enter the group and the port.
If you want to establish an unicast connection,
enter the ports ID’s between which a link is to
be set up. To verify your settings, click the but-
ton APPLY NETWORK SETTINGS.

Background service
status message

Details the current state of the background pro-
cess SpycerAgent.
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Enable local con-
tent management
(SpycerAgent)

With this radio button activated the local con-
tent management will be enabled. It installs
and starts the background process
SpycerAgent allowing you to view local drives
and search through the material stored in the
watch folders. For this a database is written
that is used by the Spycer user interface to dis-
play data. Additionally it is visible and usable
for other Spycer applications in the SpycerNet
(if applicable and permissions are given). With-
out a local content management enabled
Spycer will not display any local drives or stor-
ages nor observe any locally stored content.
Then the user interface can be used as a net-
work browser only, i.e. it will display data pro-
vided by other Spycer applications via the
SpycerNet only.

ADVANCED...

The background process SpycerAgent may not
be able to access drives that need a particular
user account (usually administrative account).
Background processes generally run with the
security context of the local system account
which is a predefined account used by back-
ground processes. To enable accesses of the
SpycerAgent to specially secured locations, en-
ter the appropriate user name and password (if
applicable) in the window that opens when the
ADVANCED... button is pressed. On a SAN this
is normally not necessary when a global super
user is configured on the metadata server.

Use these settings only if you experi-

ence access permission issues that
can be traced back to the
SpycerAgent.

Windows only: For this make sure that
the respective user has the right to ful-
ly access the background process
(see Administrative Tools » Local
Security Policy » Local Policies »
User Rights Assignment » Log on
as a service).

Disable local con-
tent management

This radio button disables the local content
management. It will stop and deinstall the
background process SpycerAgent. Then
Spycer can be used as a network browser only,
showing you the contents of other Spycers in
the SpycerNet.
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For further details about the SpycerAgent please refer to sec-
tion “SpycerAgent” on page 2-5. For further details about net-
working see section “Notes about Networking with Spycer” on

page 2-7.

9.1.8 The Group ‘Ingest Folders’

With this group you enable special workflows like P2 Ingest and Pro-
fessional Disk Ingest. How to work with these features is described in
section “File Ingest” on page 7-23. After having connected the respec-
tive external drive, e.g. a P2 card reader, enable the workflow in the
group Ingest Folders:

Wbl T
Datarate
File Tra

e . -

| Disk Ingest

Figure 9-11: The group ‘Ingest Folders’

P2 Ingest

With this check box activated, externally connected
P2 storage devices will be loaded and their content
made available as VAMC data on your local Spycer.
This will be visible as an P2 Ingest icon in the direc-
tory tree of the browse and search area.

Professional
Disk Ingest

With this check box activated, externally connected
XDCAM storage devices will be loaded and their

content made available as VAMC data on your local
Spycer. This will be visible as an XDCAM Ingest icon
in the directory tree of the browse and search area.
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9.1.9 The Group 'Jobs’

The group Jobs contains some settings concerned with jobs per-
formed by the SpycerAgent, most notably the proxy file settings.

5 oo . — -
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Figure 9-12: The group ‘Jobs’

In detail the group Jobs provides the following settings items:

Proxy file settings:

Path for proxy | Determines the location on the storage where the
files: proxy files will be stored. At this location the direc-
tory structure of the watch folders where the clip is
originally stored is reproduced which makes an
identification of the proxy clips easy.

. Temporarily downloaded proxy clips are
l not stored here but in one of the system
folders (see section “Interesting Files and
Folders” on page A-14).

9-16



The Menus

Preview prox-
ies

Activates the proxy generation. When the check
box is activated, proxies can be generated on your
system. Then the configuration items for the proxies
will be available and can be set. If the check box is
disabled, a proxy creation cannot be performed on
your system.

Path contains
mount point
prefix

This setting will be available when Preview proxies
is enabled.

When the setting Path contains mount point pre-
fix is enabled, the destination path on an e.g. DVS-
SAN system will include all elements, comprising
those parts dependent from operating systems. This
can be a problem when several different systems
have access to a shared storage with proxy files.
Disable this check box to exclude all prefixes in the
destination path for proxies that are operating sys-
tem dependent and facilitate access to shared stor-
ages for different systems.

Resolution Details the resolution of the proxies in width and
height (in pixels). This setting will be available when
Preview proxies is enabled.

File format Select from this drop-down list the file format of the

container file that will be used to create the proxies.
This setting will be available when Preview proxies
is enabled.

Scaling quality

For the proxy generation you can select between
three scaling qualities. It also effects the speed of
the creation. For example, the setting high will
yield the best quality but will also take longest to
process. This setting will be available when Preview
proxies is enabled.

Default frame
rate

Sets the default frame rate of the proxy files. This
setting will be available when Preview proxies is
enabled.

Automatic
proxy file gen-
eration

When this check box is enabled, proxy files are gen-
erated automatically on your system as soon as new
clips are detected by the SpycerAgent.

If it is disabled, proxies can only be created manual-
ly with the menu option Create proxy (see section
“The Context Menus” on page 9-28). This setting

will be available when Preview proxies is enabled.
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Defragmentation & de-scattering:

Automatic de-
fragmentation
when copy

With this check box you configure the Spycer appli-
cation to perform a defragmentation automatically
on the processed material when a copy process is
started on your system. This will be valid even if the
job is triggered by another Spycer in the SpycerNet.

Automatic de-
fragmentation
when move

With this check box you configure the Spycer appli-
cation to perform a defragmentation automatically
on the processed material when a move process is
started on your system. This will be valid even if the
job is triggered by another Spycer in the SpycerNet.

Use file
preallocation
during copy
process

With this check box activated, Spycer automatically
preallocates storage space on the target drive for
copy processes. This prevents data fragmentation
even if multiple copy processes are running in par-
allel. The data file's name will be displayed with the
suffix ‘preallocated’ in the job list, which will disap-
pear again after finishing the copy process.

Automatic paus

ing:

Pause for local
real-time pro-
cesses (DVS
systems only)

The automatic pausing for DVS real-time processes
is configurable. If it is not necessary to pause, e.g.
copy jobs during timeline scrubbing or playout op-
erations, you can switch off this automatic pausing
feature.

Drag and Drop

Ask before
copying or
moving con-
tent.

To avoid copying due to unintended drag 'n’ drop
operations, you can enable this check box. When a
copy process is initiated, a warning message will be
displayed in a separate window. This can be dis-
abled by clicking the check box again.

Data Movement:

Verify transfer
data

With this check box activated, Spycer automatically
performs a verification of the transferred data by
comparing the transferred material with the source
material using MDb check sums. If the calculated
check sums of one or more files are not equal, a
warning message will be displayed. Furthermore,
the report (see section “The Job List” on page 7-15,
context menu Show Report) will contain detailed
information about the whole process including the
verification.
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Verify commu-
nication port:

For interoperability with firewall settings, a desig-
nated port for verification commmunication between
the Spycer clients can be set. Enter the port ID into
this entry field when the Verify transfer data check
box is activated.

Repair corrupt
transfer data

If the verification encounters errors after checking
the transferred data, Spycer will automatically repair
the corrupted files after the verification has finished.
You will find the results in the report (see section
“The Job List” on page 7-15, context menu

Show Report).

9.1.10 The Group 'Network Drives’ (Windows Only)

The group Network Drives is available under Windows operating sys-
tems only and enables you to access mounted (mapped) network
drives in the user interface of Spycer. They are then displayed as any
other locally available drive/directory that is not defined as a watched
folder (see section “The Directory Tree” on page 5-3) and can be ac-
cessed as such (see section “SpycerAgent” on page 2-5).

F d:

]

Figure 9-13: The group ‘Network Drives’
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The group Network Drives provides the following items:

list

The list details the network drives that are cur-
rently mounted in your operating system. The
column 'Drive’ details the drive letter, while the
column ‘Source Path’ indicates the path to the
drive/directory in the network.

Mount network
drives

This check box mounts the network drives de-
tailed in the list above and, once confirmed,
they will be displayed in Spycer. For this you
have to enter the correct password that allows
you access to the network drives in the entry
field Password below.

The network drives will also be mounted the
next time Spycer is started. However, then a
message window will appear right after the
starting of the user interface where you have to
legitimize your access again, i.e. you have to
enter the correct password once more:

¢ Network Drive Mounting

Mount [Don't mount

Figure 9-14: Accessing network drives
auring start-up

User Details your current user name that will be
used to mount the network drives.
Password In this entry field you have to enter the correct

password that in combination with the user
name allows you to access the network drives.
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9.1.11 The Group 'Permissions’

With the group Permissions you set the remote access permissions,
i.e. you configure a remote control of your Spycer application. It may
be useful if other Spycer applications in the SpycerNet should have ac-
cess to your system, and with these settings you determine what other
peers are allowed to do on your system.

oo . -

Birc
Edit Metadata

Figure 9-15: The group ‘Permissions’

The following settings items are provided:

User & Groups | In this pane select the user or group that you want
to specify the remote access permissions for.

° Currently only the default user group is
1 | available.

Remote Access Permissions

Browse & Other Spycer applications can browse your data
Search and perform searches. If a proxy clip of a video clip
is available on your system, other Spycer applica-
tions can download it for a preview.

Edit Metadata | If this check box is enabled, other Spycer applica-
tions can edit the metadata of your material on your
system, including the header data of *. dpx image
sequences.

Read Essence | This setting allows the reading of data on your sys-
tem, for example, for copying processes. To allow
for a remote defragmentation or proxy clip genera-
tion, this check box has to be activated as well.
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Write Essence | This setting allows the writing of data on your sys-
tem, for example, for copying processes. To allow
for a remote defragmentation or proxy clip genera-
tion, this check box has to be activated as well.

Buttons

SELECT ALL This button enables all check boxes in the pane Re-
mote Access Permissions in one step.

DESELECT ALL This button disables all check boxes in the pane Re-
mote Access Permissions in one step.

The browse and search permissions enable others to take a look at your
data and metadata, i.e. they have access to the database administered
by the SpycerAgent. However, with only this permission given they
cannot change the contents of your database nor have they a real ac-
cess to your system: They see the contents of the database only and, if
available on your system, can download proxy clips.

With the 'Edit metadata’ permission activated you enable others in the
SpycerNet to change metadata entries of the files in your watched fold-
ers (file headers as well as database entries). This permission includes
the browse and search permission but still a real access to your system
is denied.

All other permissions enable them to control your SpycerAgent for file
related tasks such as a copying or defragmentation. This is meant by
remote controlling other Spycers. For moving or copying operations
you must have at least read permission on the source system and write
permission on the target system. Nevertheless, real damage can only
be done with the write permission, because with it you can, for exam-
ple, rename file sequences or delete data.

. Other Spycer applications have access to the material in your
l watched folders only (see section “SpycerAgent” on

page 2-5). To allow other Spycer applications to defragment
data on your system, both read and write permissions have to
be given.

For further information about these settings see section “Notes
about Networking with Spycer” on page 2-7.

9.1.12 The Group 'Scan Filter’

9-22

Video material is often stored not in a single file, but in numerous indi-
vidual image files gathered in one directory, where one file on the stor-
age equals one frame of video. These image sequences will be
displayed by Spycer as a single entry, i.e. as one video clip. By default
the Spycer application treats all file formats as sequence files.

The group Scan Filter allows you to determine file formats that should
not be displayed by Spycer as image sequence files, even if their file
names are identical and contain a numbering. It sets a filter for the
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scanning process of the SpycerAgent. The scanning process of the

SpycerAgent treats all

file formats as potential image sequence files.

Thus, when files are stored in one directory with identical names (e.g.
prefixes) and a numbering (frame number), they will be displayed as a
video sequence, i.e. generate a single entry in the database and be dis-
played in Spycer with a single entry as well. To avoid this, you can de-
termine the file formats that Spycer should display file by file, even if

their file names are identical and contain a numbering. The most com-
mon file formats that should be displayed file by file are already pre-

defined.

an Filter
Folders

The following settings

if their

& markup language file

’

Figure 9-16: The settings items of the group "Scan filter

items are provided by the group Scan Filter:

list

The list determines the file formats by their ex-
tensions (column 'Format’) that Spycer should

not try to recognize as video clips. The entries

can be revised by simply double-clicking an en-
try and altering it.

ADD

This button adds an empty entry in the list
above. Then type in the extension of the file for-
mat that Spycer should observe file by file.

REMOVE

This button deletes entries from the list: Select
an entry in the list and delete it by clicking the
button REMOVE.
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9.1.13 The Group 'Watch Folders’

9-24

With the settings items of the group Watch Folders you determine the
locations on your local storage that should be searched for video and
audio material by the SpycerAgent (see section “The Group 'General”
on page 9-11) and afterwards be monitored for file movements. All data
found in these volumes/directories will be written into a database ad-
ministered by the SpycerAgent. The contents of the database is then
displayed in Spycer and available for search procedures. Additionally, it
is the database that will be visible to other Spycer in the SpycerNet if
browse and search permissions are given (see section “Remote Access
Permissions” on page 1-3). This happens if the drop-down lists in the
column Indexing are set to ‘on’. If Indexing is set to 'off’, the folders
are shared in the SpycerNet without scanning (indexing) them in ad-
vance. When using this feature, the metadata will not be stored in the
database, in order to prevent time-consuming indexing processes.

o A viewing or reading of contents on other drives or directories
1 on your system (local reading including that of mounted net-
work drives) is still possible with Spycer. With a local content
management enabled, the application displays all data locally
available when selected in its browser. However, because the
contents of these locations are not scanned and indexed in the
database, they are read when accessed only and neither will a
search with Spycer include these locations nor will they be vis-
ible in the SpycerNet.

Network drives and important system drives/directories cannot
be selected as watch folders.

The SpycerAgent registers all events that take place in the
watch folders. To minimize the overall traffic for the
SpycerAgent, it is recommended to include directories/drives
that contain video/audio material only.
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File Trans
FT
neral
Fal

L]

an Filter
Folders

Indexing

Figure 9-17: The group ‘Watch Folders’

To set up the watch folders, the following settings items are provided:

list box

The list details the specified folders (column
"Path’), whether they are included or excluded
in the watched folders ("Type’) and the current
state of the included folders ('Status’).

INCLUDE FOLDER...

This button opens a dialog window where you
have to select a directory. Choose with it the
drive/directory that should be included in the
watched folders. Normally this will be the local
drive or directory where the video data is
stored. Of course, you can add more than just
one folder to this list in case your data is distrib-
uted over several drives/directories. For exam-
ple, CLIPSTER or VENICE by DVS usually use
the local drive V:/ to store video and audio data.
So the drive V:/ should be added to the list box
above via the INCLUDE FOLDER... button.

9-25




Spycer User Guide

9-26

Network drives and important system
drives/directories cannot be selected
as watch folders.

i @

The SpycerAgent registers all data
(even unknown files) as well as all
events that take place in the watch
folders. To minimize the size of its da-
tabase and the overall traffic for the
SpycerAgent, it is recommended to
include directories/drives that contain
files of formats supported by Spycer
only (see section section “Supported
File Formats” on page A-6).

EXCLUDE FOLDER...

Excludes a drive/directory from being displayed
in Spycer. Usually the exclusion of a specific di-
rectory is made to save it from being scanned
into the database (as a subdirectory of an in-
cluded folder). However, with this you can ex-
clude any drive/directory whereupon they will
not be displayed in Spycer. A click on this but-
ton opens a dialog window where you can se-
lect the drive/directory that should be
excluded. Nevertheless, other drives/directo-
ries can be excluded as well whereupon they
will not be displayed in Spycer at all.

REMOVE

The included and excluded folders can be re-
vised with this button: Select an entry in the list
and delete it by clicking the button REMOVE.
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The list provided by the group Watch Folders implicitly details three
states of the folders if a local content management is enabled. The fol-
lowing shortly summarizes their effects:

State of
Watched Folder Effect
included — Scanned by the background process and

written to the database

— Displayed almost instantaneously in the user
interface

— Can be searched with Spycer

— Displayed and usable in the SpycerNet (if
applicable and permissions are given)

not detailed in list | — Other local drives and directories

— Not scanned by the background process and
not written to the database

— Displayed in Spycer only when accessed

— Not displayed in the SpycerNet

— File-based processes are allowed

excluded — Not scanned by the background process and
not written to the database

— Not displayed in the user interface of Spycer
or the SpycerNet
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9.2 The Context Menus
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The context menu of the browsing pane (usually invoked with a right-
click of the mouse or when pressing [F2] with the mouse cursor posi-
tioned over the directory tree) provides different directory and file relat-
ed functions, such as the deletion of a directory and/or file.

o Depending on whether the context menu is invoked in a direc-
1 tory tree or in a contents area it may provide different menu
options.

You can invoke further context menus, when right-clicking, for
example, the video overlay (see section “The Video Overlay”
on page 6-4), the job list (see section “The Job List” on

page 7-1b) or the record scheduler (see section “User Inter-

face in the Record Scheduler Mode” on page 4-6).

Fename...
Scan metadata
Crefragment
Create metacli
Wian

Froperies...

Figure 9-18:

Open with

Ctrl+C

Cirl+ns

Lel
Mew folder..

Rename...

Scan metadata

=

mport metadata
Lefragment

Create metaclip(z)

Edit ive metadata...

Wi ey

Froperties...

Context menu of directory tree (left side) and contents area (right side)
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The context menu of the directory tree provides the following func-

tions:

Open in new

When right-clicking a peer or folder in the direc-

window tory tree and selecting this menu option, a further
window will open up showing the directory tree
and the respective contents area belonging to it.

Show all content | Initiates a search for all data available at the se-

lected location and displays it in the results area
(subdirectories are searched as well, see section
“The Results Area” on page 5-13).

o Actually this option performs a search
l for the respective directory (search
string) in the criteria File Path. Asa
result you receive all entries in the data-
base that contain the searched for string
in their file paths.

Move to folder...

Moves the selected directory/file(s) to another lo-
cation. When activated, it will open a dialog win-
dow where you can select a new storage location
in the network.

s ) Adirect moving of directories/files in the
1 SpycerNet is not possible. Within the
network directories/files can be copied
only.

Copy

Copies the selected directory/file(s) to the clip-
board of the operating system. You can use
[Ctrl + C] to select this option as well.

Paste

Pastes the contents of the clipboard (see Copy) at
the currently selected location. You can use
[Ctrl + V] to select this option as well.

Delete

After the confirmation of a warning message, this
menu option deletes the selected directory/file
from the storage. You can use [Del] to select this
option as well.

This menu option deletes the selected
directory/file physically from the stor-
age. Itis directly deleted and there is no

undo functionality or recycle bin avail-
able to restore the data.

New folder...

Creates a new subdirectory at the currently se-
lected location. This menu option opens a dialog
window where you have to enter the name of the
new directory. After confirming the name with
the button OK, the directory will be created.
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Rename...

Changes the name of an already existing directo-
ry/file. It opens a dialog window where you have
to enter the new name. After confirming the
changes with the button OK, the directory/file
will be named accordingly. You can use [F2] to se-
lect this option as well.

o When called for a video clip whose
] | frames consist of still images, it will
open the renaming tool for clips (see
section “Renaming” on page 7-2).

Scan metadata

Use this menu option to rescan the currently se-
lected drive/directory and refresh its entries in the
database. Any virtually added metadata such as
the production metadata will be retained. You can
use [F7] to select this option as well.

Refresh This menu option refreshes and updates the view
of the currently selected drive/directory.
Defragment Initiates a defragmentation of the currently se-

lected file, directory or drive. Further information
about this can be found in section “Defragment-
er” on page 7-4.

Create meta-
clip(s)

When you select this menu option, Spycer cre-
ates a metaclip or several metaclips from the
file(s) in the selected folder. For further informa-
tion see section “Metaclips” on page 7-28.

View

The menu option View enables you to configure
which items to see in the directory tree and/or the
contents area.

When invoked on the directory tree, it shows the
menu option Hide unwatched folders. \\ith it
you can hide all drives/directories, that are not
watched by the SpycerAgent. Once the menu op-
tion is activated, it shows a cross in frontand only
the watched folders will be displayed in the direc-
tory tree.

Properties...

With this menu option you can call up the proper-
ties of the file, directory or drive where the con-
text menu was invoked. They will be shown in the
properties window. Further information about
this can be found in section “The Properties Win-
dow"” on page 9-34.
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The context menu of the contents area provides the following func-

tions:

Open with

Available on the local peer only. This menu option
provides a submenu where you can select be-
tween several possible applications to open the
currently selected file with. You can, for example,
open the file in the standard file manager of your
operating system (Mac and Windows only) or in
the application that is configured as the default
application for this file format (menu option De-
fault).

Show all
metadata

Performs the same operation as a double-click on
a file in the contents area: The file is singled out
and is displayed in the metadata and preview ar-
ea.

Open in new win-
dow

When right-clicking a file in the contents area and
selecting this menu option, a further window will
open up showing the directory tree and the re-
spective contents area belonging to it.

Show in browser

Available for the results area after a search only.
Shows the selected file in the browse area of
Spycer thereby displaying its location.

Save as TXT... Available for the contents area only. Saves the
text information of the files currently selected in
the contents area to an ASCII file.

Select all Available for the contents area only. Selects all

files available in the contents area.

Move to folder...

Moves the selected directory/file(s) to another lo-
cation. When activated, it will open a dialog win-
dow where you can select a new storage location
in the network.

s ) Adirect moving of directories/files in the
1 SpycerNet is not possible. Within the
network directories/files can be copied
only.

Copy to folder...

Copies the selected directory/file(s) to another lo-
cation. When activated, it will open a dialog win-
dow where you can select a new storage location
in the network.

Copy

Copies the selected directory/file(s) to the clip-
board of the operating system.

Paste

Pastes the contents of the clipboard (see Copy) at
the currently selected location.

9-31




Spycer User Guide

9-32

Delete

After the confirmation of a warning message, this
menu option deletes the selected directory/file
from the storage.

This menu option deletes the selected
directory/file physically from the stor-
age. It is directly deleted and there is no

undo functionality or recycle bin avail-
able to restore the data.

New folder...

Creates a new subdirectory at the currently se-
lected location. This menu option opens a dialog
window where you have to enter the name of the
new directory. After confirming the name with
the button OK, the directory will be created.

Rename...

Changes the name of an already existing directo-
ry/file. It opens a dialog window where you have
to enter the new name. After confirming the
changes with the button OK, the directory/file
will be named accordingly.

s ) YWhen called for a video clip whose
l frames consist of still images, it will
open the renaming tool for clips (see
section “Renaming” on page 7-2).

Scan metadata

Use this menu option to rescan the currently se-
lected drive/directory and refresh its entries in the
database. Any virtually added metadata such as
the production metadata will be retained. You can
use [F7] to select this option as well.

Refresh

This menu option refreshes and updates the view
of the currently selected drive/directory.

(Re) Import me-
tadata

This option refers especially to P2 or XDCAM files
carrying their own metadata files additionally to
the Spycer metadata file. When changing the me-
tadata in the format's metadata file, use this op-
tion to import or reimport the metadata from the
format’s metadata file to the metadata file in
Spycer.

Defragment

Initiates a defragmentation of the currently se-
lected file, directory or drive. Further information
about this can be found in section “Defragment-
er” on page 7-4.

Create meta-
clip(s)

When you select this menu option, Spycer cre-
ates a metaclip or several metaclips from the se-
lected file(s) in the contents area. For further
information see section “Metaclips” on

page 7-28.
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Create proxy

Available for the contents area and video clips on-
ly. Creates a proxy of the currently selected video
clip. Then the proxy clip is created on the system
where the clip resides. Afterwards, you can use it
to view the video clip in real time.

. To create a proxy, you must have read
1 and write permissions on the respective
system and the native Spycer applica-
tion must be appropriately configured
for the creation of proxies.

Further information about proxies and
the previewing of proxies can be found
in section “Previewing Data with the
Preview Area” on page 6-3.

Convert...

Available for the contents area and video/image
files only. Opens the file format conversion tool of
Spycer to convert the selected video clip or still
image to another file format. Further information
about this can be found in section “File Format
Converter” on page 7-10.

Edit descriptive
metadata...

Opens another window with drop-down lists and
entry fields to edit the descriptive metadata of the
selected content. For further information see sec-
tion “Descriptive Data” on page 8-10.

View

The menu option View enables you to configure
which items to see in the directory tree and/or the
contents area.

When invoked in the contents area, it shows
Show folders. This menu option allows you to
view directories in the contents area. Once acti-
vated, it shows a cross in front and directories
available at the selected location will be displayed
in the contents area as well.

Properties...

With this menu option you can call up the proper-
ties of the file, directory or drive where the con-
text menu was invoked. They will be shown in the
properties window. Further information about
this can be found in section “The Properties Win-
dow"” on page 9-34.
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9.3 The Properties Window

9-34

With the menu option Properties... in the context menu of a file, direc-
tory or drive visible in the browse and search area (see chapter “Soft-
ware Reference” on page 4-1) you can call up the properties of the
respective item. They will be shown in the properties window:

o e S |-

Figure 9-19: Examples of ‘Properties” windows

This window shows cumulated sizes, the number of files in the folders
as well as the current owner of the folder. The Information about own-
ers of files will be stored in the database and can also be used for
search queries in the SpycerNet. Any old database information can be
easily updated by rescanning the required folders.

However, depending on the data type of the item where the properties
are called, the properties window will look differently beneath these in-
formation and provide other details:

Data Type(s) Shown Properties

systems When called on systems, the properties will detalil
further information about this system, such as its
hardware, operating system, the Spycer version
running, and the permissions that you have on the
respective system.
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Data Type(s)

Shown Properties

volumes
directories

When called for volumes or directories, you find
further details about the storage where the item is
located as well as about its capacity. Detailed are,
for example, the free, used and total disk space in
binary multiples of their sizes (binary prefixes). Ad-
ditionally, time values are provided to show you,
for instance, the amount of free space available
for a record of video. Because these depend on a
video raster, you can configure raster settings in
this view of the properties window as well. The
time values of the disk spaces will be changed ac-
cordingly:

Calar Made

Frame Rate 20 Hz

Figure 9-20: Time calculation settings for disk
spaces

Furthermore, a bar is available that tells you
graphically as well as via a percentage value the
amount of disk space currently used on the drive
where the item is stored.

. Storage capacities are indicated as they
l are truly available, meaning they are de-
tailed without the deduction of a safety

margin necessary to ensure the real-time
capability on a DVS video system.

files
clips

When called for files or video clips, the properties
window will provide various metadata information
in a table, such as file size, file name and its for-
mat. Additionally, depending on the type of file, it
may as well detail such things as number of audio
channels, audio samples, color mode, aspect ra-
tio, field mode, resolution, and so on.

i @

When accessing properties of items on other systems in the
network, question marks ('?’) may appear instead of proper-
ties. Then give Spycer time to update the information. During

this the properties window may remain open and once the data
has been gathered they will be displayed.

The properties window can be closed at any time with the button
CLOSE at the bottom of the window.
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Appendix

This chapter provides further information about the Spycer application.
First some information are given about how to resolve irregularities that
may occur when using Spycer and the supported file formats are listed.
Furthermore, you find information about some interesting files and

folders installed or created by Spycer, all available keyboard shortcuts
and maintenance.
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A.1 Troubleshooting

This section details some errors and their solution which may occur
when using Spycer. First some general errors and solutions will be de-
tailed, followed by a special troubleshooting that may be necessary
when installing Spycer under the Windows Vista operating system.

A.1.1 General Troubleshooting

The table below lists some errors that may occur during the operation
of Spycer and details how to resolve them:

Error

Cause

Solution

The Spycer software
does not accept the li-
cense file, i.e. Spycer
runs as Spycer Basic al-
though a license has
been uploaded.

Maybe changes have
been made to the e-mail
while making a license
file request.

Contact the DVS service department and
make a second license file request from the
respective client (see section “The License
File” on page 2-9).

Spycer runs as Spycer
Basic although a license
is available.

The CodeMeter applica-
tion is not installed.

The CodeMeter application has to be in-
stalled on both ends, the system that dis-
tributes the licenses and the systems that
should receive them (see section “Installing
the Software” on page 3-2).

Especially for Linux and Mac OS the Code-
Meter installation is mandatory.

Spycer runs as Spycer
Basic although a dongle
with floating licenses on
it is connected.

Your license was avail-
able for evaluation rea-
sons only and has
expired.

Get a new non-expiring license from DVS
(see section “Licensing” on page 2-9).

The dongle has been
plugged in after the user
interface was started.

See section “How to Connect the Dongle to
a Running Computer” on page 2-13.

After a software update
Spycer runs as Spycer
Basic.

The license does not fit
to the major software re-
lease.

Please update the license performing the
steps as described in section “Licensing”
on page 2-9.

A-2
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Error

Cause

Solution

No systems/folders are
displayed in the directory
trees of the browsing
panes, i.e. neither are lo-
cal drives/folders dis-
played nor network
systems/folders.

Spycer is configured to
localhost and the local
content management is
disabled.

With Spycer running alter the network con-
figuration settings from localhost
(127.0.0.1) to the IP address of the network
connection that is connected to the net-
work and/or enable the local content man-
agement (see section “The Group
'General'” on page 9-11).

The SpycerAgent is not
running.

Either close and afterwards re-start the user
interface of Spycer, or use the SpycerAgent
tool to get the background process started
(see section “The SpycerAgent Tool” on
page A-18).

Some network ports are
closed.

Some network ports have to be free and
available to connect successfully to the
SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address
127.0.0.1 has to be used). For further infor-
mation about this please see section “Im-
portant Notes” on page 1-9.

No network systems are
displayed in the directory
tree of a browsing pane.

The network/system
drop-down list is set to
display the drives/direc-
tories of the local system
only.

Set the network/system drop-down list to
Network (see section “The Directory Tree”
on page 5-3).

There are no other
Spycers running in the
network.

Either start or install Spycer on another sys-
tem connected to your network and config-
ure it for the SpycerNet accordingly (see
chapter “Getting Started” on page 3-1).

The local Spycer is con-
nected to the wrong net-
work or configured to
localhost (127.0.0.1).

With Spycer running alter the network con-
figuration settings: Select the proper IP ad-
dress of the network port connected to the
network where other Spycer applications
are present (see section “The Group 'Gener-
al"” on page 9-11).

Some network ports are
closed. May be the
cause when no local
drives are displayed as
well.

Some network ports have to be free and
available to connect successfully to the
SpycerNet. Otherwise Spycer will be con-
fined to its localhost only (IP address
127.0.0.1 has to be used). For further infor-
mation about this please see section “Im-
portant Notes” on page 1-9.




Spycer User Guide

ﬁ

Error

Cause

Solution

A network system is visi-
ble but provides no data/
you cannot access the
data.

The appropriate permis-
sions are not given.

The system takes part in the SpycerNet as
well as performs a local content manage-
ment but browse and search permissions
are not given. Allow at least a browsing and
searching on the system (see section “The
Group 'Permissions’” on page 9-21). You
can view what permissions are given for the
respective peer in the properties window
(see section “The Properties Window"” on
page 9-34).

The data is write-protect-
ed.

Remove the write protection from the file
on the respective peer.

A contents area of the
browse and search tools
does not show the want-
ed material.

The required data is not
stored in the selected di-
rectory.

Move, copy or capture the required data to
this directory.

The selective view drop-
down list is set to a se-
lective viewing.

Set the selective view drop-down list to the
kind of data that you want to display or to
All Files (see section “The Status Bar”
on page 5-9).

Some files (e.g. *.mov)
require the installation of
third-party programs.

Install the third-party program (see section
"System Requirements” on page 1-8) such
as the QuickTime player.

You receive an error
message when copying
(moving) data.

You tried a copying be-
tween different systems
in the network.

For copy procedures the Spycer application
running on the foreign system must be set
to the appropriate access rights (read per-
missions). Otherwise a copy process will
not be possible. Set the access permissions
of the Spycer application on the other sys-
tem appropriately.

You tried to copy/move
data to a specially se-
cured location (e.g. on
an SNFS storage).

Access to storage locations may be restrict-
ed. To enable accesses of the SpycerAgent
to these locations, you have to enter the ad-
ministrative access permissions via the Ab-
VANCED... button available in the watch
folder configuration settings (see section
“The Group 'Watch Folders'” on

page 9-24).

i @

A-4

To troubleshoot license issues, the ’About Spycer’ window
provides further details about the license currently assigned to
your application (see "About’ in the table on page 4-17).
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A.1.2 Troubleshooting under Windows Vista

When running Spycer under the Windows Vista operating system,
some particularities have to be observed:

1. | After installing Spycer, you have to manually free the network
ports to connect successfully to the SpycerNet in the installed
firewall (see section “Important Notes” on page 1-9).

2. | If you experience problems with Spycer (e.g. some configuration
settings are not available to configure the application), try to run
it as the administrator:

o |f appropriate, close the Spycer user interface.
s Call up the context menu of the Spycer icon on the desk-
top of Windows (right mouse button).
s Select the menu option Run as administrator.
This will run the Spycer application with administrator rights.

A-5
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A.2 Supported File Formats

Spycer supports over 100 graphic and image file formats. Most are
made available by a special library. For a list of all these file formats see
http://perso.orange.fr/pierre.g/xnview/
enformats.html.

The tables in the following list an excerpt of the file formats that are sup-
ported by Spycer directly. They are listed according to their file types:
First the video file formats are detailed, then the audio file formats and
last but not least a list of all other file formats supported by Spycer is

given.

. To be displayed in Spycer, some file formats, such as the
1 * . mov file format, may require the installation of third-party
programs (e.g. the QuickTime player, see section “System Re-

quirements” on page 1-8).

Table A-1: Supported video file formats

4 x 8 bit RGBA

Default .
Format File storage o
Exten- Description
Name sion format

ARRIRAW *.ari 12 bit raw (uncom- | Raw 12 bit file formats developed by the

pressed) ARRI Group for on-camera recordings.

BMP * . bmp 3 x 8 bit RGB Windows bitmap format. Only uncompres-
sed bitmaps are supported (no RLE com-
pression).

Cineon' *.cin 3 x 10 bit RGB 10 bit RGB format. Subset of the ANSI/
SMPTE DPX file format. Flexible file format
by Kodak, allowing for variable image head-
ers.

DPX!- 2 * . dpx 3 x 8 bit RGB and 8 bit RGB file format with or without key.

SMPTE Standard File Format for digital mov-
ing-picture exchange.

8 bit YUV422 and
YUVA4224

8 bit YUV file format with or without key.
SMPTE Standard File Format for digital mov-
ing-picture exchange.

3 x 10 bit RGB and
4 x 10 bit RGBA

10 bit RGB file format with or without key.
SMPTE Standard File Format for digital mov-
ing-picture exchange.

10 bit YUV422 and

10 bit YUV file format with or without key.

YUVA4224 SMPTE Standard File Format for digital mov-
ing-picture exchange.
3 x 12 bit RGB 12 bit RGB file format. SMPTE Standard File

Format for digital moving-picture exchange.

3 x 16 bit RGB and
4 x 16 bit RGBA

16 bit RGB file format with or without key.
SMPTE Standard File Format for digital mov-
ing-picture exchange.
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Table A-1: Supported video file formats (cont.)

Default .
Format File storage o
Exten- Description
Name . format
sion
JPEG *.jpg 3 x 8 bit RGB 8 bit RGB file format of the Joint Photograph-

* . jpeg ic Experts Group. Images are usually stored
with lossy compression.

JPEG2000 *.7p2 3 x 12 bit RGB 12 bit RGB file format. Flexible data and still

*.j2c image compression standard operating ei-

*.j2k ther compressed or uncompressed.

*-Jpe 3 x 16 bit RGB 16 bit RGB file format. Flexible data and still
image compression standard operating ei-
ther compressed or uncompressed.

3 x 12 bit XYZ 12 bit XYZ file format. Flexible data and still
image compression standard operating ei-
ther compressed or uncompressed.

OpenEXR *.exr 3 x 16 bit RGB 16 bit RGB high dynamic range file format

4 x 16 bit RGBA with or without key, operating either com-
pressed or uncompressed. For reading, vari-
ous other (color) channels are supported as
well.

SGl *.5g1 3 x 8 bit RGB 8 bit RGB file format. SGI IRIX image format.

*.rgb 3 x 16 bit RGB 16 bit RGB file format. SGI IRIX image for-
mat.

TGA *.tga 3 x 8 bit RGB and Targa image format.
4 x 8 bit RGBA, un-
compressed
TIFF *.tif 3 x 8 bit RGB and TIFF or Tagged Image File Format in 8 bit

* . tiff 4 x 8 bit RGBA RGB with or without key. Highly flexible and
platform-independent image format. Not all
variants of this format are supported by DVS.

3 x 16 bit RGB and | TIFF or Tagged Image File Format in 16 bit

4 x 16 bit RGBA RGB with or without key. Highly flexible and
platform-independent image format. Not all
variants of this format are supported by DVS.
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Table A-1: Supported video file formats (cont.)

Default -
Format File storage o
Exten- Description
Name . format
sion
yuv *.qnt 8 bit YUV422 and Raw 8 bit YUV422 and YUVA4224 format.®

*.qtl YUVA4224 This file has no header. The image format is

*.yuv recognized by the file size. This is done with

*.yuvs8 a table of predefined file sizes. Component
order UYVY.

* . yuvlo 10 bit YUV422 and | Raw 10 bit YUV422 and YUVA4224 format.

YUVA4224 This file has no header. The image format is
recognized by the file size. This is done with
a table of predefined file sizes. Component
order UYVY. Bits are packed tightly from left
to right for three component samples, then
two bits of padding (zero) to fill up to four
bytes. The lines are padded to a multiple of
four bytes. The file is padded to a multiple of
512 bytes.

*.yuvlé 16 bit YUV422 Raw 16 bit YUV422 format.* This file has no
header. The image format is recognized by
the file size. This is done with a table of pre-
defined file sizes. Each component is stored
as a 16 bit value in big-endian byte order
(left-aligned). Component order UYVY.

1) DVS saves files of this format by default in big-endian byte order. However, for a playout
both formats (little- and big-endian byte order) are supported.

2) Regarding the file type: V2 is the DPX file format according to SMPTE 268M-2003, the
remaining (V1) are SMPTE 268M-1994. 'b.e." stands for big endian, 'l.e.’ for little endian.

3) 8 bit YUV422 and YUVA4224: 8 bit per component, 16 bit average per pixel

4) 16 bit YUV422 and YUVA4224: 16 bit per component, 32 bit average per pixel

Table A-2: Supported container file formats

Default .
Format File storage o
Exten- Description
Name - format
sion

AVI *.avi 3 x 8 bit RGB (either | Video file format that supports various file
compressed or storage formats, either compressed or un-
uncompressed + compressed. Proprietary streaming video
audio) technology developed by Microsoft. Only

QuickTime and CineForm codecs are sup-
ported.

H.264 *.mts 3 x 8 bit RGB or Compression format for video and audio ca-
8 bit YUV (com- pable of providing good video quality (e.g.
pressed and/or au- | when in HD) at lower bit rates. One of the
dio) standard codecs for Blu-ray Discs.
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Table A-2: Supported container file formats (cont.)

Default .
Format File storage B
Exten- Description
Name . format
sion

GXF *.gxf JPEG (M-JPEG), File exchange format for the transfer of clips
MPEG, or DV-based | between storage systems.
video compression
standards, with au-
dio, timecode, and
user data that may
include metadata

MPEG-1 * . mpg 3 x 8 bit RGB or File format for the compression of video and

MPEG-2 *.m2v 8 bit YUV audio.

(compressed + au-
dio)

MPEG-4 * . mp4 3 x 8 bit RGB or File format for the compression of video and
8 bit YUV (com- audio as well as other media types. Based on
pressed and/or au- | the QuickTime file format.
dio)

Phantom *.cine Raw (uncompres- Raw video-only file format developed by Vi-

Cine Raw sed) son Research for an on-camera recording.

QuickTime * . mov various (e.g. RGB or | Video file format that supports various file
YUV either com- storage formats, either compressed or un-
pressed or uncom- | compressed. The whole video clip as well as
pressed + audio) audio are stored in one file only (container

format). Proprietary streaming video technol-
ogy developed by Apple.

REDCODE * . r3d 12 bit raw (wavelet | Raw 12 bit file format for the compression of

RAW compressed + au- video at a variable bit rate. Developed by
dio) RED Digital Cinema Camera Company for an

on-camera recording.

Windows * . wmv 3 x 8 bit RGB Video file format that supports various file

Media (compressed + au- | storage formats. Proprietary streaming video
dio) technology developed by Microsoft. Only

compressed variants are supported.

Furthermore, the software supports different variants of MXF (e.g. MXF
OP-Atom, MXF OP-1a and P2; extension *.mxf) as well as DV (DIF; ex-
tension *.dv) files. Both are container formats for audio and/or video
material. P2-3D clips can be read and played out by the software, too.
The formats are implemented with the following compression codecs:
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Table A-3: Supported codecs

. 1 Video Bit | Audio Bit
Codec Video Raster Rates Depthz Format
AVC-Intra 720p /23.98/25/29.97/50 50, 100 16 bit MXF OP-1a,
/59.94, (OP-1a: also | MXF OP-Atom (P2)
1080i /25/29.97, 24 bit)
1080p /23.98/25/29.97
DV25 525i /29.97 (4:1:1), 25 16 bit DV (DIF),
625i /25 (4:2:0) MXF OP-1a (DV),
MXF OP-Atom (P2),
MXEF (for Isis &...)
DVCPRO 25 525i /29.97 (4:1:1), 25 16 bit DV (DIF),
625i /25 (4:1:1) (OP-1a: also | MXF OP-1a (DV),
24 bit) MXF OP-Atom (P2),
MXF (for Isis &...)
DVCPRO 50 525i /29.97, 50 16 bit DV (DIF),
625i /25 (OP-1a: also | MXF OP-1a (DV),
24 bit) MXF OP-Atom (P2),
MXEF (for Isis &...)
DVCPRO HD | 720p /50/59.94, 100 16 bit DV (DIF),
1080i /25/29.97 (OP-1a: also | MXF OP-1a (DV),
24 bit) MXF OP-Atom (P2),
MXF (for Isis &...)
DNxHD 720p /23.98/25/29.97 Various, 16 bit, 24 bit> | MXF OP-1a (Avid),
/50/59.94, ranging MXF OP-Atom
1080i /23.98/24/25 from 36 to (Avid),
/29.97, 440 MXEF (for Isis &...)
1080p /23.98/24/25
/29.97/50/60
XDCAM IMX | 525i/29.97, 30,40 0r50 | 16 bit, 24 bit | MXF OP-1a
625i /25
XDCAM HD 1080i, p /25/29.97 (4:2:0) |18, 25,35 |16 bit MXF OP-1a
720p /50/59.94, 50 24 bit .'V'XlF AONPga (Avid)
1080p /23.98/25/29.97, Incl.
1080i /25/29.97
XDCAM DV 525i /29.97 (4:1:1), 25 16 bit MXF OP-1a
625i /25 (4:2:0)

1) If not mentioned otherwise all in 8 bit 4:2:2.

2) The number of channels as well as their arrangement may be restricted.
3) Each audio channel will be recorded in a separate file. Recording 16 audio channels will
generate 16 individual MXF files for audio (mono).
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Table A-4: Supported audio file formats
Default o
Format Name . Description
Extension

aif *.aif Audio interchange format. Platform-independent

aiff *.aiff file format for sound. Capable of storing multiple
mono or stereo channels.

BWF *.rfé64 Broadcast wave format. Platform-independent file
format for sound. Extension of the *.wav format
capable of storing multiple mono or stereo chan-
nels and enabling file sizes of more than 4 GB.

RIFF wave * . wav 'Resource Interchange File Format’ (RIFF) for digi-

tal audio (waveform) data under Windows. Capa-
ble of storing multiple mono or stereo channels.

Table A-5: Other supported file formats
Default .
Format Name . Description
Extension
3D LUT *,3d1 Three dimensional look-up table. ASCII file con-
*.e3d taining a matrix of color values to map them to a
* . lut selected set of other values, e.g. for color conver-

sion or gamma correction.

Project file of DVS
video systems

e.g.
*.cp
* venice

DVS proprietary XML file format detailing all fea-
tures of a timeline created with the DVS software
on a video system by DVS.
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A.3 Keyboard Shortcuts

For a more easy control of Spycer there are various keyboard shortcuts
available which are listed in the table below:

Action

Key Action

Open the online documentation

[F1]

Open the option Rename... of the
context menu when an/several
item(s) of the contents area or a/
several folder(s) in the directory tree
is/are selected

[F2]

Open the '’Configuration’ window

[F4]

Refresh the view of the directory
tree (must have focus)

[F5]

Perform a scan operation when vol-
ume or folder in the directory tree or
an item in the contents area is se-
lected

[F7]

Open the ’Scan Event Viewer’ win-
dow

[F8]

Open the ’Calculator’ window

[F11]

Open the ’About’ window

[F12]

Switch to the search tool of Spycer

[Ctrl + F] (Mac: [36 + F])

Open further window with VANC
data.

(For closing the window again use
the same shortcut)

[Ctrl + L] (Mac: [3 + L])

Play of material in preview area

[Space], [D]

Stop of material in preview area

[Space]

Step one (1) frame forward on a
scrub bar (must have focus)

[Right Arrow], [4]

Step one (1) frame backward on a
scrub bar (must have focus)

[Left Arrow], [3]

Step ten (10) frames forward on a
scrub bar (must have focus)

[Shift + Left Arrow], [2]

Step ten (10) frames backward on a
scrub bar (must have focus)

[Shift + Right Arrow], [1]

Select several items (e.g. files) dis-
jointedly

Hold [Ctrl] key (Mac: [38]) while
selecting with the mouse

Select a range of adjoining items
(e.g. files)

Hold [Shift] key while selecting
with the mouse
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Action

Key Action

Within the home system: Move ma-
terial to another location instead of

copying

Hold [Alt] key while drag 'n’
drop with the mouse

Open window with a browsing
pane for selecting content

[Ctrl + B] (Mac: [3 + B])

Copy selected material to the clip-
board

[Ctrl + C] (Mac: [ + C])

Cut selected material to the clip-
board

[Ctrl + X] (Mac: [$ + X])

Paste from clipboard to the selected
position/location

[Ctrl + V] (Mac: [$ + V])

Opens advanced 'Properties’ win-
dow

[Ctrl + Shift + D]

(Switch the tab Advanced to
the tab General at the top left of
the window)

Delete directories/files from the
storage

[Del]

Close an open window of the
Spycer application

Linux/Windows only: [Alt + F4]

Exit Spycer [Alt + F4] (Mac. [# + Q)
Toggle to full-screen mode and [Alt + Return]

back

Toggle to full-screen mode on or off | [Alt + Enter]

Open the configuration settings Mac only: &8 + ]

Minimize

Mac only.: [ + M]

Open the online help

[F1] (Mac: [& + Shift + ?])
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A.4 Interesting Files and Folders

The Spycer application is programed with the best know-how DVS has
to offer in the field of digital video. It provides some files and folders
that may be of interest to the user and/or the system administrator:

Leave the rest of the files in the directories mentioned in the
following as they are. Do not try to run them if they are exe-
cutables or even delete them. This may cause harm to your

computer system and/or the Spycer application installed.

Folder(s): |log

Location: | Linux: /etc/opt/DVS/Spycer/log
Mac: /Library/Application Support/DVS/
Spycer/log
Windows: | C:\Users\All Users\DVS\Spycer\log

Condition: | By default available.

Details: The files in this directory log the actions of the built-in de-
fragmenter (files Defrag debug/results-<time-
stamp>.log, see also section “Defragmenter” on

page 7-4) and of the SpycerAgent (Agent-<time-
stamp>. 1og, see also section “SpycerAgent” on

page 2-b). Furthermore, you find the files Local - Copy-
Report-<timestamp>.log detailing the copy jobs,
File-Receive-Report-<timestamp>.logand files
containing statistical information and the job history.
Only the last ten files of each log will be kept.

Folder(s): |log

Location: | Linux: /home/<users>/.DVS/Spycer/log

Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer/log

Windows: | C:\Users\<user>\AppData\Roam-
ing\DVS\Spycer\log

Condition: | By default available.

Details: When the Spycer user interface is started, a log file is
written into this directory detailing all actions performed
by and with the user interface. When exiting Spycer, the
log file is finished and saved. Only the last ten files will be
kept.
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Folder(s): |proxies
Location: | Linux: /home/<user>/.DVS/Spycer/proxies
Mac: /Library/Application Support/DVS/
Spycer/proxies
Windows. | C:\Users\<user>\AppData\Roam-
ing\DVS\Spycer\proxies
Condition: | Will be created after the first download of a proxy over
the SpycerNet.
Details: This folder stores temporarily the proxies used for a pre-
view when a clip from a foreign system is singled out
(see section “General Information about Proxies” on
page 6-11).
Folder(s): |savedqueries
Location: |Linux: /home/<users>/.DVS/Spycer/saved-
queries
Mac: /Users/<user>/Library/Applica-
tion Support/DVS/Spycer/savedque-
ries
Windows. | C:\Users\<user>\AppData\Roam-
ing\DVS\Spycer\savedqueries
Condition: | Will be created after the first search has been saved.
Details: In this folder you find the saved queries when having per-

formed a search with the search tool (see section
“Searching for Data” on page 5-10).
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File(s):

Spycer.cdb and Spycer. cdb-journal (backup file,
not on Windows)

Location:

Linux: /home/<user>/.DVS

Mac: /Users/<user>/Library/Applica-
tion Support/DVS

Windows: | C:\Users\All Users\DVS

Condition:

Will be created when the local content management is
enabled.

Details:

The database administered by the SpycerAgent and its
backup file. Can be deleted. However, then any virtually
added metadata will be lost and the SpycerAgent will
have to scan the watched folders again which may take
some time and render the system busy. To initiate a new
scan, you may have to stop and start the SpycerAgent.

File(s):

Agent.conf, IP.conf, Service.conf , WebSer-
vice.conf, fims services.cfg

Location:

Linux: /etc/opt/DVS/Spycer

Mac: /Library/Application Support/DVS/
Spycer

Windows. | C:\Users\All Users\DVS\Spycer

Condition:

Will be created when the local content management is
enabled.

Details:

Configuration files of the SpycerAgent. Do not delete.
The file fims services.cfg configures the record
scheduler (see section “User Interface in the Record
Scheduler Mode” on page 4-6). The file webSer-
vice.conf must be edited to enable the web service
(see section “Accessing the Web Service” on

page A-24). By restricting access to the files IP. conf
and Service. conf to 'read only’ you can deny other
users the possibility to alter the IP or service/daemon
configurations.
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File(s):

SearchItems.xml

Location:

Linux:

/home/<user>/.DVS/Spycer

Mac:

/Users/<user>/Library/Applica-
tion Support/DVS/Spycer

Windows:

C:\Users\<user>\AppData\Roaming\
DVS\Spycer

Condition:

By default available.

Details:

Contains the parameters for a search in the search tool of
the Spycer application. You may adapt it, for example, to
change the sequence of search parameters in the drop-
down list of the very first drop-down list.

Do not alter this file any further. Otherwise the
search tool may not operate correctly anymore.

File(s):

BrowserCore.data, BrowserGui.data

Location:

Linux:

/home/<user>/.DVS/Spycer

Mac:

/Users/<user>/Library/Applica-
tion Support/DVS/Spycer

Windows:

C:\Users\<user>\AppData\Roaming)\
DVS\Spycer

Condition:

Will be created after the first closing of the user interface.

Details:

These files store the layout of the user interface. They can
be deleted without harm. However, then the program will
start with a default layout. They will be created again
when the program is exited.
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A.5 Maintenance

The Spycer application, especially when working in a network, is a
complex set of individual programs. Because of this DVS provides
some maintenance tools which will help you in the event of service and
maintenance work. All the software programs described here are avail-
able for this purpose only. In your daily work with Spycer they should
be of no use.

Before applying anything of the following please refer to sec-
tion “Troubleshooting” on page A-2 to see whether it is really
necessary.

A.5.1 The SpycerAgent Tool

When a local content management is enabled, the SpycerAgent will be
the most important part of the Spycer application. It is a process (Mac/
Windows: service, Linux: daemon) running in the background of your
system and administering the local data and its database.

o Further information about the SpycerAgent can be found in
1 section “SpycerAgent” on page 2-b.

To administer the background process, DVS offers you under all oper-
ating systems the SpycerAgent tool. Furthermore, under Linux and
Mac operating systems you can also administer the SpycerAgent via a
script.

The SpycerAgent Tool

With the SpycerAgent tool DVS offers you under all supported operat-
ing systems a graphical user interface to administer the background
process. It can be started by performing the following:

Linux: o Call up a command line (shell) and enter
SpycerAgentTool.
Mac: o Select from the Applications folder of Mac

OS the entry SpycerAgentTool . app.

Windows: s Select from the START button menu of Windows
in the submenu DVS the entry Maintenance.

s From the opening submenu select the entry for
the SpycerAgent tool (for example, All
Programs » DVS » Maintenance »
SpycerAgent Tool).

This will start the SpycerAgent tool:
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Figure A-1: The SpycerAgent too/

With the SpycerAgent tool you can control the SpycerAgent and, for in-
stance, start or stop it.

o The standard operating system tools to administer a back-
1 ground process can be used as well to control the
SpycerAgent.

Linux and Mac only: The files IP. conf and Service.conf
(see section “Interesting Files and Folders” on page A-14) are
configuration files of the SpycerAgent. By restricting access to
them you can deny other users the possibility to alter the IP or
service/daemon configurations.

It provides the following items:

SpycerAgent

ADVANCED...

START

SToP

This entry field states the path on your system to
the background process as well as its file name. To
select another SpycerAgent, you can either enter
another path/file name or use the button to the
right (JBl) to select one via the opening dialog win-
dow.

This button provides the same functionality as the
ADVANCED... button of the general configuration
settings. For a description please refer to section
“The Group 'General’” on page 9-11.

After installing the background process (button IN-
STALL), it has to be started. This can be made with
the START button. Afterwards, it will be running on
your system administering the data and database.

Once the background process is started (button
START), it can be stopped with this button. After-
wards, it is no longer running and the connection
to the SpycerNet will be lost. However, after a re-
boot it will be started automatically again. A stop-
ping of the process will make the UNINSTALL
button available.
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INSTALL A background process must be installed before it
can operate. This can be done with this button.
When the SpycerAgent is installed, it will be start-
ed automatically during the loading of the operat-
ing system. To start it now, the button START has to
be pressed (available after an installation of the
background process).

UNINSTALL To un- or deinstall the background process, you
may use this button. Afterwards, it will no longer
be started during the loading of the operating sys-
tem. The button UNINSTALL will be available once
the process is stopped.

In the middle of the window, the current state of the SpycerAgent is de-
tailed. However, when the SpycerAgent tool is running and the state of
the background process changes in the meantime, it will not be noticed
by the tool automatically. In this case you have to update the status

message as well as the state of the window by pressing the key [Fb] (re-
fresh). Any changes in the state of the SpycerAgent will be detailed by
the status message and the state of the tool's controls may change.

The SpycerAgent Script (Linux/Mac only)

Under Linux and Mac OS the SpycerAgent process can also be admin-
istered via a script. It can be called from any command line by entering:

Linux: /etc/init.d/spyceragent <commands
Mac: /Library/Startupltems/Spycer/SpycerAgent
<command >

With the SpycerAgent script you can control the SpycerAgent and, for
instance, start or stop it.

o The standard operating system tools to administer a back-
1 ground process can be used as well to control the
SpycerAgent.

The files IP. conf and Service.conf (see section “Interest-
ing Files and Folders” on page A-14) are configuration files of
the SpycerAgent. By restricting access to them you can deny
other users the possibility to alter the IP or service/daemon
configurations.

To install or deinstall the background process, use the
SpycerAgent tool (see section “The SpycerAgent Tool” on
page A-18).
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The following lists the available commands (<commands>) for the
SpycerAgent script:

start When the SpycerAgent is installed as a back-
ground process, it can be started with this com-
mand. Afterwards, it will be running on your
system administering the data and database.

stop Once the background process is started, it can be
stopped with this command. Afterwards, it is no
longer running and the connection to the
SpycerNet will be lost. However, after a reboot it
will be started automatically again.

restart This command stops the process and afterwards
starts it again.

status With this command the current state of the
SpycerAgent is returned, i.e. whether it is started
or stopped.

A.5.2 The CodeMeter Control Center

CodeMeter is another name for the dongle providing the license for
your Spycer application (see section “Licensing” on page 2-9). It comes
with a control center and web server application for a more detailed
configuration of the dongle.

Because the control center and the web server application
configure the dongle as well as its network capabilities do not
change any of their default configurations unless you are ab-

solutely sure about the outcome, or are instructed to by your
distributor or the DVS service department.

The web server application by CodeMeter can be accessed
from the user interface of the CodeMeter Control Center (but-
ton WEBADMIN).

i @

You can get further information about the control center as well
as the web server application via the help information which
can be accessed once the user interface of the control center
is displayed.

The CodeMeter Control Center can be accessed by performing the fol-
lowing:

Linux: * Select from the system menu of Linux the entry
Utilities » CodeMeter Control Center.

A-21
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Mac: * Select from the Applications folder of Mac
OS the entry CodeMeter. app.
Windows: ¢ Select from the START button menu of Windows

in the submenu CodeMeter the entry Code-
Meter Control Center (for example, All
Programs » CodeMeter » CodeMeter Control
Center).

This will start the user interface of the control center.

A.5.3 Gathering Diagnostic Information

A-22

To aid a debugging, the Spycer application stores log files which detail
the actions performed by and with the program. You may get asked by
the DVS service department to send in these files as well as others in
case you experience operation problems with Spycer.

o For further information about the log files see section “Interest-
1 ing Files and Folders” on page A-14.

To gather the diagnostic information, DVS prepared a script that will

gather all required files automatically. To run it, you have to do the fol-
lowing:

Linux/Mac: * Call up a command line (shell) and enter slc.
Windows: | Perform one of the following:

» Access the installation folder of Spycer (usually
C:\Programs\DVS\Spycer or
C:\Programs (x86) \DVS\Spycer)and dou-
ble-click the file s1c. exe.

* Open a command line and enter slc.bat.

This will execute the script gathering all diagnostic information that
may help DVS to determine your problem in an archive file (such as

* . zip). Under Windows the file will be saved on your desktop, while
under Linux and Mac it can be found in the folder where the script was
called. Afterwards, perform the following:

* Locate the archive file and send it to the e-mail address provided by
the DVS personnel.

Once your mail is received, the DVS support team will evaluate the in-
formation and, if possible, provide you with a solution for your problem.
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A.6 Command Line Operations

Some features of the Spycer application can also be controlled from a
command line. They can be called by entering:

Spycer

[ [command] <parameters>]

The following lists the available operations and commands that can be
performed from a command line:

o If Spycer is not already running when initiating a command
l from a command line, it will be started automatically and the
operation will be carried out.

Paths to directories should end with a backslash (Windows) or
slash (Linux/Mac).

Depending on the operating system the syntax (paths) will be

case sensitive.

Entering the syntax with an invalid command (e.g. -help) will
call up help information in the Spycer user interface.

Command/Parameter Operation

- none - Simply entering Spycer at a command line
without any command or parameter will start
Spycer.

<path> Browses to and selects the drive, directory,

-Ccopy <source>
<destinations>

-move <source>
<destinations>
-delete <path>
-defrag <path>

-scan <paths>

clip, or file indicated by <paths.

Copies the directory tree or file/clip indicated
by <source> to a destination location (direc-
tory). The destination location must already
exist.

Performs the same as -copy but moves the
data instead of copying.

Deletes the directory, clip, or file indicated by
<paths>.

Defragments the drive, directory, clip, or file
indicated by <paths.

(Re)scans the drive, directory, clip, or file indi-
cated by <paths>.
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A.7 Accessing the Web Service

A-24

The web service (SOAP interface) allows you to develop an application
of your own that can be used to control the Spycer software, for exam-
ple, from a remote computer connected via network.

1

To enable the Spycer web service, the necessary license (SOAP
in the ’About Spycer’ window, see ‘About’ in the table on
page 4-17) must be available.

To enable the web service perform the following:

* In the path /etc/opt/DVS/Spycer/ open the file
WebService.conf with a text editor (e.g. nano).

* |nsection [Service] change the line Enabled=0 to Enabled=1.

* Change the line IpAddress=127.0.0.1 to the IP address which
is set for the network port.

¢ Save the file.

1

Make sure that the port number specified in the setting
Port is not used anywhere else on the system. Otherwise

you have to change it as well.

¢ Restart the software.

1

The necessary *.wsd1 file will be sent to you by DVS. When
received, you can load it into your web service application.

With this the web service will be enabled and the Spycer software will
receive commands sent to the system.
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